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Legal information 

 

Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

 

NOTICE  
indicates that an unintended result or situation can occur if the corresponding information is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation for the specific task, in particular its warning notices and 
safety instructions. Qualified personnel are those who, based on their training and experience, are capable of 
identifying risks and avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be adhered to. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the 
owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Preface 1
 

This document is part of the System and Function Descriptions 
documentation package. 

Scope 
This manual applies to SIMOTION SCOUT in association with the SIMOTION Cam or 
Cam_ext technology package for product version 4.2. 

Chapters in this manual 
This manual provides information about the functions, operation, command execution, and 
technology alarms of the technology objects. 
● Output Cam technology object (part I) 

Functions and operation 
● Cam Track technology object (part II) 

Functions and operation 
● TO measuring input (part III) 

Functions and operation 
● Index 

Keyword index for locating information 

1.1 SIMOTION Documentation 
An overview of the SIMOTION documentation can be found in a separate list of references.  
This documentation is included as electronic documentation in the scope of delivery of 
SIMOTION SCOUT. It comprises 10 documentation packages.  
The following documentation packages are available for SIMOTION V4.2: 
● SIMOTION Engineering System 
● SIMOTION System and Function Descriptions 
● SIMOTION Service and Diagnostics 
● SIMOTION IT 
● SIMOTION Programming 
● SIMOTION Programming - References 
● SIMOTION C 
● SIMOTION P 
● SIMOTION D 
● SIMOTION Supplementary Documentation 
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1.2 Hotline and Internet addresses 

Additional information 
Click the following link to find information on the the following topics: 
● Ordering documentation/overview of documentation 
● Additional links to download documents 
● Using documentation online (find and search in manuals/information) 
http://www.siemens.com/motioncontrol/docu 
Please send any questions about the technical documentation (e.g. suggestions for 
improvement, corrections) to the following e-mail address: 
docu.motioncontrol@siemens.com 

My Documentation Manager 
Click the following link for information on how to compile documentation individually on the 
basis of Siemens content and how to adapt this for the purpose of your own machine 
documentation: 
http://www.siemens.com/mdm 

Training 
Click the following link for information on SITRAIN - Siemens training courses for automation 
products, systems and solutions: 
http://www.siemens.com/sitrain 

FAQs 
You can find Frequently Asked Questions on the Service&Support pages under Product 
Support: 
http://support.automation.siemens.com 

Technical support 
Country-specific telephone numbers for technical support are provided on the Internet under 
Contact: 
http://www.siemens.com/automation/service&support  
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Output Cam TO - Part I 2
2.1 Overview of Output Cam TO 

2.1.1 General information about the Output Cam TO 
The Output Cam technology object  
● Generates position-dependent switching signals 
● Can be assigned to positioning axes, synchronous axes, path axes or external encoders 
● The axes can be real or virtual. 
Different switching signals distinguish different types of output cam: 
● Software cam 

Switching signals are used internally in the user program by evaluating the relevant state 
system variable. 

● Hardware cam 
Switching signals are output externally on I/O devices by assigning a digital output to the 
Output Cam TO. For example, digital output modules from the ET 200 I/O system can be 
used for the cam output. 

 
Figure 2-1 Interconnection options for the output cam TO 
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A range of output cam types with different switching behaviors are available. 
● Position-based cam 

The switching signal is supplied between the switch-on position and the switch-off 
position. 

● Time-based cam 
The switching signal is supplied for a specified time period after the switch-on position is 
reached. 

● Unidirectional output cam 
The switching signal is supplied when the axis reaches the switching position and is then 
reset by the user. 

● Counter cam 
Counter cams are not a separate output cam type, but rather position-based or time-
based type cams. Counter cams can be configured so that they are output for every 
switching or for every nth switching. They can only be programmed and activated in the 
user program. 

● Cam output types 
While output cams are usually output in the IPO cycle clock or the position control cycle 
clock, high-speed output cams provide better output accuracy than the position control 
cycle clock because the switching edges are positioned within the position control cycle 
clock.  

2.1.2 Functionality 
It is possible to define an effective direction for the Output Cam TO, i.e. the output cam is 
only active when the direction of motion of the axis is the same as the effective direction.  
The output cam can be calculated in the position control cycle clock, IPO cycle clock, or 
IPO2 cycle clock.  
The reference values of the cam depend on the axis type or the external encoder: 

Table 2- 1 Reference to the actual or setpoint position 

Technology object Reference to actual position 
possible 

Reference to position setpoint 
possible 

Real drive axis - - 
Real position axis X X 
Real synchronized axis X X 
Virtual axes - X 
External encoder X - 

In this case, the output cam functionality can be applied to axes or external encoders with or 
without modulo properties. 
The output cam is also effective for axes that have not been homed. 
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The Output Cam technology object is assigned to exactly one output during configuration. 
Output can be achieved via: 
● Integrated I/Os 
● Drive I/O (e.g. TB30, TM31, TM1x) 
● SIMOTION C centralized I/O 
● Distributed I/Os; PROFIBUS DP I/Os (e.g. ET 200M) 
However, the output must not be in the process image. 
The switching accuracy is dependent on the following: 
● Output accuracy of the I/O 
● How the output cam is allocated in the task system 
● How constant deceleration times are compensated 
Several Output Cam TOs can be connected to the same output (see Section Logical 
operation). Alternatively, the Cam Track TO can be used for this purpose. 

Example 
Lines of glue are applied to a wooden board. The output cams are assigned to an external 
encoder. Output cams assigned to outputs Q 0 to Q 4 are switched on and off at specified 
positions. 

 
Figure 2-2 Example of an electronic cam control 

See also 
Logical operation (Page 30) 
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2.1.3 Comparison of Output Cam TO and Cam Track TO 
Depending on the application, it may be practical to use either the Cam Track TO or one or 
more Output Cam TOs. The table below should help you to decide which TO should be used 
in which case.  

Table 2- 2 Comparison of Output Cam TO and Cam Track TO 

Features Output Cam TO Cam Track TO 
Availability • As of Version 1.0 • As of Version V3.2 

Supported output cams • Position-based cam 
• Time-based output cam 
• Unidirectional output cam 
• Counter cam 
• Exact time setting of an output, exact 

time output cams (as of V4.1) 

• Position-based cam 
• Time-based output cam 
• Time-based cam with maximum ON 

length 

Several output cams on one 
output 

• Via logical operation (AND/OR) • Maximum 32 output cams of the same 
type in one track 

• No cam track logical operations 
(AND/OR) 

Different types of output cam 
on one output 

• Via AND/OR • Not available 

Output cam definition • Related to axis 
• Via system variables 

• Related to cam track (cam track can be 
mapped as required on axis) 

• Via system-variables array 

Hysteresis • Available • Available 

Effective direction • Available • Not available 

Derivative-action times • Separate for power ON/power OFF • Separate for power ON/power OFF 

Deactivation time for time-
based cam 

• As of Version V3.2 • As of Version V3.2 

Activation/deactivation types • Active immediately • Start and stop mode parameterizable 

Types of output • Cyclic • Cyclic 
• Once 

Output cam status • System variable • Status of single output cams over one 
array of byte 

Output cam enable • Via_enableOutputCam • via_enableCamTrack 
• Validity of single output cams 

configurable via system variables 

Performance • Depends on number of single output 
cams 

• When 5 or more output cams are used in 
one output cam track instead of 5 single 
output cams, the output cam track 
performs better. This performance 
advantage amounts to at least a factor of 
2 for 32 single output cams. 

MCC command available • Available • Available (V4.0 and higher) 
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2.2 Output cam TO basics 

2.2.1 Output cam type 

2.2.1.1 Software cam 
Switching signals are used internally in the user program by evaluating the relevant state 
system variable.  

2.2.1.2 Hardware cam 
Switching signals are output externally on I/O devices by assigning a digital output to the 
Output Cam TO.  
The following can be used as digital outputs: 
● Onboard outputs (SIMOTION C, D, ...) 
● Centralized I/O (SIMOTION C) 
● Distributed I/Os via PROFIBUS DP (e.g. ET 200M) and PROFINET IO (e.g. ET 200S) 
● Drive I/O (for example TM15 and TM17 high feature terminal modules) 

Hardware for output cams 
Cam output on cam output (I/O channel is configured as CAM) 
● SIMOTION D4x5-2 (X142, V4.2 or higher) 
● TM15, TM17 high feature 
 
Cam output on high-speed output with direct access (I/O channel is configured as DO) 
● SIMOTION D4xx / D4x5-1 
● SIMOTION D4x5-2 (X142, V4.2 or higher) 
● SIMOTION C240, C240 PN 
 
Cam output on standard output (I/O channel is configured as DO) 
● SIMOTION C/D/CX onboard I/O 
● SINAMICS onboard I/O 
● TM15, TM15 DI/DO, TM17 high feature, TM31, TM41, TB30 
● Standard DO (SIMATIC ET200, ...) 
 
For more information, see cam output types. (Page 18) 
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2.2.1.3 Position-based cam 

Direction-neutral switching  

 
Figure 2-3 Position-controlled output cam with start position less than end position 

Limits imposed by start and end positions 
The output cam is activated: 
● Axis position is within the switch-on area 
● Axis position value is shifted into the switch-on area of the output cam 

The position value of the interconnected object can change abruptly, for example, when it 
is homed or when its coordinate system is shifted with the _redefinePosition command. 

The output cam is switched off: 
● When the axis position is outside the start or end position 
● When the axis position value is shifted outside the switch-on area 
● When commands are issued that deactivate the output cam, e.g. _disableOutputCam, 

_setOutputCamState, and _resetOutputCam 

Switch-on area 
The switch-on area of the output cam is defined from the start position to the end position in 
a positive counting direction, i.e. within a range between the start position and the end 
position. If the end position is greater than the start position, the switch-on area is defined by 
the start and end positions (see figure above). 
The switch-on area is outside the area between the end and start positions if the end 
position is less than the start position (see figure below). 

 
Figure 2-4 Position-controlled output cam with end position less than start position 

 

 Note 
This definition of the switch-on area is possible for all modulo and non-modulo axes. 
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ON duration 
The ON duration of the output cam depends on the velocity at which the axis traverses the 
output cam length. 

Direction-dependent switching 
The output cam is activated: 
● When the axis position is between the start and end positions, and the axis is moving in 

the programmed effective direction 
The output cam is switched off: 
● When the axis position is outside the start or end position 
● When the motion direction is not the same as the assigned effective direction 
● When the axis position value is shifted outside the switch-on area 
● When commands are issued that deactivate the output cam, e.g. _disableOutputCam, 

_setOutputCamState, and _resetOutputCam 

2.2.1.4 Time-based output cam 

Direction-neutral switching 

 
Figure 2-5 Time-controlled output cam 

Limits imposed by starting position and ON duration 
The output cam is switched on: 
● At the starting position. 

If the starting position is overrun again during the ON duration, the time-based cam is not 
switched on again. It is not possible to retrigger a time-based cam. 

The output cam is switched off: 
● When the assigned time period expires 
● When commands are issued that deactivate the output cam, e.g. _disableOutputCam, 

_setOutputCamState and _resetOutputCam 

Output cam length 
The output cam length is dependent on the velocity at which the assigned axis traverses 
during ON duration of the output cam. 

Direction-dependent switching 
The output cam is switched on: 
● At the starting position if the traversing direction is the same as the effective direction 
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The output cam is switched off: 
● When the assigned time period expires 
● When commands are issued that deactivate the output cam, e.g. _disableOutputCam, 

_setOutputCamState and _resetOutputCam 
A change of direction will not lead to the output cam being switched off if the time-based cam 
has already been activated. 

2.2.1.5 Unidirectional output cam 

 
Figure 2-6 Unidirectional output cam 

Limits imposed by starting position 
The output cam is switched on: 
● At the starting position if the axis is moving in the programmed effective direction 
The output cam is switched off: 
● By the _disableOutputCam, _setOutputCamState and _reset commands 

 

 
 

Note 
The unidirectional output cam does not switch unless the starting position is explicitly 
crossed, e.g. by setting the actual value. 
An end position is not defined for the unidirectional output cam. The output cam signal 
depends solely on the switching criteria when the output cam is crossed over. The 
unidirectional cam can be reset via the program (e.g. by calling up the system function 
_enableOutputCam again). 

 

 

2.2.1.6 Counter cam 
For a counter cam, it can be specified whether the output cam is to be output every time it 
switches or every nth time it switches.  

 

 Note 
Counter cams can only be configured for position-based and time-based cams. A counter 
cam is used via the _setOutputCamCounter system function. 
Counter cams can only be defined in the user program. In configuring the output cam, the 
output cam type cannot be defined as counter cam. 

 

Every counter cam has a starting count value and a current count value.  
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The current count value for the output cam is reduced by 1 every time the output cam 
switches. If the current count reaches 0, the output cam is output (state system variable and 
output cam output). At the same time, the current count value is reset to the starting count 
value. If the current count value does not reach 0, the output cam output is suppressed. The 
default setting of the starting count value and current count value is 1. The starting count 
value and current count value are programmed by means of the _setOutputCamCounter. 
The current count values can be scanned with the counterCamData.actualValue and 
counterCamData.startValue system variables. No resetting of the values by the system takes 
place, e.g. after _enableOutputCam or _disableOutputCam. 

3 24 3401

 
Figure 2-7 Example of a counter cam 
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2.2.1.7 Cam output types 
The output cam calculations are performed in the execution cycle (IPO or IPO2 cycle clock 
or in the position control cycle clock). For the possible setting IPO_fast, see the chapter 
entitled Second position control cycle clock (Servo_fast) in the Motion Control Basic 
Functions manual. 
The temporal resolution of cam output depends on the hardware used and the setting in the 
configuration. In standard applications, the setting is undertaken using screens. The 
configuration data can also be set via the expert list 
The possible setting options for cam output are described below: 

 
Figure 2-8 Output cam configuration using the example of a position-based cam 
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Figure 2-9 Assignment dialog 

Symbolic assignment is activated by default in projects as of V4.2 (Project > Use symbolic 
assignment) 

Cam output (CAM) 
Cam output is based on an internal time stamp. The temporal resolution of cam output 
depends on the hardware used. In the case of D4x5-2 and the TM17 high feature, the 
resolution is 1 µs. 

Hardware supported 
● SIMOTION D4x5-2 (X142) 
● TM15, TM17 high feature 
The I/O channel must be configured as CAM. 

SIMOTION D4x5-2 onboard outputs (interface X142) 
The D4x5-2 onboard outputs can be used as cam output (CAM) from the user program. The 
D4x5-2 onboard outputs are permanently assigned to SIMOTION. The X142 I/Os are 
configured using HW Config. 
The X142 configuration screen can be accessed directly from the project navigator in 
SIMOTION SCOUT. 
With SIMOTION D4x5-2, output cams are output at the X142 interface with a resolution of 
1 μs. 
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TM15 / TM17 high feature Terminal Modules 
The TM15 and TM17 high feature terminal modules can be used to set up cam outputs 
(CAM) within the SIMOTION Motion Control system. The terminal modules are connected 
directly to SIMOTION D or CX32/CX32-2 via DRIVE-CLiQ for this purpose. 
Alternatively, TM15 and TM17 high feature can be connected to a SINAMICS S120 Control 
Unit 
CU320/CU320-2/CU310 with higher-level SIMOTION C, P or D. 
Output cams on the TM15 operate with DRIVE-CLiQ cycle-clock resolution (typically 125 µs). 
Output cams on the TM17 high feature have a resolution of 1 µs. 

High-speed digital output (DO) 
Output cams are output via SIMOTION CPU onboard outputs. Output is via a hardware 
timer, which achieves cam output with a temporal resolution < position control cycle clock. 
The time that it takes for the axis to reach the output cam switching position with reference to 
the processing cycle clock is calculated by linear extrapolation. Calculated from the 
beginning of the 1st position control cycle clock, the output cam function is triggered by a 
hardware time when this time is reached. 

Hardware supported 
The onboard I/O of the following CPUs is used: 
● SIMOTION D4x5-2 (interface X142), 8 high-speed cam outputs, V4.2 or higher (The I/O 

channel must be configured as DO) 
● SIMOTION D4x5 (interface X122, X132), 8 high-speed cam outputs, V4.1 or higher (The 

I/O channel must be configured as DO) 
● SIMOTION D410 (interface X121), 4 high-speed cam outputs, V4.1 or higher (The I/O 

channel must be configured as DO) 
● SIMOTION C240, C240 PN (interface X1), 8 high-speed cam outputs 

SIMOTION D410/D4x5 onboard outputs 
Output cams are output via a high-speed digital output (DO). 
● Up to and including SCOUT V4.1 SP5, all D410/D4x5 onboard I/Os configured as digital 

outputs are exclusively available to SIMOTION 
● As of SCOUT V4.2, D410/D4x5 onboard I/Os configured as digital outputs can be 

switched over to SINAMICS using BICO interconnection (channel granular) 

SIMOTION D4x5-2 onboard outputs (interface X142) 
Output cams are output via a "high-speed digital output (DO)". The D4x5-2 onboard outputs 
are permanently assigned to SIMOTION.  
The X142 I/Os are configured using HW Config.  
The X142 configuration screen can be accessed directly from the project navigator in 
SIMOTION SCOUT. 
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Standard digital output (DO) 
The output cam calculations are performed in the processing clock cycle (IPO or IPO2 cycle 
clock or position control cycle clock). 
Actual cam output takes place in the position control cycle clock. The temporal resolution of 
cam output is usually reduced by the output cycle of the I/O used. 
Therefore the resolution  
● with a standard I/O (e.g. ET 200) depends on the cycle time of the bus system 

(PROFIBUS DP / PROFINET IO) 
● with TM15 / TM17 depends on the cycle time of the bus system (PROFIBUS Integrated / 

PROFIBUS DP / PROFINET IO) 
● with TM15 DI/DO, TM31, TM41, TB30 depends on the configured sampling time 

– cu.p0799 (CU inputs/outputs sampling time) for TB30 and onboard outputs 
– p4099 (TMxx inputs/outputs sampling time) for TM15 DI/DO, TM31 and TM41 

Hardware supported 
● Onboard outputs (SIMOTION D, Controller Extension CX, SINAMICS Control Unit 

CU3xx) 
● Centralized I/O (SIMOTION C) 
● Distributed I/O via PROFIBUS DP/PROFINET IO (e.g. ET 200, ...) 
● Drive I/O TM15, TM15 DI/DO, TM17 high feature, TM31, TM41, TB30 

Configuration data of cam output types in expert list 

Table 2- 3 Setting options for cam output 

Selection in configuration screen Setting in expert list 
Cam output (CAM)  
(TM15/17, D4x5-2) 

OcaBaseCfg.outputType = [1] TIME_STAMP 
OcaBaseCfg.hwTimer = [91] NO 

High-speed digital output (DO) 
(D4xx, D4x5-2, C240) 

OcaBaseCfg.outputType = [0] STANDARD 
OcaBaseCfg.hwTimer = [173] YES 

Standard digital output (DO) 
(Standard DO, e.g. ET200, TM31) 

OcaBaseCfg.outputType = [0] STANDARD 
OcaBaseCfg.hwTimer = [173] NO 

Output cams on cam output (CAM) or on high-speed digital output (DO) are also referred to 
below as high-speed, hardware-supported output cams. 



Output Cam TO - Part I  
2.2 Output cam TO basics 

 Output Cams and Measuring Inputs 
22 Function Manual, 11/2010 

 
 

 Note 
Further information and the output accuracy for high-speed output cams is described in the 
PM21 catalog and in the respective product brief or commissioning/equipment manual. 
Commissioning Manual Terminal Modules TM15/TM17 High Feature 
Operating instructions SIMOTION C2xx  
Commissioning Manual SIMOTION D410 
Commissioning and Hardware Installation Manual SIMOTION D4x5 
Commissioning and Hardware Installation Manual SIMOTION D4x5-2 

 

 

See also 
Configuring cams on SIMOTION D4xx onboard (Page 42) 

2.2.1.8 Exact time setting of an output, exact time output cams (as of V4.1) 
You can switch a high-speed output cam On/Off at an exact time within an execution cycle 
(position control, IPO cycle) via the timeOffset parameter of the _setOutputCamState system 
function. 
Enter an offset of the switching edge in the configured unit (e.g. s) of the Output Cam TO in 
the timeOffset parameter. The reference point of the offset is the start of the next execution 
cycle of the Output Cam TO. You can read out the value of the time offset (system-
dependent execution time between the execution cycle and the output cycle) in the tOutput 
system variable. The time in tOutput is the earliest possible time to switch the output cam. 
The timeOffset is added to this time. 

Features 
● The offset must be less than the cycle clock time of the processing cycle clock. The offset 

is limited automatically and a technological alarm is output when the cycle clock time is 
exceeded. 

● It is possible to switch on or off within a cycle clock. 
● When this function is used, there is a dependency on the processing cycle clock and the 

set cycle clock times. 
● The offset is valid for every output cam type. If only switched once, the unidirectional 

output cam type is recommended. 
● The offset can only be stated if the output cam TO on the outputs is configured with a 

time stamp (cam output (CAM)). 
● For output cams without time stamp (e.g. C230-2 onboard output cams), tOutput (time 

stamp) is set to 0.0. 
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● If multiple activation or deactivation signal edges are issued in a cycle clock, the most 
recently written values apply. 

● The start of the output cycle clock is shifted with respect to the beginning of the 
processing cycle clock by the value output in the tOutput system variable and the 
specified timeOffset. 

 
Figure 2-10 Exact-time output setting for DP:POSITION CONTROL=1:1 

 
Figure 2-11 Exact-time output setting for DP:POSITION CONTROL=1:2 
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2.2.2 Cam parameters 

2.2.2.1 Reaction, effective direction 

Behavior 
The following diagram shows output cam behavior when switching on and off, without 
hysteresis, activation, or deactivation time.  

 
Figure 2-12 Output cam behavior when switching on/off 

The switching action depends on the position only (position setpoint or actual position). 

Effective direction 
You can define a default effective direction when you activate output cams. The output cam 
only switches when the motion direction and effective direction are identical. 
Options: 

Table 2- 4 Effective direction and behavior 

Effective direction Behavior 
Positive The output cam is activated only in positive direction of motion. 
Positive and negative The output cam is activated independent of the direction of motion.  
Negative The output cam is activated only in negative direction of motion. 
Last programmed 
direction of rotation 

With this setting, the output cam switches for the last programmed direction 
of rotation. If no direction of rotation has been previously programmed, the 
default setting is used. 
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Figure 2-13 Positive effective direction and output cam switching behavior 

2.2.2.2 Hysteresis 
If the actual position value tends to fluctuate due to mechanical influences, specification of a 
hysteresis prevents the output cam from unintended switch status changes.  

 
Figure 2-14 Hysteresis 

Hysteresis range conditions  
● Hysteresis is not activated until the direction has been reversed. 
● The direction of motion is not redefined within the hysteresis. 
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● Within the hysteresis, the switching state of position-based cams is not changed. 
● If modified switching conditions for the output cam are detected when the output cam is 

outside the hysteresis range, this current switching state is set. 

Example: position-based cam hysteresis 
Output cam configuration: 
output cam type: position-based cam; switch-on position, 20 mm; switch-off position, 200 
mm; hysteresis, 20 mm; effective direction: positive 
Axis positions: 
0 mm -> 100 mm -> 10 mm -> 50 mm -> 0 mm -> 150 mm -> 0 mm 

 
Figure 2-15 Hysteresis range (height of blue sections) and behavior of a position-based cam, positive effective direction 

Output cam's second switch-on point is moved to position 30 mm, due to hysteresis (see 
figure above). 

Example: time-based cam hysteresis 
Output cam configuration: 
output cam type: time-based cam; switch-on position, 40 mm; ON duration, 0.5 s; hysteresis, 
20 mm; effective direction: positive 
Axis positions: 
0 mm -> 100 mm -> 20 mm -> 60 mm -> 30 mm -> 80 mm -> 10 mm -> 150 mm 
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Figure 2-16 Hysteresis range (height of blue sections) and behavior of a time-based cam, positive effective direction 

Time-based cam switches off only after ON duration has expired, not after change of 
direction. 
Time-based cam with a start position within the hysteresis range is not output (see figure 
above). 

Hysteresis range 
The upper limit of the hysteresis range is set at 25% of the working range for a linear axis, 
and 25 % of the rotary axis range for a rotary axis. If you violate this maximum setting, an 
error message is issued. In practice, a lower setting is used for the hysteresis range. 
● Path-controlled output cam 

The hysteresis becomes active after direction reversal is detected. If only a positive or 
only a negative effective direction has been parameterized for an output cam, the output 
cam does not switch off after a reversal of direction until it has left the hysteresis. 

● Time-based cam 
The switching behavior of a time-based cam is determined by the ON duration, not by the 
hysteresis. This means that an entered hysteresis range has no influence on the ON 
duration of an output cam. It only has an influence on the switch-on time (start position). 

 

 
 

Note 
If a time-based cam's start position lies within the hysteresis, it is not output. 

 

 

2.2.2.3 Derivative-action times (activation/deactivation time) 
To compensate for the switching times of digital outputs and connected switching elements, 
or of propagation delays, it is possible to specify actuation times. Actuation times are 
calculated from the sum of all delay times and can be specified separately for activation and 
deactivation edges as an actuation time at the activation edge (activation time) or an 
actuation time at the deactivation edge (deactivation time).  
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The activation/deactivation times of the Output Cam TO are dynamically compensated by 
means of the derivative-action times. In this way, output cams are dynamically shifted 
depending on the actual velocity. 
For example, a valve that should open at 200°, with an activation time of 0.5 s  
● Must be controlled at 195° at a velocity of 10°. 
● Must be controlled at 190° at a velocity of 20°. 
This dynamic shift takes place automatically by means of the Output Cam TO. 
Settings for the activation and deactivation times can contain positive or negative values. 
A negative activation time must be entered if the output cam is to be switched before the 
programmed start of the output cam. 

 
Figure 2-17 Switching behavior at varying actuation times 

 

 Note 
The time of output for the output cam in the control is relevant for calculation of the dynamic 
adjustment. If velocity changes up to signal output, these changes are no longer taken into 
account. 
Dead times, e.g. PROFIBUS DP communication times, output delay times on digital outputs, 
etc., are taken into account in the actuation time. 
Long actuation times exceeding one modulo cycle may lead to heavy fluctuation of the 
switching position of actual value output cams (actual value curve). Here, setpoint output 
cams should be used or the actuation time should be considerably less than one modulo 
cycle. 

 

The system takes into account the specified actuation times when the output cams are 
calculated and managed. If, allowing for actuation times, the output cam was switched, then 
the system deems this operation to have occurred, and it does not switch the output cam 
again even if any subsequent current velocity changes occur. 
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The dynamic actuation of modulo axes can be greater than one modulo length. However, the 
number of switching operations is not collected by the system, i.e. for actuation times longer 
than one modulo length, a switching operation cannot take place in each modulo cycle. One 
switching operation is active in the system at any given point in time. A switching operation is 
completed when the output cam is switched off. 

Actuation times and cycle clock settings 
A change of cycle clock settings does not have to be taken into account for the actuation 
time settings (activation/deactivation time). These are, for example: 
● Change of position control/IPO/IPO2 cycle clock settings (e.g. from "1/1/1 ms" to "2/2/2 

ms"). 
● Change of processing cycle clock of the output cam TO (setting: position control cycle 

clock, IPO, or IPO2). 
When the position control:IPO ratio is ≠ 1:1, then the greatest possible accuracy for the 
calculation is reached for "output cams related to position value" when the position control 
cycle clock is set as the processing cycle clock for the output cam TO. 

Deactivation time for time-based cam  
Deactivation time is also taken into account in setting a time-based cam. 
Deactivation time must be: 
● Deactivation time ≤ activation time + ON duration 
Activation and deactivation times can vary independently of the I/O and can, therefore, 
influence the ON duration of the time-based cam. 
To achieve compatibility with older software versions (<V3.2), deactivation time for time-
based cams can be activated or deactivated in the Defaults window, by means of the Use 
deactivation time checkbox. 
 

See also 
Determining derivative-action times for output cams (dead time compensation) (Page 39) 
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2.2.2.4 Logical operation 
Through a setting in the LogAdress.logicOperation  configuration data element you can 
specify whether the output cam is connected to the output using an AND or OR operation.  
That is, all ORed output cams will be grouped and then logically linked at the output with the 
output cams linked by AND logic.  

 
Figure 2-18 OR operation of two output cams 

 

 Note 
If hardware output cams are configured, you can configure an I/O variable in the symbol 
browser for monitoring. 

 

2.2.2.5 Simulation 
Operation can be simulated by means of the simulation commands on the output cam. The 
output cam status is then not output to the hardware output. In simulation mode, a hardware 
cam behaves as a software cam. It is then only used for programming purposes.  
If an active output cam is switched to simulation mode (_enableOutputCamSimulation), the 
output cam status remains the same, and only the control of the output is reset or 
interrupted. 

2.2.2.6 Inversion 
The inversion of single output cams is available and is set on the _enableOutputCam 
command by a parameter (invertOutput).  
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2.2.3 Configure Units 
You can define the basic units for each technology object. The same physical variables can 
have different units in different technology objects. These are converted:  

How to configure the units: 
1. Open the context menu for the technology object in the project navigator. 
2. In the context menu, select Expert > Configure units. The Configure Units window 

appears in the working area. 
3. Select the unit for the physical variables. These units are used for the technology object, 

e.g. s for time units. 
or 
1. In the project navigator, open the Configuration under the TO. 
2. Select the tab Units. 

 
You can set the following parameters: 

Field/Button Explanation/Instructions 
Unit system Drop down list for preselecting the units to be displayed 

The "SI units system" is set by default in the drop down list 
when creating anew. 

Table with units  
 Physical parameter column Displays the physical parameter. The physical parameters 

which are also used by the TO are made available. 
 Unit column Display and configuration for unit. A drop down list for 

selecting the unit appears when you click on the cell. 
Toolbar  
  Displays whether offline data or online data is shown 

• Blue field = offline display 
• Yellow field = online display 

 Close Button for closing the dialog. 
 Help Button for opening the dialog's online help. 
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2.3 Configuring the Output Cam technology object 

2.3.1 Insertion of Output Cam 
 

 Note 
Before you insert an output cam, the axis (position or synchronous axis) or external encoder 
to which the output cam is assigned has to be created. 
If the output cams are to be output on a TM15/TM17 high feature, the module must be added 
and configured before output cam configuration. 

 

To insert a new output cam:  
1. In the project navigator, highlight the OUTPUT CAMS folder under the relevant axis or 

external encoder. 
2. Select Insert > Technology object > Output cam or double-click Insert output cam in the 

project navigator under the axis or external encoder in the OUTPUT CAMS folder. The 
Insert output cam window appears. 

3. Enter a name for the output cam. You can also enter a comment. 
Names must be unique throughout the project and must comply with ST syntax 
conventions. For this reason, all the existing output cams are displayed under Available 
output cams. 

4. Confirm with OK. In the working area, the window for the configuration is displayed and 
the created output cam TO is shown in the project navigator. 

2.3.2 Parameterize Output Cam technology object 

General information about configuration data and system variables  
Two data classes are distinguished when parameterizing a TO. 
Configuration data define the principal functionality of a TO. They are set within the object 
configuration framework with the SCOUT engineering system and are not normally changed 
during runtime. 
System variables provide status data of the TO for the user program and a parameterization 
interface on the TO. System variables can be changed during runtime. 

 

 Note 
For more information about technology objects, refer to the SIMOTION Motion Control Basic 
Functions functional description. 
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To parameterize an output cam: 
1. In the project navigator under the folder OUTPUT CAMS, find the output cam TO that you 

want to parameterize. Double-click the output cam TO to display the associated objects. 
2. Double-click Configuration or Default in the project navigator. The window appears in the 

working area. 
– Configuration: 

Define the configuration data of the output cam here. This includes, for example, 
output cam type.  

– Default: 
Define the output cam defaults of the system variables here. This includes, for 
example, the effective direction.  

3. Change the configuration data and output cam defaults. 
4. Click Close to accept the changes. 
5. Repeat steps 2 to 4 for all objects in which you want to change the configuration data and 

output cam defaults. 

See also 
Output cam configuration (Page 34) 
Defining output cam defaults (Page 38) 

2.3.3 Using the expert list for output cams 
For standard SIMOTION applications, necessary parameters (configuration data and system 
variables) are parameterized into the Output Cam technology object directly by means of 
screen forms or are defined automatically. 
It can be necessary to change automatically defined parameters for special SIMOTION 
applications. These configuration data and system variables can only be displayed and 
changed in the expert list.  

 

 Note 
For more information about working with the expert list, refer to the SIMOTION Motion 
Control Basic Functions functional description. 
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2.3.4 Output cam configuration 
In the Configuration window, define the configuration data values for the output cam. 
Double-clicking in the project navigator below the output cam on the Configuration element 
displays the window in the working area.  

 
Figure 2-19 Output cam configuration using the example of a position-based cam 
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Figure 2-20 Assignment dialog 

You can set the following parameters: 

Table 2- 5 Output cam configuration data 

Field/Button Significance/Note 
Name The name of the created output cam is displayed here. 
Output cam type Choose Output cam type to select the type of output cam.  

Position-based cam 
(Default value) The switching signal is active when the position of the axis lies between two 
markers (start and end position).  
Time-based cam 
The switching signal is on for a specific period of time after reaching the switching position 
(starting position).  
Unidirectional output cam 
The switching signal changes when the axis reaches the switching position (starting position). 
The output cam remains switched on even if the starting position is crossed over several 
times. The output cam must be explicitly reset.  
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Field/Button Significance/Note 
Processing cycle clock Choose Processing cycle clock to select the system cycle clock used to update the output cam 

signal at the output or in the system variables.  
The output cam calculations are performed in the IPO or IPO2 cycle clock, or the position 
control cycle clock. The processing cycle clock is set in the configuration by means of the 
OcaBaseCfg.taskLevel configuration data element. 
IPO 
(default value) 
The output cam signal is updated in the interpolator cycle clock.  
IPO2 
The output cam signal is updated in the interpolator cycle clock 2. The IPO2 cycle clock length 
is at least twice that of the IPO.  
Position control cycle clock 
The output cam signal is refreshed in the position control cycle clock.  
The following configurations of the processing cycle clock are possible: 
• Axis in IPO cycle clock and output cam in IPO2 cycle clock 
• Output cam in position control cycle clock and axis in IPO or IPO2 cycle clock 
For the possible setting IPO_fast, see the chapter entitled Second position control cycle clock 
(Servo_fast) in the Motion Control Basic Functions manual. 
It is not possible to configure the axis in the IPO2 cycle clock and the output cam in the IPO 
cycle clock. 
Note: 
When the position control:IPO ratio is ≠ 1:1, then the greatest possible accuracy for the 
calculation is reached for "output cams related to position value" when the position control 
cycle clock is set as the processing cycle clock for the output cam TO. 

Type of output cam value Select the position value that is the reference for the output cam during processing. 
Setpoints 
(Default value) 
The output cam refers to the current setpoint during processing. With regard to output cam 
values at the setpoint, the output cams are output delayed by one cycle because the setpoints 
are also only output and can therefore only take effect in the next cycle.  
This also relates to displaying the output cam status.  
Actual values 
The output cam refers to the current actual value during processing.  

Activate output Activate the checkbox if the output cam signal is to be applied to a digital output. Parameters 
are displayed. 

Cam output on  
 cam output (CAM) If the output check box is activated and the cam output (CAM) radio button selected, the 

output cams are output on the basis of an internal time stamp.  
The temporal resolution of cam output depends on the hardware used. In the case of D4x5-2 
and the TM17 high feature, the resolution is e.g. 1 µs. 
Hardware supported: 
• SIMOTION D4x5-2 (X142) 
• TM15, TM17 high feature 
The I/O channel must be configured as CAM. 
For more details, see cam output types. (Page 18) 
Note 
Cam output (CAM) or high-speed digital output (DO) are also known as high-speed, hardware-
supported output cams. 
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Field/Button Significance/Note 
High-speed digital 
output (DO) 

If the output check box is activated and the "High-speed digital output (DO)" radio button 
selected, the output cam is output via onboard outputs of the SIMOTION CPU. Output is via a 
hardware timer, which achieves cam output with a temporal resolution < position control cycle 
clock. 
The time that it takes for the axis to reach the output cam switching position with reference to 
the processing cycle clock is calculated by linear extrapolation. Calculated from the beginning 
of the 1st position control cycle clock, the output cam function is triggered by a hardware time 
when this time is reached. 
Hardware supported: 
The onboard I/O of the following CPUs is used: 
• SIMOTION D4x5-2 (interface X142), 8 high-speed cam outputs, V4.2 or higher (The I/O 

channel must be configured as DO) 
• SIMOTION D4x5 (interface X122, X132), 8 high-speed cam outputs, V4.1 or higher (The 

I/O channel must be configured as DO) 
• SIMOTION D410 (interface X121), 4 high-speed cam outputs, V4.1 or higher (The I/O 

channel must be configured as DO) 
• SIMOTION C240, C240 PN (interface X1), 8 high-speed cam outputs 
For more details, see cam output types. (Page 18) 
Note 
Cam output (CAM) or high-speed digital output (DO) are also known as high-speed, hardware-
supported output cams. 
 

Standard digital 
output (DO) 

If the output check box is activated and the "Standard digital output (DO)" radio button 
selected, the output cam is output in the position control cycle clock.  
The temporal resolution of cam output is usually reduced by the output cycle of the I/O used. 
Hardware supported: 
• Onboard outputs (SIMOTION D, Controller Extension CX, SINAMICS Control Unit CU3xx) 
• Centralized I/O (SIMOTION C) 
• Distributed I/O via PROFIBUS DP/PROFINET IO (e.g. ET 200, ...) 
• Drive I/O TM15, TM15 DI/DO, TM17 high feature, TM31, TM41, TB30 
For more details, see cam output types. (Page 18) 

Logical operation 
(Page 30) 

You can assign several TO output cams to an output. Select the logical link of the output cam 
signal with the output. During the operation, all output cam signals are first grouped together 
with the logical operation OR. The result of this operation is then combined with the output 
cam signals to which a logical AND was assigned. 

Output The output can be symbolically assigned via the assignment dialog (see the Chapter entitled 
Symbolic Assignment (from V4.2 onward) in the Motion Control Basic Functions manual) using 
the  button in the Output field (symbolic assignment is activated by default in projects as of 
V4.2).  
If symbolic assignment is not active or if the CPU version < V4.2, a physical output is assigned 
by entering the HW address and bit number in the Output field. 
Enter the logical HW address of the output to which the output cam signal is to be applied. 
Only the output cam signal may be present at this address. If other objects are already using 
this output, an error occurs that is reported following downloading into the target system. The 
logical HW address must be located outside the process image and therefore be greater than 
63.  
For more details, see cam output types. (Page 18) 
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Field/Button Significance/Note 

 Button for opening the assignment dialog (see the Chapter entitled Symbolic Assignment (from 
V4.2 onward) in the Motion Control Basic Functions manual). Select a parameter or an 
address in the assignment dialog.  

 Displays whether offline data or online data is shown 
• Blue field = offline display 
• Yellow field = online display 

2.3.5 Defining output cam defaults 
You can define the defaults for every output cam. These values are stored in system 
variables and can be changed by programs.  
Double-clicking in the project navigator below the output cam on the Defaults element 
displays the window in the working area. 

 
Figure 2-21 Output cam defaults, position-based cam example 

You can set the following parameters: 

Table 2- 6 Defining output cam defaults 

Field/Button Significance/Note 
Output cam type Output cam type displays the type of output cam selected in the Configuration window.  
Activation time 
See also the 
Actuation times 
(activation/deactivatio
n time) section. 

Enter the activation time here. The output cam switching time is set to the point when the start 
position is reached, plus this period. The output cam position is adapted dynamically. This allows 
you to compensate for propagation delays. 
If a negative value is entered as an activation time, the switching signal is activated before the start 
position is reached.  
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Field/Button Significance/Note 
Using deactivation 
time 

Activate the checkbox if you want to use a deactivation time when working with time-based cams. If 
this checkbox is deactivated, you cannot enter a time. In this respect, the time-based cam is 
compatible with older software versions (<V3.2). 

Deactivation time Enter the deactivation time here. The output cam switch-off time is set to the point when the end 
position is reached, plus this period. The output cam position is adapted dynamically. This allows 
you to compensate for propagation delays. 
If a negative value is entered as a deactivation time, the switching signal is activated before the 
end position is reached.  

Hysteresis Enter a range for the hysteresis here. The output cam does not change its switching state in this 
defined range around the switching position even under changed switching conditions. This 
prevents a repeated change of the switching state.  

Start position 
See also the Output 
cam types section. 

Enter the start position of the output cam. For path-controlled output cams this is the left switching 
position. 

End position Enter the end position of the output cam. For path-controlled output cams this is the right switching 
position. 

Effective direction Enter the effective direction for the output cam. The output cam is active only if the current 
direction of motion of the axis corresponds to the parameterized effective direction.  
Positive and negative effective direction (both) 
Output cam switches in both directions of motion 
Last programmed effective direction (effective) 
Output cam switches only in the last programmed effective direction 
Negative effective direction (negative) 
Output cam switches only for negative direction of motion 
Positive effective direction (positive) 
Output cam switches only for positive direction of motion 

ON duration Enter the ON duration for time-controlled output cams here. After the axis has passed the switch-
on position, the time-based cam output remains on for the ON duration. 

See also 
Derivative-action times (activation/deactivation time) (Page 27) 
Reaction, effective direction (Page 24) 
Hysteresis (Page 25) 

2.3.6 Determining derivative-action times for output cams (dead time compensation) 
Depending on the system and the device, there is a certain time between the setting of a 
cam output by the program and the actual reaction of the actuator (e.g. solenoid valve). This 
time is called dead time and depends, for example, on the load-dependent delay times of a 
digital output, the switching properties of a valve, etc. Usually the exact value for the dead 
time is not known and can therefore be determined empirically through measurements. 
In order that an output cam switches at the correct time, the dead time must be 
compensated by specifying a derivative-action time, which offsets the cam output by the 
dead time. Whereby it must be taken into account that the derivative-action times for 
switching an actuator on and off are usually different. 
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The empirical determination of the dead times using a difference measurement as an 
example. 

 

 Note 
The procedure applies not only to output cams, but also to cam tracks. However, with cam 
tracks you can only specify a derivative-action time for the entire cam track. 

 

Example 
Lines of glue are to be applied to a product at a defined position and with a fixed length. The 
glue output is controlled by an output cam or a cam track. The glue is output from the start of 
output cam (switch-on point) to the end of output cam (switch-off point). The offset of the 
begin and end of output cam with respect to the velocity can be observed on the length and 
position of the glue line on the product (see figure). The figure below shows the line of glue 
for two velocities (v1, v2) with v2 > v1. 

 
Figure 2-22 Offset of the output of output cam through dead times (dead time compensation) 

Procedure: 
1. Set all actuation times for start of output cam (activation time) and end of output cam 

(deactivation time) to 0. 
2. Define the velocities for which the positions are to be determined. You should select two 

velocities that correspond to velocities that occur during production (e.g. minimum and 
maximum velocity). 

3. Start the application and determine the start positions (xA1 and xA2) and end positions (xE1 
and xE2) of the line of glue for the velocities v1 and v2. 

 

 
 

Note 
To increase the accuracy, you can perform several comparison measurements and use 
the average measured values. 
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4. You can determine the actuation times for the output of output cam using the following 
formula. 
tActivation = Δs/Δv = (xA2-xA1)/(v2-v1) 
tDeactivation = Δs/Δv = (xE2-xE1)/(v2-v1) 

5. Enter the calculated actuation times as activationtime for the start of output cam and as 
deactivationtime for the end of output cam. Note that the actuation time must be entered 
as a negative when the output time is to be before the programmed output cam switching 
time. 

6. After you have determined the activation time and the deactivation time for the output of 
output cam, you should perform a control measurement and check the result. 

 

 
 

Note 
Depending on the application, it may be, e.g. with eccentric presses, that there is no 
linear relationship between dead time and velocity (e.g. non-linear response of an applied 
brake). You have to dynamically adapt the dead time to the respective velocity for these 
applications. This can be implemented in the application with a user program. After the 
actuation time has been changed, you have to activate the output cam again with 
_enableOutputCam or the cam track with _enableCamTrack. 

 

 

See also 
Derivative-action times (activation/deactivation time) (Page 27) 
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2.3.7 Configuring cams on SIMOTION D4xx onboard 
Output cams and cam tracks can be configured for standard outputs, or as high-speed, 
hardware-based output cams / cam tracks.  

Cams can be configured on SIMOTION D4xx onboard as follows:  
1. In the project navigator, switch to the control unit via SINAMICS_Integrated > 

Control_Unit. 
2. Double-click Inputs/outputs below the control unit. The window appears in the working 

area. 
3. Switch to the Bidirectional digital inputs/outputs tab. 
4. Click the button to switch between the input and output for the digital inputs/outputs (DO8 

to DO15). In each case, switch the DI/DO to the output you wish to use as the output of 
output cam. The designation at the terminal strip of DI or DO switches to DO. Outputs of 
the output cam can only be used if they have been defined as an output. DO8 is 
configured as output in the figure. For the output, select the DO (SIMOTION) setting. 

 

 
 

Note 
Mixed use of the SIMOTION D4xx DI/O as high-speed outputs (of output cams) and 
inputs of measuring inputs is possible. 

 

 
Figure 2-23 SIMOTION D4xx digital inputs/outputs 

5. Click Close. 
6. Insert a new output cam or a new cam track or use an existing one. 
7. Parameterize the TO Output Cam / Cam Track 
8. Double-click Configuration below the output cam or the cam track in the project navigator. 

The Configuration window appears in the working area. 
9. For high-speed, hardware-supported output cams, you can achieve an output accuracy 

exceeding the position control cycle clock based on the hardware used. Should you wish 
to configure a high-speed output cam, select the Activate output check box and select the 
High-speed digital output (DO) radio button. 

10. Assignment of an output to an output cam/cam track is supported as of V4.2 using 
symbolic assignment (see the Chapter entitled Symbolic Assignment (from V4.2 onward) 
in the Motion Control Basic Functions manual) or by means of entering the HW address. 

11. Click OK to close the window and select Project > Save. 
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To determine the logical hardware address for outputs on SIMOTION D4xx onboard (only if 
symbolic assignment is not activated)  
1. In the project navigator, below the SIMOTION D device, select SINAMICS_Integrated > 

Communication > Message Frame Configuration. 
2. Double-click Configuration and, in the window which appears, select the tab IF1: 

PROFIdrive PZD message frame. The components are displayed there with address 
range (input/output data). 

3. Select SIEMENS message frame 390, 391 or 392 as message frame type. A maximum of 
eight output cams can be configured for each message frame. The number of DI/DO is 
limited to eight, i.e. only two output cams can be configured for message frame 392 if you 
are already using six measuring inputs. Therefore consider whether you also want to use 
measuring inputs during the message frame selection. 

 
Figure 2-24 Determining the hardware address of the components 

4. Before you determine the hardware address, an alignment between HW Config and 
SIMOTION SCOUT, with respect to the address, must be performed. If this has not been 
performed or you have changed the addresses, click on Set up addresses. If there are 
question marks in the fields instead of I/O addresses, you must also perform an 
alignment. 

5. Now calculate the HW address by adding the base output address (first value of the 
output data) of the Control Unit to the offset (for example 298 + 3 = 301). The offset 
always has the value 3. 

6. You will find the bit number in the following table. 

Table 2- 7 Bit numbers for D410 and D4x5 

Output D4x5  Output D410 Bit number 
X122.7 (DI/DO 8) X121.7 (DI/DO 8) Bit 0 
X122.8 (DI/DO 9) X121.8 (DI/DO 9) Bit 1 
X122.10 (DI/DO 10) X121.10 (DI/DO 10) Bit 2 
X122.11 (DI/DO 11) X121.11 (DI/DO 11) Bit 3 
X132.7 (DI/DO 12) - Bit 4 
X132.8 (DI/DO 13) - Bit 5 
X132.10 (DI/DO 14) - Bit 6 
X132.11 (DI/DO 15) - Bit 7 
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 Note 
In the case of versions earlier than V4.2, when using 39x message frames, the onboard 
D4x5 outputs are to be assigned exclusively to SIMOTION. 

 

 

See also 
Insertion of Output Cam (Page 32) 
Parameterize Output Cam technology object (Page 32) 
Cam output types (Page 18) 
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2.3.8 Configuring cams on SIMOTION D4x5-2 onboard 

With SIMOTION D4x5-2 the outputs on the interface X142 are used for cam output 
1. The Inputs/outputs X142 entry in the project navigator can be used to open the 

configuration screen in HW Config. 
2. For the selected I/O channel, select Output cam as the function. 

 

 
 

Note 
If you do not use any symbolic assignments (see the Chapter entitled Symbolic 
Assignment (from V4.2 onward) in the Motion Control Basic Functions manual), then you 
must note the logical address. (see Figure I/O Properties) This address must be 
configured at the TO output cam 

 

 
Figure 2-25 I/O Properties 

3. Click OK. 
4. Insert a new output cam or a new cam track or use an existing one. 
5. Parameterize the TO Output Cam / Cam Track 
6. Double-click Configuration below the output cam or the cam track in the project navigator. 

The Configuration window appears in the working area. 
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7. For high-speed, hardware-supported output cams, you can achieve an output accuracy 
exceeding the position control cycle clock based on the hardware used.  
Should you wish to configure a high-speed output cam, select the Activate output check 
box and select the Cam output (CAM) radio button. 

8. Assignment of an output to an output cam/cam track is supported as of V4.2 using 
symbolic assignment or by entering the HW address. 

9. Click OK to close the window and select Project > Save. 

2.3.9 Configuring an output cam on a TM15/TM17 High Feature 
1. In the project navigator, below the input/output component (TM15/TM17) that you want to 

use, double-click the entry Inputs/outputs. The Bidirectional Digital Inputs/Outputs window 
is displayed. 

2. For the selected I/O channel, select Output cam as the function. 
 

 
 

Note 
If you do not use symbolic assignment (see the Chapter entitled Symbolic Assignment 
(from V4.2 onward) in the Motion Control Basic Functions manual), then you must note 
the offset (e.g. 3.1). 

 

3. Insert a new output cam or a new cam track or use an existing one. 
4. Parameterize the TO Output Cam / Cam Track 
5. Double-click Configuration below the output cam or the cam track in the project navigator. 

The Configuration window appears in the working area. 
6. For high-speed, hardware-supported output cams, you can achieve an output accuracy 

exceeding the position control cycle clock based on the hardware used.  
Should you wish to configure a high-speed output cam, select the Activate output check 
box and select the Cam output (CAM) radio button. 

7. Assignment of an output to an output cam/cam track is supported as of V4.2 using 
symbolic assignment (see the Chapter entitled Symbolic Assignment (from V4.2 onward) 
in the Motion Control Basic Functions manual) or by means of entering the HW address. 

8. Click OK to close the window and select Project > Save. 
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To determine the logical hardware address for TM15/TM17 High Feature outputs (only if 
symbolic assignment is not activated) 
1. In the project navigator, below the SIMOTION device or the SINAMICS drive unit 

- for SIMOTION D, select: SINAMICS_Integrated > Communication > Message Frame 
Configuration 
- for SINAMICS S/G drive unit (position axis only): Communication > Message Frame 
Configuration 

2. Double-click Message frame configuration and, in the window which appears, select tab 
IF1: PROFIdrive PZD message frame. The components are displayed there with the 
address ranges (e.g. TM17 output data 304 to 315). 

 
Figure 2-26 Determining the hardware address of the components 

3. Before you determine the hardware address, an alignment between HW Config and 
SIMOTION SCOUT, with respect to the address, must be performed. If this has not been 
performed or you have changed the addresses, click on Set up addresses. If question 
marks are entered in the fields instead of I/O addresses, either alignment has not yet 
taken place, or the address is not recognized by SIMOTION SCOUT. In this case, you 
must perform an alignment. 

4. Now calculate the HW address by adding the base output address (first value of the 
address range) of the TM to the offset (e.g. 304 + 3 = 307). 

5. The bit number is defined by means of the offset. For example, an offset of an output cam 
on DO1 of 3.1 results in a bit number of 1. 

2.3.10 Configuring cams on SIMOTION C240 
1. Insert a new output cam or a new cam track or use an existing one. 
2. Parameterize the TO Output Cam / Cam Track 
3. Double-click Configuration below the output cam or the cam track in the project navigator. 

The Configuration window appears in the working area. 
4. For high-speed, hardware-supported output cams, you can achieve an output accuracy 

exceeding the position control cycle clock based on the hardware used. Should you wish 
to configure a high-speed output cam, select the Activate output check box and select the 
High-speed digital output (DO) radio button 
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5. Assignment of an output to an output cam/cam track is supported as of V4.2 using 
symbolic assignment (see the Chapter entitled Symbolic Assignment (from V4.2 onward) 
in the Motion Control Basic Functions manual) or by means of entering the HW address. 

6. Click OK to close the window and select Project > Save. 

2.3.11 HW enable for Output Cam TO 
You can make the output of output cams dependent on a hardware-supported enable (only 
with the TM17 High Feature).  
Because HW enables are used predominantly for output cam tracks, this function is 
described with the Cam Track TO (Page 109). 
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2.4 Programming/references of Output Cam TO 

2.4.1 Programming 

 
Figure 2-27 Programming and execution model for Output Cam technology object 

*1 The following commands are effective in the TO states can be activated and active: 
● _disableOutputCamSimulation 
● _enableOutputCamSimulation 
The simulation commands are modal / act in parallel and do not replace any existing 
_enableOutputCam commands. 
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2.4.2 Commands 
The Output Cam technology object can be addressed in the user program using the 
following commands:  

Table 2- 8 Output Cam TO system functions 

Commands Description Application 
_enableOutputCam Activate output cam Output cam analysis is activated. If the 

switching condition for the output cam 
is fulfilled, the output or state system 
variable is set.  

_disableOutputCam Deactivate output cam Output cam analysis is deactivated. If 
the switching condition for the output 
cam is fulfilled, the output or state 
system variable is not set. Controlled 
output cams are reset immediately. 

_enableOutputCamSimulation Activate simulation mode. This function 
simulates an output cam by 
disconnecting the output. 

Values are calculated, but not 
forwarded to the hardware. Hardware 
output cams act as software cams. The 
output cam remains internally active, 
the status is retained, the output of 
output cam is not switched. If an active 
output cam is switched to simulation 
mode, the output cam status remains 
the same, and only the control of the 
output is reset or interrupted. 

_disableOutputCamSimulation The output cam is reset from simulation 
mode.  

The output of output cam is switched 
according to the output cam status and 
the signal inversion. 

_setOutputCamState Deactivate the output cam function and 
set the output cam status to the 
specified value. 

This is used if the output should not be 
controlled by the output cam TO. 
Example: 
A glue nozzle is controlled by the 
output cam TO (applying glue dots). As 
a service function, it should also be 
possible to rinse the nozzle while 
constantly controlling it. This is 
achieved via _setOutputCamState. 

_resetOutputCamError Reset error on output cam TO. E.g. acknowledge configuration errors 
after entering correct values. 

_setOutputCamCounter Change starting count for a counter 
cam. 

Output cam is output on every nth 
switching operation. 

_resetOutputCam This function sets the output cam to an 
initial state. Pending errors are deleted. 
Modified configuration data is reset on 
request. 

Create initial state of output cam TO. 

_resetOutputCamConfigDataBuffer This function deletes the configuration 
data collected in the buffer since the 
last activation without activating it. 

Changing configuration data in the 
RUN state discards the accumulated 
modifications. 
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Commands Description Application 
_getStateOfOutputCamCommand 
(V3.2 and higher) 

This function returns the execution 
state of a command. 

Check whether the output cam 
switching has already taken place, i.e. 
whether the command ID is still 
available or has already been deleted. 

_bufferOutputCamCommandId 
(V3.2 and higher) 

This function enables commandId and 
the associated command status to be 
saved beyond the execution period of 
the command. 
The commandId parameter is used to 
define the command for which the 
respective status is to be saved. The 
maximum number of saveable 
command status is specified in the 
decodingConfig.numberOfMaxBuffered
CommandId configuration data 
element. 

Subsequent check of how command 
was terminated, e.g. error-free or 
number of error that occurred. 

_removeBufferedOutputCamCom 
mandId 
(V3.2 and higher) 

This function ends saving of 
commandId and the associated 
command status beyond the execution 
period of the command. 

Explicit deletion of previously saved 
command IDs. 

For further information on the system functions, please refer to the SIMOTION TP CAM 
Reference Lists. 
 

2.4.3 Process Alarms 
You can predefine local alarm responses via SIMOTION SCOUT.  

 

 Note 
For more information, refer to the Motion Control Technology Objects Basic Functions 
functional description. 

 

How to configure the alarm response: 
1. Double-click Execution system in the project navigator below the SIMOTION device. The 

execution system opens. 
2. In the execution level tree, select SystemInterruptTasks > TechnologicalFaultTask. 
3. Then click the Alarm Response button in the displayed window. The Alarm Response 

window appears. You can configure the alarm response for every TO here. 
A system variable error indicates that a technology alarm has been generated. The response 
to the alarm is displayed in the errorReaction variable. 
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Table 2- 9 Possible alarm responses 

Alarm Response Description Application 
NONE No response - 
DECODE_STOP Command processing is aborted, the output cam 

function remains active. Execution on the technology 
object can continue after _resetOutputCam or 
_resetOutputCamError. 

The Output Cam TO can only be 
reactivated after the error has been 
acknowledged. 

OUTPUTCAM_DISABLE Command processing is aborted, current output cam 
function is aborted. Execution on the technology 
object can continue after _resetOutputCam or 
_resetOutputCamError. 

The Output Cam TO can only be 
reactivated after the error has been 
acknowledged. 

2.4.4 Output Cam TO menus 

2.4.4.1 Output cam menu 
Grayed-out menu functions cannot be selected. The menu is only active if an output cam 
window is active in the working area.  

You can select the following functions: 

Table 2- 10 Output cam TO menu 

Function Significance/Note 
Close Select Close to close the configuration window for the output cam that is open in the working 

area. 
Characteristics Select Properties to display the properties of the output cam highlighted in the project navigator. 
Configuration Select Configuration to determine the configuration data (for example output cam type) of the 

output cam. 
Default Select Default to define the default settings of the system variables (e.g. effective direction) for 

the output cam. 
Expert  

Expert list Select Expert list to open the expert list for the highlighted output cam. The configuration data 
and system variables can be displayed and changed in this list. 

 

Configure units Select Configure units to open the Configure units of the object window in the working area. You 
can configure the units used for the selected object here. 
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2.4.4.2 Output cam context menu 
Grayed-out functions in the context menu cannot be selected.  
You can select the following functions: 

Table 2- 11 Output cam context menu 

Function Significance/Note 
Open configuration Select Open configuration to display the window for configuring the output cam in the working area. 

Enter the configuration data (for example output cam type) for the output cam in this window. 
Cut Select Cut to remove the selected object and save it to the clipboard. 
Copy Select Copy to copy the selected object. It is stored in the clipboard. 
Paste Select Paste to insert the output cam stored in the clipboard. 
Delete Select Delete to delete the highlighted output cam. The entire data of the output cam is deleted 

permanently. 
Rename Use Rename to rename the object selected in the project navigator. Note that with name changes, 

name references to this object are not adapted. 
Expert  

Expert list Select Expert list to open the expert list for the highlighted output cam. The configuration data and 
system variables can be displayed and changed in this list. 

Configure units Select Configure units to open the Configure units of the object window in the working area. You 
can configure the units used for the selected object here. 

Insert script 
folder 

Insert script folder enables you to insert a folder below the TO. You can create scripts in this folder 
in order to, for example, automate the configuration. 

Import object Import object imports the data of a SIMOTION object from another project which was previously 
created with a selective XML export. You cannot import the entire project, only the data of the 
SIMOTION object. 

 

Save project 
and export 
object 

Save project and export object exports selected data of the selected object in XML format. This 
data export can then be reimported into other projects. Only the data of the selected object, not the 
entire project, is exported. 

Print Select Print to print the configuration of the output cam. All system variables and configuration data 
with the associated values are printed. 

Print preview Select Print preview to open the preview of the output cam data to be printed. 
Default Select Default to define the default setting of the system variables (e.g. effective direction) of the 

output cam. 
Properties Select Properties to display the properties of the output cam highlighted in the project navigator. 
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Cam Track TO - Part II 3
3.1 Overview of TO Cam Track 

3.1.1 General information about Cam Track TO 
Cam tracks allow several output cams to be output as a track on one output.  
The Cam Track technology object  
● Generates position-dependent switching signals 
● Can be assigned to positioning axes, synchronous axes or external encoders 
● The axes can be real or virtual. 
Different switching signals distinguish different types of output cam on the cam track: 
● Software cam 

Switching signals are used internally in the user program by evaluating the relevant state 
system variable. 

● Hardware output cam 
Switching signals are output externally on I/O by assigning a digital output to the cam 
track TO. For example, digital output modules from the ET 200 I/O system can be used 
for cam track output. 

 
Figure 3-1 Interconnection options for the cam track TO 
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A range of output cam types with different switching behaviors are available on a cam track: 
● Position-based cam 

The switching signal is supplied between the switch-on position and the switch-off 
position. 

● Time-based cam 
The switching signal is supplied for a specified time period after the switch-on position is 
reached. 

● Time-based cam with maximum ON length 
A maximum ON length can be defined for time-based cams. This means that the time-
based cam is deactivated once it has covered the maximum length, even though the 
parameterized time has not yet expired. 

● High-speed/accurate output cam (hardware-based output cam) 
While output cams are usually output in the IPO cycle clock or the position control cycle 
clock, high-speed output cams provide better output accuracy than the position control 
cycle clock because the switching edges are positioned within the position control cycle 
clock. 

3.1.2 Functionality 

Cam track functionality 
● Cam tracks allow up to 32 output cams to be configured within one TO and allow, for 

example, the switching point for all output cams to be shifted collectively. 
● The switching of several output cams is dependent on the same setpoint/actual value, 

and they are output on one output. 
● Any number of cam tracks can be used per axis. The only restriction placed on this 

number is the system performance. 
● The cam track can be calculated in the position control cycle clock, IPO cycle clock, or 

IPO2 cycle clock. 
● All output cams on one track are of the same type (position or time-based cams). 
● Cam tracks can be activated once or cyclically. 
● Various modes are available for activating and deactivating cam tracks, e.g. active 

immediately, next track cycle, etc. 
● Cam track output can be inverted. 
● The status of each single output cam (controlled/not controlled) can be read over one 

array of byte. 
● Single output cams on a cam track can also be defined as valid/invalid. 
● In connection with the TM17 High Feature terminal module, the cam track output can be 

controlled via a high-speed hardware enabling signal. 
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Reference to axis 
The reference values of the cam track depend on the axis type or the external encoder: 

Table 3- 1 Reference to the actual or set position 

Technology object Reference to actual position 
possible 

Reference to set position 
possible 

Real drive axis - - 
Real position axis X X 
Real synchronized axis X X 
Virtual axes - X 
External encoder X - 

● In this case, the cam track functionality can be applied to axes or external encoders with 
or without modulo properties. 

● The cam track is also effective for axes that have not been homed. 
● The cam track is defined independently of the axis. The cam track is mapped on the axis 

via an axis reference position, once the track is activated. This enables cam tracks to be 
operated in a particularly flexible way (e.g. relative output of a cam track on the basis of a 
measured edge on the measuring input, cam track offset, etc.). 

Output on one output 
The cam track TO is assigned to one output only during configuration. Output can be 
achieved via: 
● Onboard I/O 
● Drive I/O (e.g. TB30, TM31, TM1x) 
● SIMOTION C centralized I/O 
● Distributed I/O; PROFIBUS DP I/O (e.g. ET 200M) 
However, the output must not be in the process image. 
The switching accuracy is dependent on the following:  
● Output accuracy of the I/O 
● How the cam track is allocated in the task system 
● How constant delay times are compensated 
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3.1.3 Comparison of Output Cam TO and Cam Track TO 
Depending on the application, it is practical to use either the Cam Track TO or one or more 
Output Cam TOs. The table below should help you to decide which TO should be used in 
which case.  

Table 3- 2 Comparison of Output Cam TO and Cam Track TO 

Features Output Cam TO Cam Track TO 
Availability • As of Version 1.0 • As of Version V3.2 

Supported output cams • Position-based cam 
• Time-based output cam 
• Unidirectional output cam 
• Counter cam 
• Exact time setting of an output, 

exact time output cams (as of V4.1) 

• Position-based cam 
• Time-based output cam 
• Time-based cam with maximum ON 

length 

Several output cams on one output • Via logical operation (AND/OR) • Maximum 32 output cams of the 
same type in one track 

• No cam track logical operations 
(AND/OR) 

Different types of output cam on one 
output 

• Via AND/OR • Not available 

Output cam definition • Related to axis 
• Via system variables 

• Related to cam track (cam track can 
be mapped as required on axis) 

• Via system-variables array 

Hysteresis • Available • Available 

Effective direction • Available • Not available 

Derivative-action times • Separate for power ON/power OFF • Separate for power ON/power OFF 

Deactivation time for time-based cam • As of Version V3.2 • As of Version V3.2 

Activation/deactivation types • Active immediately • Start and stop mode 
parameterizable 

Types of output • Cyclic • Cyclic 
• Once 

Output cam status • System variable • Status of single output cams over 
one array of byte 

Output cam enable • Via_enableOutputCam • via_enableCamTrack 
• Validity of single output cams 

configurable via system variables 

Performance • Depends on number of single 
output cams 

• When 5 or more output cams are 
used in one output cam track 
instead of 5 single output cams, the 
output cam track performs better. 
This performance advantage 
amounts to at least a factor of 2 for 
32 single output cams. 

MCC command available • Available • Available (V4.0 and higher) 
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3.2 TO Cam Track basics 

3.2.1 Cam track features 
A cam track has parameters that are valid for the track as a whole, and parameters that can 
be configured for each single output cam on a track.  

Track data 
Track data is valid for all output cams on a track and is, therefore, configured for the cam 
track as a whole. 
● Output cam type 

Position-based, time-based, etc. 
● Cam track start 

Always defined from "0" 
● Track length 

Cam track start to cam track end 
● Hysteresis 

Even if the switching conditions change, the output cam does not change its switching 
state in this defined range around the switching position. 

● Actuation times 
Actuation times can be specified to compensate for the switching times of digital outputs 
and connected switching elements. 

● Axis reference position 
Cam tracks are defined independently of the axis. The axis reference position is used to 
define how the cam track is mapped on the axis, or from which axis position the cam 
track should be output. 

● Cyclic or non-cyclic activation mode 
With non-cyclic output of the cam track, it must be reactivated after execution. 

● Start mode and stop mode 
Start mode or stop mode can be used, for example, to define whether a cam track should 
be output immediately, or not until the next track cycle. 

Output cam data 
Output cam data can be configured separately for each single output cam on a cam track. 
● Output cam parameters: 

Depending on output cam type, start position, end position, ON duration, maximum ON 
length. 

● Validity of single output cam 
Single output cams on a defined cam track can be parameterized as "invalid". This output 
cam is completely suppressed and is not output. It also has no status indication. 
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Example of a cam track definition 

 
Figure 3-2 Definition of a cam track with 3 output cams 

3.2.2 Output cam types of the single output cams on a track 
The following chapter provides an overview of the output cam types within a cam track. All 
output cams on a cam track are always of the same output cam type.  
Software cam (Page 60) 
Hardware cam (Page 60) 
Position-based cam (Page 61) 
Time-based cam (Page 63) 
Time-based cam with maximum ON length (Page 64) 
High-speed/accurate output cam (Page 65) 

3.2.2.1 Software cam 
Switching signals are used internally in the user program by evaluating the relevant state 
system variable.  

3.2.2.2 Hardware cam 
Switching signals are output externally on I/O devices by assigning a digital output to the 
Cam Track TO.  
The following can be used as digital outputs: 
● Onboard outputs (SIMOTION C, D, ...) 
● Centralized I/O (SIMOTION C) 
● Distributed I/Os via PROFIBUS DP (e.g. ET 200M) and PROFINET IO (e.g. ET 200S) 
● Drive I/O (for example TM15 and TM17 high feature terminal modules) 
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Hardware for cam track 
Cam output on cam output (I/O channel is configured as CAM) 
● SIMOTION D4x5-2 (X142, V4.2 or higher) 
● TM15, TM17 high feature 
 
Cam output on high-speed output with direct access (I/O channel is configured as DO) 
● SIMOTION D4xx / D4x5-1 
● SIMOTION D4x5-2 (X142, V4.2 or higher) 
● SIMOTION C240, C240 PN 
 
Cam output on standard output (I/O channel is configured as DO) 
● SIMOTION C/D/CX onboard I/O 
● SINAMICS onboard I/O 
● TM15, TM15 DI/DO, TM17 high feature, TM31, TM41, TB30 
● Standard DO (SIMATIC ET200, ...) 

See also 
Cam output types (Page 65) 

3.2.2.3 Position-based cam 

Switching behavior 
Position-based cams on a cam track switch independently of the direction of motion, i.e. they 
always have a positive and negative effective direction. 

 
Figure 3-3 Position-controlled output cam with starting position less than end position 

Limits imposed by starting and end positions 
The output cam is switched on: 
● Axis position is within the switch-on area 
● Axis position value is shifted into the switch-on area of the output cam 

The position value of the interconnected object can change abruptly, for example, when it 
is homed or when its coordinate system is shifted with the _redefinePosition command. 
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The output cam is switched off: 
● When the axis position is outside the starting or end area 
● When the axis position value is shifted outside the switch-on area 
● When commands are issued that deactivate the output cam, e.g. _disableOutputCam, 

_setOutputCamState and _resetOutputCam 

Cam activation range 
The switch-on area of the output cam is defined from the starting position to the end position 
in a positive counting direction, i.e. within a range between the starting position and the end 
position. If the end position is greater than the starting position, the switch-on area is defined 
by the starting and end positions (see figure above). 
The switch-on area is outside the area between the end and starting position if the end 
position is less than the starting position (see figure below). 

 
Figure 3-4 Position-controlled cam with end position less than starting position 

 

 Note 
This definition of the switch-on area is possible for all modulo and non-modulo axes. 

 

Last programmed ON duration 
The ON duration of the output cam depends on the velocity at which the axis traverses the 
output cam length. 
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3.2.2.4 Time-based output cam 

Switching behavior 
Time-based cams on a cam track switch independently of the direction of motion, i.e. they 
always have a positive and negative effective direction. 

 
Figure 3-5 Time-controlled output cam 

Limits imposed by starting position and ON duration 
The output cam is switched on: 
● At the starting position.  

If the starting position is overrun again during the ON duration, the time-based cam is not 
switched on again. It is not possible to retrigger a time-based cam. 

The output cam is switched off: 
● When the assigned time period expires 
● When commands are issued that deactivate the output cam, e.g. _disableOutputCam, 

_setOutputCamState and _resetOutputCam 

Output cam length 
The output cam length is dependent on the velocity at which the assigned axis traverses 
during ON duration of the output cam. 



Cam Track TO - Part II  
3.2 TO Cam Track basics 

 Output Cams and Measuring Inputs 
64 Function Manual, 11/2010 

3.2.2.5 Time-based cam with maximum ON length 

Additional limits imposed by maximum ON length 
A maximum ON length can also be defined for time-based cams on cam tracks. This means 
that the time-based cam is deactivated once it has covered the maximum length, even 
though the parameterized time has not yet expired. 
This is the case if, for example, glue dots should be applied to a workpiece and the amount 
of glue should be independent (constant time -> time-based cam) of the throughput rate.  
To avoid the time-based cam still being controlled after the end of the workpiece at high 
sweep rates, the ON duration can be limited by a maximum ON length (related to the start 
position of the output cam). This prevents a glue dot being placed adjacent to the workpiece. 
The maximum ON length is effective in both traversing directions of the axis, and the cam 
track's switch-on position is the reference position. 

Parameters of a time-based cam with maximum ON length 
Every time-based cam on a track has three parameters 
● Start of output cam (SOC) 
● ON time (t) 
● Maximum ON length (Lmax) 

This always relates to the dynamically adjusted start of output cam SOC, i.e. the 
assigned activation time is taken into account. The output cam is then traversed over the 
maximum ON length, without taking into account the deactivation time (see the Actuation 
times (activation time/deactivation time section). 

Example of a cam track which controls glue application 
In the following example, a cam track with three output cams is used to control the 
application of glue onto a workpiece. No glue may be applied outside of the predefined 
areas. 

 

 
Figure 3-6 Control of glue application via a cam track, based on a time-based cam with maximum 

ON length 
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● The start of output cam (here, SOC1 and SOC4) is used to exactly define the start of glue 
application. 

● The ON time (t) is used to ensure that the same amount of glue is applied, independent 
of the axis speed. 

● The maximum ON length Lmax is used to ensure that no glue is applied outside of the 
defined area. In the example, the output cam ON durations t3 and t6 are limited by the 
maximum ON length. 

3.2.2.6 Cam output types 
The output cam calculations are performed in the execution cycle (IPO or IPO2 cycle clock 
or in the position control cycle clock). For the possible setting IPO_fast, see the chapter 
entitled Second position control cycle clock (Servo_fast) in the Motion Control Basic 
Functions manual. 
The temporal resolution of cam output depends on the hardware used and the setting in the 
configuration. In standard applications, the setting is undertaken using screens. The 
configuration data can also be set via the expert list 
The possible setting options for cam output are described below: 

 
Figure 3-7 Output cam configuration using the example of a position-based cam 
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Figure 3-8 Assignment dialog 

Symbolic assignment is activated by default in projects as of V4.2 (Project > Use symbolic 
assignment) 

Cam output (CAM) 
Cam output is based on an internal time stamp. The temporal resolution of cam output 
depends on the hardware used. In the case of D4x5-2 and the TM17 high feature, the 
resolution is 1 µs. 

Hardware supported 
● SIMOTION D4x5-2 (X142) 
● TM15, TM17 high feature 
The I/O channel must be configured as CAM. 

SIMOTION D4x5-2 onboard outputs (interface X142) 
The D4x5-2 onboard outputs can be used as cam output (CAM) from the user program. The 
D4x5-2 onboard outputs are permanently assigned to SIMOTION. The X142 I/Os are 
configured using HW Config. 
The X142 configuration screen can be accessed directly from the project navigator in 
SIMOTION SCOUT. 
With SIMOTION D4x5-2, output cams are output at the X142 interface with a resolution of 1 
μs. 
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TM15 / TM17 high feature Terminal Modules 
The TM15 and TM17 high feature terminal modules can be used to set up cam outputs 
(CAM) within the SIMOTION Motion Control system. The terminal modules are connected 
directly to SIMOTION D or CX32/CX32-2 via DRIVE-CLiQ for this purpose. 
Alternatively, TM15 and TM17 high feature can be connected to a SINAMICS S120 Control 
Unit 
CU320/CU320-2/CU310 with higher-level SIMOTION C, P or D. 
Output cams on the TM15 operate with DRIVE-CLiQ cycle-clock resolution (typically 125 µs). 
Output cams on the TM17 high feature have a resolution of 1 µs. 

High-speed digital output (DO) 
Output cams are output via SIMOTION CPU onboard outputs. Output is via a hardware 
timer, which achieves cam output with a temporal resolution < position control cycle clock. 
The time that it takes for the axis to reach the output cam switching position with reference to 
the processing cycle clock is calculated by linear extrapolation. Calculated from the 
beginning of the 1st position control cycle clock, the output cam function is triggered by a 
hardware time when this time is reached. 

Hardware supported 
The onboard I/O of the following CPUs is used: 
● SIMOTION D4x5-2 (interface X142), 8 high-speed cam outputs, V4.2 or higher (The I/O 

channel must be configured as DO) 
● SIMOTION D4x5 (interface X122, X132), 8 high-speed cam outputs, V4.1 or higher (The 

I/O channel must be configured as DO) 
● SIMOTION D410 (interface X121), 4 high-speed cam outputs, V4.1 or higher (The I/O 

channel must be configured as DO) 
● SIMOTION C240, C240 PN (interface X1), 8 high-speed cam outputs 

SIMOTION D410/D4x5 onboard outputs 
Output cams are output via a high-speed digital output (DO). 
● Up to and including SCOUT V4.1 SP5, all D410/D4x5 onboard I/Os configured as digital 

outputs are exclusively available to SIMOTION 
● As of SCOUT V4.2, D410/D4x5 onboard I/Os configured as digital outputs can be 

switched over to SINAMICS using BICO interconnection (channel granular) 

SIMOTION D4x5-2 onboard outputs (interface X142) 
Output cams are output via a "high-speed digital output (DO)". The D4x5-2 onboard outputs 
are permanently assigned to SIMOTION.  
The X142 I/Os are configured using HW Config.  
The X142 configuration screen can be accessed directly from the project navigator in 
SIMOTION SCOUT. 
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Standard digital output (DO) 
The output cam calculations are performed in the processing clock cycle (IPO or IPO2 cycle 
clock or position control cycle clock). 
Actual cam output takes place in the position control cycle clock. The temporal resolution of 
cam output is usually reduced by the output cycle of the I/O used. 
Therefore the resolution  
● with a standard I/O (e.g. ET 200) depends on the cycle time of the bus system 

(PROFIBUS DP / PROFINET IO) 
● with TM15 / TM17 depends on the cycle time of the bus system (PROFIBUS Integrated / 

PROFIBUS DP / PROFINET IO) 
● with TM15 DI/DO, TM31, TM41, TB30 depends on the configured sampling time 

– cu.p0799 (CU inputs/outputs sampling time) for TB30 and onboard outputs 
– p4099 (TMxx inputs/outputs sampling time) for TM15 DI/DO, TM31 and TM41 

Hardware supported 
● Onboard outputs (SIMOTION D, Controller Extension CX, SINAMICS Control Unit 

CU3xx) 
● Centralized I/O (SIMOTION C) 
● Distributed I/O via PROFIBUS DP/PROFINET IO (e.g. ET 200, ...) 
● Drive I/O TM15, TM15 DI/DO, TM17 high feature, TM31, TM41, TB30 

Configuration data of cam output types in expert list 

Table 3- 3 Setting options for cam output 

Selection in configuration screen Setting in expert list 
Cam output (CAM)  
(TM15/17, D4x5-2) 

OcaBaseCfg.outputType = [1] TIME_STAMP 
OcaBaseCfg.hwTimer = [91] NO 

High-speed digital output (DO) 
(D4xx, D4x5-2, C240) 

OcaBaseCfg.outputType = [0] STANDARD 
OcaBaseCfg.hwTimer = [173] YES 

Standard digital output (DO) 
(Standard DO, e.g. ET200, TM31) 

OcaBaseCfg.outputType = [0] STANDARD 
OcaBaseCfg.hwTimer = [173] NO 

Output cams on cam output (CAM) or on high-speed digital output (DO) are also referred to 
below as high-speed, hardware-supported output cams. 
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 Note 
Further information and the output accuracy for high-speed output cams is described in the 
PM21 catalog and in the respective product brief or commissioning/equipment manual. 
Commissioning Manual Terminal Modules TM15/TM17 High Feature 
Operating instructions SIMOTION C2xx  
Commissioning Manual SIMOTION D410 
Commissioning and Hardware Installation Manual SIMOTION D4x5 
Commissioning and Hardware Installation Manual SIMOTION D4x5-2 

 

 

3.2.3 Cam track parameters 

3.2.3.1 Track length 
The camTrackLength system variable is used to parameterize the track length. The track 
length is calculated from the start of the cam track (always 0) to the end of the cam track. 
Usually, the output cams of the cam track are located within the track length. The track 
length must not be 0. When track length = 0, an error is reported when the cam track of a 
non-modulo axis is activated. If track length = 0 for a modulo axis during cam track 
activation, the cam track length is set to the axis modulo length.  

3.2.3.2 Effective direction and behavior 
The following diagram shows output cam behavior on switching on and off, without 
hysteresis, activation or deactivation time.  

 
Figure 3-9 Output cam behavior on switching on/off 
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The switching characteristic depends only on the position (position setpoint or actual 
position). The cams on a cam track switch independently of the direction of motion, i.e. they 
always have a positive and negative effective direction. A position-based cam can be output 
repeatedly on changing the direction of movement. Time-based cams are output once only. 

3.2.3.3 Hysteresis 
If the actual position value tends to fluctuate due to mechanical influences, specification of a 
hysteresis prevents the output cam from unintended switch status changes.  

 
Figure 3-10 Hysteresis 

Conditions for the hysteresis range  
● Hysteresis is not activated until the direction has been reversed. 
● The direction of motion is not redefined within the hysteresis. 
● Within the hysteresis, the switching state of position-based cams is not changed. 
● If modified switching conditions for the output cam are detected when the output cam is 

outside the hysteresis range, this current switching state is set. 

Example: position-based cam hysteresis 
Cam track configuration (only one output cam configured): 
Output cam type: position-based cam; switch-on position, 20 mm; switch-off position, 200 
mm; hysteresis, 20 mm; effective direction: both 
Axis positions: 
0 mm -> 100 mm -> 10 mm -> 50 mm -> 0 mm -> 150 mm -> 0 mm 
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Hysteresis

Actual position of axis

X
START

Switching state of output cam

 
Figure 3-11 Hysteresis range (height of blue sections) and behavior of a cam track with a position-based cam, effective 

direction in both directions. 

As the cam track switches in both directions, the output cam does not switch off after the first 
reversal of direction. The second switch-on point is moved to position 30, due to active 
hysteresis. 

Example: time-based cam hysteresis 
Cam track configuration (only one output cam configured): 
Output cam type: time-based cam; switch-on position, 40 mm; ON duration, 0.5 s; 
hysteresis, 20 mm; effective direction: both 
Axis positions: 
0 mm -> 100 mm -> 20 mm -> 50 mm -> 30 mm -> 80 mm -> 10 mm -> 150 mm 

 
Figure 3-12 Hysteresis range (height of blue sections) and behavior of a cam track with one time-based cam, no effective 

direction. 

Time-based cam switches off only after ON duration has expired, not after change of 
direction. 
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Time-based cams with a start position within the hysteresis range are not output (see figure 
above). 

Hysteresis range 
The upper limit of the hysteresis range is set at 25% of the working range for a linear axis, 
and 25 % of the rotary axis range for a rotary axis. If you violate this maximum setting, an 
error message is issued. In practice, a lower setting is used for the hysteresis range. 
● Path-controlled output cam 

The hysteresis becomes active after direction reversal is detected. The output cam 
switches off once the hysteresis has been left and the position is located outside of a 
defined output cam. 

● Time-based cam 
The switching behavior of a time-based cam is determined by the ON duration, not by the 
hysteresis. This means that an entered hysteresis range has no influence on the ON 
duration of an output cam. It only has an influence on the switch-on time (start position). 

● Time-based cam with maximum ON length 
The maximum ON length switches off the output cam once the hysteresis has been left 
and the maximum ON length has been exceeded. 

 

 
 

Note 
If a time-based cam's start position lies within the hysteresis, it is not output. 

 

3.2.3.4 Derivative-action times (activation time/deactivation time) 
To compensate for the switching times of digital outputs and connected switching elements, 
or of propagation delays, it is possible to specify actuation times. Actuation times are 
calculated from the sum of all delay times and can be specified separately for activation and 
deactivation edges as an actuation time at the activation edge (activation time) or an 
actuation time at the deactivation edge (deactivation time).  
The activation/deactivation times of the output cam are dynamically compensated by means 
of the derivative-action times. In this way, output cams are dynamically shifted depending on 
the actual velocity. 
For example, a valve that should open at 200°, with an activation time of 0.5 s  
● Must be controlled at 195° at a velocity of 10°. 
● Must be controlled at 190° at a velocity of 20°. 
This dynamic shift takes place automatically by means of the Cam Track TO. 
Settings for the activation and deactivation times can contain positive or negative values. 
A negative activation time must be entered if the output cam is to be switched before the 
programmed start of the output cam. 
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Figure 3-13 Switching behavior at varying actuation times 

 

 Note 
The time of output for the output cam in the control is relevant for calculation of the dynamic 
adjustment. If velocity changes up to signal output, these changes are no longer taken into 
account. 
Dead times, e.g. PROFIBUS DP communication times, output delay times on digital outputs, 
etc., are taken into account in the actuation time. 
Long actuation times exceeding one modulo cycle may lead to heavy fluctuation of the 
switching position of actual value output cams (actual value curve). Here, setpoint output 
cams should be used or the actuation time should be considerably less than one modulo 
cycle. 

 

The system takes into account the specified actuation times when the output cams are 
calculated and managed. If, allowing for actuation times, the output cam was switched, then 
the system deems this operation to have occurred, and it does not switch the output cam 
again even if any subsequent current velocity changes occur. 
The dynamic actuation of modulo axes can be greater than one modulo length. However, the 
number of switching operations is not collected by the system, i.e. for actuation times longer 
than one modulo length, a switching operation cannot take place in each modulo cycle. One 
switching operation is active in the system at any given point in time. A switching operation is 
completed when the output cam is switched off. 

Actuation times and cycle clock settings 
A change of cycle clock settings does not have to be taken into account for the actuation 
time settings (activation/deactivation time). These are, for example: 
● Change of position control/IPO/IPO2 cycle clock settings (e.g. from "1/1/1 ms" to "2/2/2 

ms"). 
● Change of processing cycle clock of the cam track TO (setting: position control cycle 

clock, IPO, or IPO2). 
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When the position control:IPO ratio is ≠ 1:1, then the greatest possible accuracy for the 
calculation is reached for "output cams related to position value" when the position control 
cycle clock is set as the processing cycle clock for the cam track TO. 

Deactivation time for time-based cam  
Deactivation time is also taken into account in setting a time-based cam. 
Deactivation time must be: 
● Deactivation time ≤ activation time + ON duration 
Activation and deactivation times can vary independently of the I/O and can, therefore, 
influence the ON duration of the time-based cam. 
 

3.2.3.5 Cam track activation 
The _enableCamTrack command activates the cam track. On activation, the defaults are 
transferred to the system variables. If you explicitly want to use other values, these must be 
transferred with the command.  
The following parameters are transferred via the _enableCamTrack command: 
● Cam track data 
● Output cam data 
If you do not transfer any new data when activating the command, the defaults are used. 

3.2.3.6 Cam track deactivation 
Cam tracks are deactivated automatically or via a command.  

Automatic deactivation 
Automatic cam track deactivation is only possible when the configuration data 
octBaseCfg.keepEnabledOutOfTrackRange has been set to NO. In this case deactivation 
occurs on exiting the domain of the cam track, i.e. the track start (in a negative direction) or 
the track end (in a positive direction). It is not possible to reverse the direction of movement 
repeatedly within the track length. Output cams can therefore be output repeatedly. 
Automatic deactivation is set as default. As of V4.1 you can set the deactivation via the 
configuration data. 

 

 Note 
In the cam track Configuration window, you can configure the automatic deactivation via 
Leave non-cyclic activated cam track active in the axis range. 

 

Deactivation via command 
The _disableCamTrack command is used to deactivate the cam track. 
You can parameterize the deactivation time for the _disableCamTrack command (see 
Section Start mode and stop mode). 
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3.2.3.7 Leave cam track active in the axis range (as of V4.1) 
Non-cyclic activated cam tracks are deactivated per default when the cam track length is 
exited. So that the non-cyclic cam track remains active over the entire axis range (also 
outside of the cam track length), you must set the configuration data 
octBaseCfg.keepEnabledOutOfTrackRange to YES. When the cam track length is exited, 
the non-cyclic cam track remains active and is deactivated, for example, via command.  

 

 Note 
In the cam track Configuration window, you can deselect the automatic deactivation via 
Leave non-cyclic activated cam track active outside of the track range. 

 

Features 
● Valid for modulo axes and non-modulo axes 
● With modulo axes, the cam track is only switched in the appropriate modulo range of the 

axis, and not in every modulo range. This also ensures a clear assignment when cam 
track lengths ≥ modulo length. 

● Value=NO: Non-cyclic cam track is only active within the cam track length. 
If the axis or external encoder moves out beyond the cam track length, the cam track is 
deactivated. Returning to this length triggers new switching operations. 

● Value=YES: Non-cyclic cam track is active over the entire axis range, also after leaving 
the cam track length If the axis or external encoder moves out beyond the cam track 
length and then back into the cam track range, the configured output cams switch again. 

Example 
There is a linear axis (non-modulo axis) with a traversing range of -1000 mm to 1000 mm 
and a cam track with a track length of 200 mm (-100 mm to 100 mm). The cam track is to 
remain active over the entire axis range and the cam track is to be activated non-cyclically. 
After the cam track is exited (2), it remains active and is switched again after the reversal of 
direction (3) (see figure below). 

 
Figure 3-14 Leaving cam track active over the entire axis range 
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3.2.3.8 Start mode and stop mode 
Start mode and stop mode are used to parameterize behavior on activation or deactivation of 
a track.  

Start mode  
The start mode (startMode) is used to define when the cam track should become effective 
after activation, or how tracks should be changed. 
The mode is defined either as part of the cam track configuration in the Default window, or 
directly as a default setting using the _enableCamTrack command. 

Table 3- 4 Types of start mode 

Start mode Description 
Effective immediately (default) 
(IMMEDIATELY)  

Track becomes active immediately. If an output cam (or time-based cam) is defined or 
active at the current position of the old track, the output is aborted. The new track is 
enabled without delay (as quickly as possible). This enables high-speed exchange of 
cam tracks. 
If an output cam is already controlled and new data from the exchanged cam track 
continues to control the track signal, the track signal is not interrupted. 

Immediately when cam track 
output inactive 
(IMMEDIATELY_BY_CAM_TRA
CK_OUTPUT_INACTIVE) 

Changeover is made to the new cam track if no single output cam is active (any longer) 
on the old cam track. An active (output) single output cam on the old cam track is still 
output completely. 
If a changeover to the new track has not been made at the start position of a single 
output cam on the new track, this output cam is not output. Only after the tracks have 
been exchanged are the subsequent output cams on the new track output. 

With next track cycle 
(NEXT_CAM_TRACK_CYCLE) 

Track does not become active until the next track cycle, after either the axis reference 
position (in the positive traversing direction) or the end position of the cam track (in the 
negative traversing direction). The cam track end of the old track equals the axis 
reference position of the new track. Immediately the first output cam on the new track 
switches, a changeover is made to the new track. Up to that point, a time-based cam on 
the old track is output. 
The previous cycle is processed according to the previous command, the next cycle 
according to the _enable command. This allows the next track to be enabled, although 
another track is currently being processed. 
It is necessary to use this mode if the enable must occur before the start of the new 
cam track, for example, if the first output cam lies at the very start, but an output cam at 
the very end of an old (inactive) track is not to be enabled by mistake. 

Last programmed value The last programmed stop mode is active. If a stop mode is not programmed, the user 
default setting is used. 

Changing cam track output on the basis of the selected start mode 
The effect of the start mode on cam track output is shown in the following table for two cam 
tracks. The examples refer to activation of the same cam track with new or modified data. 
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Table 3- 5 Start mode examples 

Mode Description Display on cam track output 
 One cam track with different data is 

given. 
• Cam track 1 (A to C) 

active cam track 
• Cam track 2 (1 to 3) 

is activated 

 

 
Effective 
immediately 
(IMMEDIATELY) 

• New cam track becomes active 
immediately. 

• Cam track output becomes inactive. 
• Output cams 1, 2 and 3 are output. 

 

 
 

Cam track output 
inactive 
(IMMEDIATELY_B
Y_CAM_TRACK_
OUTPUT_INACTI
VE) 

• New cam track becomes active at a 
cam track output of zero. 

• Output cam A on the active track is 
output completely. 

• Output cams 2 and 3 are output. 
• Output cam 1 is not output. 

 

 
 

With next track 
cycle 
(NEXT_CAM_TRA
CK_CYCLE) 

• Cam track is exchanged at the axis 
reference position of the new cam 
track. 

• Example 1, position-based cam: 
Position-based cam of the old track 
is terminated. 

• Example 2, time-based cam: 
New cam track becomes active with 
the first output cam of the new track, 
at the latest. Up to that point, time-
based cams remaining from the old 
cam track are still output. 

 

 
 

Stop mode  
The stop mode (stopMode) is used to define the behavior of the cam track on deactivation. 
The mode is defined either as part of the cam track configuration in the Default window, or 
directly as a default setting using the _disableCamTrack command. 
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Table 3- 6 Types of stop mode 

Stop mode Description 
Effective immediately (default) 
(IMMEDIATELY)  

Track is deactivated immediately. If an output cam (or time-based cam) is defined or 
active at the current position of the track, the output of output cam is aborted. 

Immediately when cam track 
output inactive 
(IMMEDIATELY_BY_CAM_TRA
CK_OUTPUT_INACTIVE) 

If no single output cam is active (any longer), the active cam track is stopped. An active 
(output) single output cam is still output completely. 

At end of cam track 
(BY_CAM_TRACK_END) 

Track is deactivated at its end. Immediately the final output cam on the track switches, 
the track is deactivated. Up to that point, a time-based cam on the track is output. 

Last programmed value The last programmed start mode is active. If a start mode is not programmed, the user 
default setting is used. 

3.2.3.9 Output activation mode 
Cam tracks can be output in a cyclic or non-cyclic mode. This setting is also transferred 
when activating the cam tracks (_enableCamTrack)  

Cyclic output 
The CYCLIC setting in the activationMode parameter is used to predefine the activation 
mode for cyclic output of the cam track. 
The cam track's track length is mapped from the start position and continued/repeated 
cyclically. The cam track switches after the axis reference position and remains active until it 
is switched off with _disableCamTrack. 

Non-cyclic output 
The NO_CYCLIC setting in the activationMode parameter is used to predefine the activation 
mode for non-cyclic output of the cam track. 
The cam track is mapped from the start position, output once only and terminated 
automatically after reaching the end position or remains active in the axis range. The 
performance depends on the value of the configuration date octBaseCfg. 
keepEnabledOutOfTrackRange. 

Example of cyclic and non-cyclic output 
A cam track is mapped onto a modulo axis. The figure shows a representation of the 
different activation modes. 

 
Figure 3-15 Example of cyclic and non-cyclic output on a modulo axis 
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3.2.3.10 Axis reference position and cam track offset 
Cam tracks are defined independently of the axis. Output cams are not calculated according 
to the defaults until they are mapped onto the axis. The 
(enableCamTrack.axisReferencePosition) axis reference position is used to define from 
which position on the axis the cam track should be output. The axis reference position value 
can be negative or positive. The cam track is always output relative to this position data.  
The axis reference position enables you to offset the cam track on the axis as you wish, and 
therefore to define when the output should take place (see figure in Section Cam track 
features). 
A cam track is mapped to the axis range exactly once, beginning with the axis reference 
position specified in the enable command. This axis reference position represents the 
beginning of the cam track (applies for modulo and non-module axes). Upon activation, the 
cam track is executed once (NO_CYCLIC) or continued cyclically (CYCLIC). 

3.2.3.11 Simulation 
Operation can be simulated by means of the simulation commands on the cam track. The 
cam track status is then not output to the hardware output. In simulation mode, hardware 
cams behave as software cams. They are then only used for programming purposes.  
If an active cam track is switched to simulation mode (_enableCamTrackSimulation), the 
output cam status remains the same, and only the control of the output is reset or 
interrupted. 

3.2.4 Configure Units 
You can define the basic units for each technology object. The same physical variables can 
have different units in different technology objects. These are converted:  

How to configure the units: 
1. Open the context menu for the technology object in the project navigator. 
2. In the context menu, select Expert > Configure units. The Configure Units window 

appears in the working area. 
3. Select the unit for the physical variables. These units are used for the technology object, 

e.g. s for time units. 
or 
1. In the project navigator, open the Configuration under the TO. 
2. Select the tab Units. 
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You can set the following parameters: 

 
Field/Button Explanation/Instructions 
Unit system Drop down list for preselecting the units to be displayed 

The "SI units system" is set by default in the drop down list 
when creating anew. 

Table with units  
 Physical parameter column Displays the physical parameter. The physical parameters 

which are also used by the TO are made available. 
 Unit column Display and configuration for unit. A drop down list for 

selecting the unit appears when you click on the cell. 
Toolbar  
  Displays whether offline data or online data is shown 

• Blue field = offline display 
• Yellow field = online display 

 Close Button for closing the dialog. 
 Help Button for opening the dialog's online help. 
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3.2.5 Mapping a cam track onto an axis 
The cam track is defined independently of the axis. On activation, the cam track is mapped 
onto the axis. Only then are the switching states of the output cams calculated.  

See also 
Basics of cam track mapping (Page 81) 
Mapping output cams onto the cam track (Page 82) 
Mapping onto negative axis positions (e.g. linear axes) (Page 83) 
Relation of track length, modulo length and activation mode in mapping (Page 84) 

3.2.5.1 Basics of cam track mapping 
● Conversion and mapping of the track onto the axis is identical for modulo and non-

modulo axes. Certain points must be noted when mapping onto negative reference 
positions (see Section Mapping onto negative axis positions (e.g. linear axes)). 

● The track length can be longer than, shorter than or equal to the modulo length of the 
axis. Based on this relationship, the switching states of the output cams may differ when 
they are mapped onto the axis. 

● The positions of single output cams always relate to the cam track, not to the axis 
position. Only on activation of the cam track and entry of the axis reference position is a 
relationship to the axis position created (start of cam track output). 

● If the cam track is activated and the axis rotates negatively, the track will also travel in a 
negative direction. There is no conversion on the basis of the direction of rotation (see 
figure). If a cam track should always be output in a positive direction, irrespective of the 
axis direction, this must be solved in the application. 

 
Figure 3-16 Cam track in positive and negative direction, depending on axis direction 

● Cam tracks defined outside of the track length limits are mapped or converted during 
mapping onto the track range. 
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3.2.5.2 Mapping output cams onto the cam track 
The _enableCamTrack command is used to map the starting and end positions of the output 
cam individually onto the cam track (not onto the axis). Output cams, which have been 
defined outside of the track range, are converted to this track. Negative starting and end-
position values are also converted to the cam track.  
"Unfavorable" starting and end-position default settings for output cams, e.g. output cam 
position outside of the track range, can lead to output cams being shifted, or new output 
cams being created. This must be taken into account when mapping the cam track onto the 
axis. 

 

 Note 
After converting the cam track onto the axis, the effective output cam length is always 
shorter than or equivalent to the track length. No output cams are defined outside of the 
track length. 
For standard applications, and in the interests of clear programming, automatic conversion of 
output cams should be avoided. This can be achieved by only defining output cams, which 
lie within the track length. 

 

Mapping example 
A cam track with three output cams (OC1 - OC3) is provided. The end position of output cam 
OC2 and the entire output cam OC3 are defined outside of the track length. After being 
mapped onto the axis, OC3 is converted to the track length and mapped to position OC3*. A 
new output cam OC4* arises from partial output cam OC2. 

 
Figure 3-17 Parts of cam track lie outside of the track length 
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3.2.5.3 Mapping onto negative axis positions (e.g. linear axes) 
Output cams on the cam track are always predefined positively. If you want to output output 
cams at negative axis positions, the cam track output start must be set in the negative range 
by means of the axis reference position.  

Example of a linear axis with negative axis position 
● Range of linear axis: -1000 mm to +1000 mm (non-modulo axis) 
● Output of output cam at axis position: -100 mm to -200 mm 
● Cam track length: 2000 mm 
● Definition of the output cam on the track: SOC=800 mm; EOC=900 mm 
By mapping the cam track via the axis reference position, the output cam OC1 can be output 
at a negative axis position. 

 
Figure 3-18 Linear axis with output of output cam at negative axis position 

Please note that during cyclic output (CYCLIC), cam tracks are continued cyclically even 
with non-modulo axes, and thus the cam track can be output multiple times to different axis 
positions. 
If a cam track is to remain switched on permanently and only output at one axis position, we 
recommend the following setting: cam track length ≥ axis traversing range. 
This setting prevents the cam track from being continued cyclically in the case of cyclic 
output of a cam track after execution of the track range (in the figure: axis position - 1000 to 
+1000). 
In the above figure, for example, the cam track would be continued cyclically 
● in the positive range from axis position 1000 to 3000; 3000 to 5000 etc 
● In the negative range from axis position -1000 to -3000; -3000 to -5000 etc. 
. 
The same behavior applies also for non-modulo rotary axes. 
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3.2.5.4 Relation of track length, modulo length and activation mode in mapping 
In conventional output-cam output (comparable to mechanical cam controllers), the track 
length corresponds to the modulo length of the axis and cyclic output takes place.  
With electronic cam controllers, the track length can be shorter or longer than the modulo 
length of the axis, therefore offering a greater degree of flexibility. 
● Track length (tl) < modulo length (m) (integer ratio m to tl) 

Track length is output n-fold (n = m/tl) on modulo length. 
● Track length (tl) > modulo length (m) (integer ratio tl to m) 

Output takes place on every nth rotation (n = tl/m). Output always takes place after the 
first quadrant. If the output takes place differently, a greater track length must be defined 
and the output cam placed accordingly. 

● Non-integer division ratios lead to the cam track being dislocated on every axis rotation. 

Use of cyclic output with track length = n x modulo length 
If the track length is n times the modulo length, cyclic output allows a repetitive output of 
output cam to be easily achieved on every nth rotation (e.g. an air nozzle, which is always 
activated in the same angular range on every nth rotation). 

Use of cyclic output with track length = 1/n x modulo length 
A cycle scan rate is described using the example of a packaging machine with variable 
product lengths. 
A cam controller controls/triggers all machine functions through a machine cycle of 0-360° 
(fed from left-hand area, see figure below). The product lengths may vary and are always 
mapped at 360°. 
The machine cycle is subdivided into four identical operation steps at an operating station 
(right-hand area). The output cam is output cyclically for the operating station, with the track 
length = 1/4 modulo length of axis. The output cams on a cam track define the operating 
steps for one of the four identical feeds. 
The advantage of this solution is that the product defaults are set in mm of the blister length 
and calculation/mapping at 360° only has to take place once. In this example, one machine 
cycle is used for four purposes. The same outputs are required for one use. Therefore, the 
same configuration does not have to be performed four times. Rather, the repetition factor n 
is calculated into the track length of the cyclically active track. 

 
Figure 3-19 Packaging machine with reduced cycle 
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Example of a modulo axis with cyclic output  

Table 3- 7 Example of a modulo axis with cyclic output and track length < modulo length 

Cam track data/Explanation Representation 
• Modulo length: 360° 
• Track length: 0-120° 
• Output cam defaults: SOC=10°, EOC=20° 
Output cam is output cyclically every 10-20°, 130-
140°, 250-260°, etc.  
If the direction of movement is reversed at 50°, 
for example, the 10-20° output cam will be output 
again. 
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Example of a modulo axis with non-cyclic output 
The example (following table) below shows a modulo axis with non-cyclic output, next-track-
cycle start mode, and varying enable positions and axis reference positions. 
● Enable A, axis reference position 0°, positive direction of rotation: 

output cam A is output. 
If the cam track is not exited, output cam A switches multiple times when the direction is 
reversed. The cam track output is terminated on exiting the cam track. 

● Enable A, axis reference position 240°, negative direction of rotation: 
output cam C is output during the next cycle. 

● Enable B, axis reference position 120°, positive direction of rotation: 
output cam B is output. 

● Enable C, axis reference position 240°, positive direction of rotation: 
output cam C is output. 

Table 3- 8 Example of a modulo axis with non-cyclic output and track length < modulo length 

Cam track data/Explanation Representation 
• Modulo length: 360° 
• Track length: 0-120° 
• Output cam defaults: SOC=10°, EOC=20° 
• Start mode: with next track cycle 

 

 
 

3.2.6 Cam track operating behavior 
Changes made to the configuration and defaults of cam tracks or their associated axes 
during operation affect the cam track, which is active at that time. This section briefly 
describes the most important changes.  
An explanation of how you can determine the status of single output cams and cam tracks is 
also provided. 
The values of system variables are stored in the userdefault array. This array is transferred 
on using _enableCamTrack to activate a cam track. These defaults are configured during 
cam track configuration or other values can be written to them dynamically in the user 
program. 
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See also 
Changing output cams on a cam track during runtime (Page 87) 
Changing the track length during operation (Page 88) 
Changing the axis configuration when a cam track is active (Page 88) 
Calling up the status of cam tracks and single output cams (Page 89) 

3.2.6.1 Changing output cams on a cam track during runtime 

Changing start and end positions of an output cam 
The start and end positions of single output cams can only be changed by transferring the 
new single positions to the userdefault array and using _enableCamTrack to activate the 
changed array. 

Validity of single output cams on a track  
You can define whether single output cams on a track are valid or invalid. This enables you 
to define whether single output cams should be output or not. If existing output cams are to 
be activated on an already active cam track, the relevant 
userdefault.singleCamSettings.cam.cam[0-31].validity system variable can be set with the 
value YES or NO, and the _enableCamTrack system function must be executed. 
When parameterizing the cam track in SIMOTION SCOUT, validity can be set during 
configuration in the Default window and the Output cam data tab (see the Defining cam track 
defaults section). 

Disabling or enabling valid output cams of a cam track without reactivation via 
_enableCamTrack (as of V4.1)  
Valid output cams of a cam track can be quickly disabled or enabled via the enableValidCam 
system variable without reactivation of the cam track via _enableCamTrack. 
Default setting of the enableValidCam system variable is 0xFFFFFFFF, i.e. all valid output 
cams are enabled. By setting the bit of the relevant output cam, e.g. Bit_0 for output cam 0, 
the valid output cam is enabled with 1 and disabled with 0 (e.g. only output cam 0 is disabled 
with 0x FFFFFFFE). 
Properties of enableValidCam: 
● Value of enableValidCam is retained with reactivation by _enableCamTrack 
● During system ramp-up or with _resetCamtTrack, enableValidCam is set to the default 

setting 0xFFFFFFFF. 
● Invalid output cams cannot be enabled via enableValidCam. 
● System variable takes effect immediately without activation of the cam track. 
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3.2.6.2 Changing the track length during operation 
The userdefault.camTrackLength system variable can be used to change the track length of 
an active cam track during operation. Changes to a track length do not become effective until 
the cam track is reactivated (_enableCamTrack). The track length of the cam track that is 
already active remains unchanged unless it is overridden by the changed cam track.  

Example of a changed track length 
● 360° track length is changed to 400° and the new track is activated. 
● Output cam defaults: SOC=310°, EOC=30° 

 
Figure 3-20 Changed track length with an effect on switching states 

3.2.6.3 Changing the axis configuration when a cam track is active 
Changing the axis configuration for an assigned, active cam track affects cam track 
behavior.  

Changing modulo length  
Changing the modulo length of an axis does not affect the definition or behavior of a cam 
track when it is enabled. 
If the modulo length of an axis is changed, the conversion of the cam track on that axis is not 
automatically adjusted. If necessary, when changing the modulo length, you must deactivate 
the active cam track and activate it again, so that the axis can be mapped according to the 
new modulo length. 
Output-cam output is aborted if the modulo length on an axis is changed and the axis is 
restarted. 

Redefine axis 
If the axis position is changed during operation, e.g. with _redefinePosition, the cam track is 
aborted and restarted. The change is interpreted as a skip in the modulo range. The cam 
track is mapped onto the new modulo range of the axis. 
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3.2.6.4 Calling up the status of cam tracks and single output cams 
You can detect the status of single output cams and cam tracks at any time via system 
variables, and use the status in the user program.  

Table 3- 9 Status and position of cam tracks and single output cams 

System variable Meaning Description 
control Functional status of Cam 

Track TO 
The variable displays the state of the cam track. For example, it can 
be active, inactive or waiting for the next cam track cycle. 

state Output status The variable displays if cam track output is in an ON or OFF state. 
singleCamState Status of single output cam The singleCamState system variable is used to read out the status 

of single output cams. The variable consists of a 32-bit array, in 
which the lowest bit (bit0) represents output cam 0. 

camTrackPosition Position of the cam track The camTrackPosition system variable is used to read out the actual 
position of a cam track operation within a cam track cycle. 
The cam track position is required, because the actual track position 
of a cam track cannot be determined by means of the axis position 
of a modulo axis (as, for example, the track length could be longer 
than the modulo range of the axis).  
The detected value always lies between the start (always "0") and 
end (defined by the cam track length) of the track. 

3.2.7 Inverting a cam track 
If the application requires, you can invert the cam track's activation level. The Cam Track TO 
retains its positive logic. The cam track switches at level 1 or high. 
You can set the inversion via the OctTechnologicalCfg.invertOutput configuration data 
element or in the Configuration window of the cam track. The TO must be restarted in order 
for a change to be made.  
 

3.2.8 Effect of cam track parameters on mapping 
This chapter uses examples to explain the effect of configuration changes on cam track 
mapping onto an axis. 

See also 
Basic mapping of a simple cam track (Page 90) 
Advanced mappings with shifted output cam positions (Page 91) 
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3.2.8.1 Basic mapping of a simple cam track 

One cam track with the following data is given. 
● Three position-based cams (10-20; 30-50; 60-90) 
● Activation mode: Non-cyclical cam track activation 
● Start mode and stop mode: Effective immediately 
● Track length: 100 
● All other user-default variables are the default setting unless another setting is mentioned 

explicitly. 

 

Display of given cam track with modified axis reference position, activation mode, and track 
length 
● Activation mode: Cyclic 

 
● Activation mode: Cyclic 
● Axis reference position: 20 

 
● Activation mode: Cyclic 
● Axis reference position: 20 
● Track length: 130 

 
The following applies: 
● A change of axis reference position causes a change in the cyclic and non-cyclic mode. 

The cam track is offset once. 
● A track length change only affects the cyclic mode and causes an offset in the cam track 

cycle. 
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Display of given cam track with modified start/stop mode 
● Start mode: Effective immediately 
● Position of axis on which _enableCamTrack occurs: 40 
● Position at which _disableCamTrack occurs: 170 
● Activation mode: Cyclic 

 
● Start mode: Immediate for inactive output cam track output 
● Position of axis on which _enableCamTrack occurs: 40 

 

3.2.8.2 Advanced mappings with shifted output cam positions 
The following chapter presents examples of a cam track with shifted single cams, i.e. when 
they are mapped onto the axis, single cams are shifted to another position if they are defined 
outside the track length. 

One cam track with the following data is given. 
● Three position-based cams (30-60; 110-120; 170-190) 
● Track length: 100 
● Axis reference position: 0 
● All other user-default variables are the default setting unless another setting is mentioned 

explicitly. 

1000 50 150 200

1000 50 150 200

Mapping Mapping

Single output cams of the cam track are mapped onto the track 

length and the position is recalculated. A new output cam track 

results.
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Display of given cam track with modified activation mode and axis reference position 
● Activation mode: Cyclic 

 
● Mode: Cyclic 
● Axis reference position: 20 
● Position at which _disableCamTrack occurs: 150 

 

3.3 Configuring the TO Cam Track 
This chapter describes typical operations used when working with the Cam Track technology 
object.  

See also 
Inserting cam tracks (Page 92) 
Parameterizing the Cam Track technology object (Page 93) 
Using expert list for cam tracks (Page 94) 
Configuring a cam track (Page 94) 
Defining cam track defaults (Page 97) 
Determining derivative-action times for cam tracks (dead time compensation) (Page 107) 
Using HW enable for cam tracks (Page 109) 

3.3.1 Inserting cam tracks 
 

 Note 
Before you insert a cam track, the axis or external encoder to which the cam track is 
assigned has to be created. 
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To insert a cam track:  
1. In the project navigator, highlight the OUTPUT CAMS folder under the relevant axis or 

external encoder. 
2. Select Insert > Technology object > Cam track or double-click Insert cam track in the 

project navigator under the axis or external encoder in the OUTPUT CAMS folder. The 
Insert cam track window appears. 

3. Enter a name for the cam track. You can also enter a comment. 
Names must be unique throughout the project. For this reason, all the existing output 
cams are displayed under Available cam tracks. 

4. Confirm with OK. In the working area, the window for the configuration is displayed and 
the created cam track TO is shown in the project navigator. 

 

3.3.2 Parameterizing the Cam Track technology object 

General information about configuration data and system variables  
Two data classes are distinguished when parameterizing a TO. 
Configuration data define the principal functionality of a TO. They are set within the object 
configuration framework with the SCOUT engineering system and are not normally changed 
during runtime. 
System variables provide status data of the TO for the user program and a parameterization 
interface on the TO. System variables can be changed during runtime. 

 

 Note 
For more information about technology objects, refer to the SIMOTION Motion Control Basic 
Functions functional description. 

 

To parameterize a cam track  
1. In the project navigator under the OUTPUT CAMS folder, find the cam track technology 

object (TO) that you want to parameterize. Double-click the cam track TO to display the 
associated objects. 

2. Double-click Configuration or Default in the project navigator. The window appears in the 
working area. 
– Configuration (see the Configuring a cam track section): 

Define the values for the configuration data of the cam track here. This includes, for 
example, output cam type.  

– Default (see the Defining cam track defaults section): 
Define the cam track defaults of the system variables here. This can include, for 
example, cam track and output cam data.  

3. Changing configuration data and defaults 
4. Click Close to accept the changes. 
5. Repeat steps 2 to 4 for all objects in which you want to change the configuration data and 

defaults. 
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3.3.3 Using expert list for cam tracks 
Parameters required for standard SIMOTION applications (configuration data and system 
variables) are parameterized in the Cam Track TO directly by means of screen forms or are 
defined automatically. 
It may be necessary to change automatically-defined parameters for special SIMOTION 
applications. These configuration data and system variables can only be displayed and 
changed in the expert list.  

 

 Note 
For more information about working with the expert list, refer to the SIMOTION Motion 
Control Basic Functions functional description. 

 

 

3.3.4 Configuring a cam track 
In the Configuration window, define the configuration data values for the cam track. 
Double-clicking in the project navigator below the cam track on the Configuration element 
displays the window in the working area.  

 
Figure 3-21 Output cam configuration using the example of a position-based cam 
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You can set the following parameters: 

Table 3- 10 Cam track configuration data 

Field/Button Significance/Note 
Name The name of the created cam track is displayed here. 
Output cam type 
(see the Output cam 
types of the single output 
cams on a track section) 

Choose the type of output cam used on the track in Output cam type. 
Position-based cam 
(default value) 
The switching signal is active when the position of the axis lies between two markers (start and 
end position). 
Time-based cam 
The switching signal is on for a specific period of time after reaching the switching position 
(start position). 
Time-based cam with maximum ON length 
A maximum ON length can also be defined for time-based cams. This means that the time-
based cam is deactivated once it has covered the maximum length, even though the 
parameterized time has not yet expired. 

Processing cycle clock Choose Processing cycle clock to select the system cycle clock used to update the output cam 
signal at the output or in the system variables. 
The output cam calculations are performed in the IPO or IPO2 cycle clock, or the position 
control cycle clock. The processing cycle clock is set in the configuration by means of the 
OctBaseCfg.taskLevel configuration data element. 
IPO 
(default value) 
The output cam signal is updated in the interpolator cycle clock.  
IPO2 
The output cam signal is updated in the interpolator cycle clock 2. The IPO2 cycle clock length 
is at least twice that of the IPO.  
Position control cycle clock 
The output cam signal is refreshed in the position control cycle clock.  
The following configurations of the processing cycle clock are possible: 
• Axis in IPO cycle clock and output cam in IPO2 cycle clock 
• Output cam in position control cycle clock and axis in IPO or IPO2 cycle clock 
It is not possible to configure the axis in the IPO2 cycle clock and the output cam in the IPO 
cycle clock. 
Note: 
When the position control:IPO ratio is ≠ 1:1, then the greatest possible accuracy for the 
calculation is reached for "output cams related to position value" when the position control 
cycle clock is set as the processing cycle clock for the cam track TO. 

Type of output cam value Select the position value that is the reference for the output cam during processing. 
Setpoints 
(default value) 
The output cam refers to the current setpoint during processing. With regard to output cam 
values at the setpoint, the output cams are output delayed by one cycle because the setpoints 
are also only output and can therefore only take effect in the next cycle.  
This also relates to displaying the output cam status.  
Actual values 
The output cam refers to the current actual value during processing.  

Activate output Activate the checkbox if the output cam signal is to be applied to a digital output. Parameters 
are displayed. 
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Field/Button Significance/Note 
Cam output on  
 cam output (CAM) If the output check box is activated and the cam output (CAM) radio button selected, the 

output cams are output on the basis of an internal time stamp.  
The temporal resolution of cam output depends on the hardware used. In the case of D4x5-2 
and the TM17 high feature, the resolution is e.g. 1 µs. 
Hardware supported: 
• SIMOTION D4x5-2 (X142) 
• TM15, TM17 high feature 
The I/O channel must be configured as CAM. 
For more details, see cam output types. (Page 18) 
Note 
Cam output (CAM) or high-speed digital output (DO) are also known as high-speed, hardware-
supported output cams. 

 High-speed digital 
output (DO) 

If the output check box is activated and the "High-speed digital output (DO)" radio button 
selected, the output cam is output via onboard outputs of the SIMOTION CPU. Output is via a 
hardware timer, which achieves cam output with a temporal resolution < position control cycle 
clock. 
The time that it takes for the axis to reach the output cam switching position with reference to 
the processing cycle clock is calculated by linear extrapolation. Calculated from the beginning 
of the 1st position control cycle clock, the output cam function is triggered by a hardware time 
when this time is reached. 
Hardware supported: 
The onboard I/O of the following CPUs is used: 
• SIMOTION D4x5-2 (interface X142), 8 high-speed cam outputs, V4.2 or higher (The I/O 

channel must be configured as DO) 
• SIMOTION D4x5 (interface X122, X132), 8 high-speed cam outputs, V4.1 or higher (The 

I/O channel must be configured as DO) 
• SIMOTION D410 (interface X121), 4 high-speed cam outputs, V4.1 or higher (The I/O 

channel must be configured as DO) 
• SIMOTION C240, C240 PN (interface X1), 8 high-speed cam outputs 
For more details, see cam output types. (Page 60) 
Note 
Cam output (CAM) or high-speed digital output (DO) are also known as high-speed, hardware-
supported output cams. 

 Standard digital 
output (DO) 

If the output check box is activated and the "Standard digital output (DO)" radio button 
selected, the output cam is output in the position control cycle clock.  
The temporal resolution of cam output is usually reduced by the output cycle of the I/O used. 
Hardware supported: 
• Onboard outputs (SIMOTION D, Controller Extension CX, SINAMICS Control Unit CU3xx) 
• Centralized I/O (SIMOTION C) 
• Distributed I/O via PROFIBUS DP/PROFINET IO (e.g. ET 200, ...) 
• Drive I/O TM15, TM15 DI/DO, TM17 high feature, TM31, TM41, TB30 
For more details, see cam output types. (Page 60) 
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Field/Button Significance/Note 
Output The output can be symbolically assigned via the assignment dialog (see the Chapter entitled 

Symbolic Assignment (from V4.2 onward) in the Motion Control Basic Functions manual) using 
the  button in the Output field (symbolic assignment is activated by default in projects as of 
V4.2).  
If symbolic assignment is not active or if the CPU version < V4.2, a physical output is assigned 
by entering the HW address and bit number in the Output field. 
Enter the logical HW address of the output to which the output cam signal is to be applied. 
Only the output cam signal may be present at this address. If other objects are already using 
this output, an error occurs that is reported following downloading into the target system. The 
logical HW address must be located outside the process image and therefore be greater than 
63.  
For details see Cam output types (Page 18) 

 Button for opening the assignment dialog (see the Chapter entitled Symbolic Assignment (from 
V4.2 onward) in the Motion Control Basic Functions manual). Select a parameter or an 
address in the assignment dialog. 

 Displays whether offline data or online data is shown 
• Blue field = offline display 
• Yellow field = online display 

3.3.5 Defining cam track defaults 
You can define defaults for every cam track. These values are stored in system variables 
and can be changed by programs. 
Double-clicking in the project navigator below the cam track on the Defaults element displays 
the window in the working area.  

See also 
Track data (Page 98) 
Output cam data (Page 100) 
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3.3.5.1 Track data 
The defaults for the track system variables, e.g. track length, are displayed in the Track Data 
tab.  

 
Figure 3-22 Cam track data using the example of a position-based cam 

You can set the following parameters: 

Table 3- 11 Defaults for cam track data 

Field/Button Significance/Note 
Output cam type Output cam type displays the type of output cam selected for the cam track in the Configuration 

window.  
Activation mode 
(See the Output 
activation mode 
section) 

Cam tracks can be output in a cyclic or non-cyclic mode. 
Cyclic cam track activation 
The cam track's track length is mapped from the axis reference position and continued/repeated 
cyclically. 
Non-cyclic cam track activation 
Cam track is mapped from the axis reference position, output once, and terminated automatically 
after exiting the cam track or remains active in the axis range. This setting depends on the value of 
the octBaseCfg.disableOutOfTrackRange configuration data element. 
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Field/Button Significance/Note 
Start mode 
(See the Start mode 
and stop mode 
section) 

The start mode (startMode) is used to define when the cam track should become effective after 
activation, or how tracks should be changed. 
Last programmed value 
The last programmed start mode is active. If a start mode is not programmed, the user default 
setting is used. 
Effective immediately 
Track becomes active immediately. If an output cam (or time-based cam) is defined or active at the 
current position of the old track, the output is aborted. The new track is enabled without delay (as 
quickly as possible). This enables high-speed exchange of cam tracks. 
Immediately with inactive cam track output 
Changeover is made to the new cam track if no single output cam is active (any longer) on the old 
cam track. An active (output) single output cam on the old cam track is still output completely. 
With next track cycle 
The track becomes active at the next track cycle. Immediately the first output cam on the new track 
switches, a changeover is made to the new track. Up to that point, a time-based cam on the old 
track is output. 

Stop mode 
(See the Start mode 
and stop mode 
section) 

The stop mode (stopMode) is used to define the behavior of the cam track on deactivation. 
Last programmed value 
The last programmed stop mode is active. If a stop mode is not programmed, the user default 
setting is used. 
Effective immediately 
Track is deactivated immediately. If an output cam (or time-based cam) is defined or active at the 
current position of the track, the output of output cam is aborted. 
Immediately with inactive cam track output 
If no single output cam is active (any longer), the active cam track is stopped. An active (output) 
single output cam is still output completely. 
At cam track end 
Track is deactivated at its end. Immediately the final output cam on the track switches, the track is 
deactivated. Up to that point, a time-based cam on the track is output. 

Track length Enter the track length. The track length is calculated from the start of the cam track to the end of 
the cam track. 

Axis reference 
position 
(See the Cam track 
features section) 

The axis reference position is used to define how the cam track is mapped on the axis, or from 
which axis position the cam track should be output. 

Axis modulo length 
(See the Relation of 
track length, modulo 
length, and activation 
mode section) 

The modulo length of the axis, which the cam track is linked to, is displayed here. The modulo 
length does not have to be identical to the track length. To change the modulo length of the axis, 
you must work through the axis wizard. 
It is only displayed when the axis is configured as a modulo axis. 

Activation time 
(See the Actuation 
times (activation 
time/deactivation 
time) section) 

Enter the activation time here. The output cam switching time is set to the point when the start 
position is reached, plus this period. The output cam position is adapted dynamically. This allows 
you to compensate for propagation delays. 
If a negative value is entered as an activation time, the switching signal is activated before the start 
position is reached.  
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Field/Button Significance/Note 
Deactivation time Enter the deactivation time here. The output cam switch-off time is set to the point when the end 

position is reached, plus this period. The output cam position is adapted dynamically. This allows 
you to compensate for propagation delays. 
If a negative value is entered as a deactivation time, the switching signal is activated before the 
end position is reached.  

Hysteresis 
(See the Hysteresis 
section) 

Enter a range for the hysteresis here. The output cam does not change its switching state in this 
defined range around the switching position even under changed switching conditions. This 
prevents a repeated change of the switching state.  

3.3.5.2 Output cam data 
The defaults for system variables of single output cams on a track, e.g. starting and end 
position, are displayed in the Output Cam Data tab.  

 
Figure 3-23 Cam track output cam data, position-based cam example 
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You can set the following parameters: 

Table 3- 12 Cam track output cam data defaults 

Field/Button Meaning/Note 
Output cam 
(camType) 

The output cam number (0 - 31) is displayed here. Each track can have up to 32 output cams. 

Validity Select this checkbox, if you want to set the output validity of single output cams on a track. If the 
box is activated, the output cam will be output, along with the track. If it is not activated, the output 
cam is not output. 

Starting position Enter the starting position of the output cam. 
End position Enter the end position of the position-based cam here. 
Last programmed ON 
duration 
(See Section Time-
based cam) 

Enter the ON duration for time-based cams here. The output cam switches off once the 
parameterized time has expired.  

Max. ON length 
(See Section Time-
based cam with 
maximum ON length) 

Enter the maximum ON length for time-based cams with maximum ON length here. 

3.3.6 Configuring cam tracks on SIMOTION D4xx onboard 
Output cams and cam tracks can be configured for standard outputs, or as high-speed, 
hardware-based output cams / cam tracks.  

Cams can be configured on SIMOTION D4xx onboard as follows:  
1. In the project navigator, switch to the control unit via SINAMICS_Integrated > 

Control_Unit. 
2. Double-click Inputs/outputs below the control unit. The window appears in the working 

area. 
3. Switch to the Bidirectional digital inputs/outputs tab. 
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4. Click the button to switch between the input and output for the digital inputs/outputs (DO8 
to DO15). In each case, switch the DI/DO to the output you wish to use as the output of 
output cam. The designation at the terminal strip of DI or DO switches to DO. Outputs of 
the output cam can only be used if they have been defined as an output. DO8 is 
configured as output in the figure. For the output, select the DO (SIMOTION) setting. 

 

 
 

Note 
Mixed use of the SIMOTION D4xx DI/O as high-speed outputs (of output cams) and 
inputs of measuring inputs is possible. 

 

 
Figure 3-24 SIMOTION D4xx digital inputs/outputs 

5. Click Close. 
6. Insert a new output cam or a new cam track or use an existing one. 
7. Parameterize the TO Output Cam / Cam Track 
8. Double-click Configuration below the output cam or the cam track in the project navigator. 

The Configuration window appears in the working area. 
9. For high-speed, hardware-supported output cams, you can achieve an output accuracy 

exceeding the position control cycle clock based on the hardware used. Should you wish 
to configure a high-speed output cam, select the Activate output check box and select the 
High-speed digital output (DO) radio button. 

10. Assignment of an output to an output cam/cam track is supported as of V4.2 using 
symbolic assignment (see the Chapter entitled Symbolic Assignment (from V4.2 onward) 
in the Motion Control Basic Functions manual) or by means of entering the HW address. 

11. Click OK to close the window and select Project > Save. 

To determine the logical hardware address for outputs on SIMOTION D4xx onboard (only if 
symbolic assignment is not activated)  
1. In the project navigator, below the SIMOTION D device, select SINAMICS_Integrated > 

Communication > Message Frame Configuration. 
2. Double-click Configuration and, in the window which appears, select the tab IF1: 

PROFIdrive PZD message frame. The components are displayed there with address 
range (input/output data). 
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3. Select SIEMENS message frame 390, 391 or 392 as message frame type. A maximum of 
eight output cams can be configured for each message frame. The number of DI/DO is 
limited to eight, i.e. only two output cams can be configured for message frame 392 if you 
are already using six measuring inputs. Therefore consider whether you also want to use 
measuring inputs during the message frame selection. 

 
Figure 3-25 Determining the hardware address of the components 

4. Before you determine the hardware address, an alignment between HW Config and 
SIMOTION SCOUT, with respect to the address, must be performed. If this has not been 
performed or you have changed the addresses, click on Set up addresses. If there are 
question marks in the fields instead of I/O addresses, you must also perform an 
alignment. 

5. Now calculate the HW address by adding the base output address (first value of the 
output data) of the Control Unit to the offset (for example 298 + 3 = 301). The offset 
always has the value 3. 

6. You will find the bit number in the following table. 

Table 3- 13 Bit numbers for D410 and D4x5 

Output D4x5  Output D410 Bit number 
X122.7 (DI/DO 8) X121.7 (DI/DO 8) Bit 0 
X122.8 (DI/DO 9) X121.8 (DI/DO 9) Bit 1 
X122.10 (DI/DO 10) X121.10 (DI/DO 10) Bit 2 
X122.11 (DI/DO 11) X121.11 (DI/DO 11) Bit 3 
X132.7 (DI/DO 12) - Bit 4 
X132.8 (DI/DO 13) - Bit 5 
X132.10 (DI/DO 14) - Bit 6 
X132.11 (DI/DO 15) - Bit 7 

 
 

 Note 
In the case of versions earlier than V4.2, when using 39x message frames, the onboard 
D4x5 outputs are to be assigned exclusively to SIMOTION. 

 

 



Cam Track TO - Part II  
3.3 Configuring the TO Cam Track 

 Output Cams and Measuring Inputs 
104 Function Manual, 11/2010 

3.3.7 Configuring cam tracks on SIMOTION D4x5-2 onboard 

With SIMOTION D4x5-2 the outputs on the interface X142 are used for cam output 
1. The Inputs/outputs X142 entry in the project navigator can be used to open the 

configuration screen in HW Config. 
2. For the selected I/O channel, select Output cam as the function. 

 

 
 

Note 
If you do not use any symbolic assignments (see the Chapter entitled Symbolic 
Assignment (from V4.2 onward) in the Motion Control Basic Functions manual), then you 
must note the logical address. (see Figure I/O Properties) This address must be 
configured at the TO output cam 

 

 
Figure 3-26 I/O Properties 

3. Click OK. 
4. Insert a new output cam or a new cam track or use an existing one. 
5. Parameterize the TO Output Cam / Cam Track 
6. Double-click Configuration below the output cam or the cam track in the project navigator. 

The Configuration window appears in the working area. 
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7. For high-speed, hardware-supported output cams, you can achieve an output accuracy 
exceeding the position control cycle clock based on the hardware used.  
Should you wish to configure a high-speed output cam, select the Activate output check 
box and select the Cam output (CAM) radio button. 

8. Assignment of an output to an output cam/cam track is supported as of V4.2 using 
symbolic assignment or by entering the HW address. 

9. Click OK to close the window and select Project > Save. 

3.3.8 Configuring cam tracks on a TM15/TM17 High Feature 
1. In the project navigator, below the input/output component (TM15/TM17) that you want to 

use, double-click the entry Inputs/outputs. The Bidirectional Digital Inputs/Outputs window 
is displayed. 

2. For the selected I/O channel, select Output cam as the function. 
 

 
 

Note 
If you do not use symbolic assignment (see the Chapter entitled Symbolic Assignment 
(from V4.2 onward) in the Motion Control Basic Functions manual), then you must note 
the offset (e.g. 3.1). 

 

3. Insert a new output cam or a new cam track or use an existing one. 
4. Parameterize the TO Output Cam / Cam Track 
5. Double-click Configuration below the output cam or the cam track in the project navigator. 

The Configuration window appears in the working area. 
6. For high-speed, hardware-supported output cams, you can achieve an output accuracy 

exceeding the position control cycle clock based on the hardware used.  
Should you wish to configure a high-speed output cam, select the Activate output check 
box and select the Cam output (CAM) radio button. 

7. Assignment of an output to an output cam/cam track is supported as of V4.2 using 
symbolic assignment (see the Chapter entitled Symbolic Assignment (from V4.2 onward) 
in the Motion Control Basic Functions manual) or by means of entering the HW address. 

8. Click OK to close the window and select Project > Save. 
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To determine the logical hardware address for TM15/TM17 High Feature outputs (only if 
symbolic assignment is not activated) 
1. In the project navigator, below the SIMOTION device or the SINAMICS drive unit 

- for SIMOTION D, select: SINAMICS_Integrated > Communication > Message Frame 
Configuration 
- for SINAMICS S/G drive unit (position axis only): Communication > Message Frame 
Configuration 

2. Double-click Message frame configuration and, in the window which appears, select tab 
IF1: PROFIdrive PZD message frame. The components are displayed there with the 
address ranges (e.g. TM17 output data 304 to 315). 

 
Figure 3-27 Determining the hardware address of the components 

3. Before you determine the hardware address, an alignment between HW Config and 
SIMOTION SCOUT, with respect to the address, must be performed. If this has not been 
performed or you have changed the addresses, click on Set up addresses. If question 
marks are entered in the fields instead of I/O addresses, either alignment has not yet 
taken place, or the address is not recognized by SIMOTION SCOUT. In this case, you 
must perform an alignment. 

4. Now calculate the HW address by adding the base output address (first value of the 
address range) of the TM to the offset (e.g. 304 + 3 = 307). 

5. The bit number is defined by means of the offset. For example, an offset of an output cam 
on DO1 of 3.1 results in a bit number of 1. 
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3.3.9 Configuring cam tracks on SIMOTION C240 
1. Insert a new output cam or a new cam track or use an existing one. 
2. Parameterize the TO Output Cam / Cam Track 
3. Double-click Configuration below the output cam or the cam track in the project navigator. 

The Configuration window appears in the working area. 
4. For high-speed, hardware-supported output cams, you can achieve an output accuracy 

exceeding the position control cycle clock based on the hardware used. Should you wish 
to configure a high-speed output cam, select the Activate output check box and select the 
High-speed digital output (DO) radio button 

5. Assignment of an output to an output cam/cam track is supported as of V4.2 using 
symbolic assignment (see the Chapter entitled Symbolic Assignment (from V4.2 onward) 
in the Motion Control Basic Functions manual) or by means of entering the HW address. 

6. Click OK to close the window and select Project > Save. 

3.3.10 Determining derivative-action times for cam tracks (dead time compensation) 
Depending on the system and the device, there is a certain time between the setting of a 
cam output by the program and the actual reaction of the actuator (e.g. solenoid valve). This 
time is called dead time and depends, for example, on the load-dependent delay times of a 
digital output, the switching properties of a valve, etc. Usually the exact value for the dead 
time is not known and can therefore be determined empirically through measurements. 
In order that an output cam switches at the correct time, the dead time must be 
compensated by specifying a derivative-action time, which offsets the cam output by the 
dead time. Whereby it must be taken into account that the derivative-action times for 
switching an actuator on and off are usually different. 
The empirical determination of the dead times using a difference measurement as an 
example. 

 

 Note 
The procedure applies not only to output cams, but also to cam tracks. However, with cam 
tracks you can only specify a derivative-action time for the entire cam track. 

 

Example 
Lines of glue are to be applied to a product at a defined position and with a fixed length. The 
glue output is controlled by an output cam or a cam track. The glue is output from the start of 
output cam (switch-on point) to the end of output cam (switch-off point). The offset of the 
begin and end of output cam with respect to the velocity can be observed on the length and 
position of the glue line on the product (see figure). The figure below shows the line of glue 
for two velocities (v1, v2) with v2 > v1. 
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Figure 3-28 Offset of the output of output cam through dead times (dead time compensation) 

Procedure: 
1. Set all actuation times for start of output cam (activation time) and end of output cam 

(deactivation time) to 0. 
2. Define the velocities for which the positions are to be determined. You should select two 

velocities that correspond to velocities that occur during production (e.g. minimum and 
maximum velocity). 

3. Start the application and determine the start positions (xA1 and xA2) and end positions (xE1 
and xE2) of the line of glue for the velocities v1 and v2. 

 

 
 

Note 
To increase the accuracy, you can perform several comparison measurements and use 
the average measured values. 

 

4. You can determine the actuation times for the output of output cam using the following 
formula. 
tActivation = Δs/Δv = (xA2-xA1)/(v2-v1) 
tDeactivation = Δs/Δv = (xE2-xE1)/(v2-v1) 
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5. Enter the calculated actuation times as activationtime for the start of output cam and as 
deactivationtime for the end of output cam. Note that the actuation time must be entered 
as a negative when the output time is to be before the programmed output cam switching 
time. 

6. After you have determined the activation time and the deactivation time for the output of 
output cam, you should perform a control measurement and check the result. 

 

 
 

Note 
Depending on the application, it may be, e.g. with eccentric presses, that there is no 
linear relationship between dead time and velocity (e.g. non-linear response of an applied 
brake). You have to dynamically adapt the dead time to the respective velocity for these 
applications. This can be implemented in the application with a user program. After the 
actuation time has been changed, you have to activate the output cam again with 
_enableOutputCam or the cam track with _enableCamTrack. 

 

 

3.3.11 Using HW enable for cam tracks 
You can make cam track output dependent on a hardware-based enable (only with the TM17 
High Feature). The cam track is, for example, output cyclically on the TM17 High Feature. 
The enable signal (level or edge-controlled) triggers output of the cam track on the TM17 
High Feature.  
A Measuring Input TO can be configured to implement an edge-controlled enable on the 
enable input of the TM17 High Feature. Once the configured measuring signal drops in, the 
cam track is enabled at the output of the TM17 High Feature. 
A HW enable can be configured for Cam Track TOs, as well as Output Cam TOs. The 
procedure to be used is described below using the example of a Cam Track TO. Subject to 
any stated restrictions, this procedure is also used for Output Cam TOs. 

 

 Note 
A HW enable can only be used if the "High-speed output cam on TM15/17" option is 
activated for the Cam Track TO or the Output Cam TO (see Section Configuring cam tracks 
for HW output cams). 

 

 Note 
For more information about HW enable input, see the Terminal Modules TM15 / TM17 High 
Feature Commissioning Manual. 

 

See also 
Absolute level-controlled (TM17 High Feature) (Page 110) 
Absolute edge-controlled (TM17 High Feature) (Page 111) 
Setting (overriding) the enable via a program (Page 112) 
Relative edge-controlled (Page 113) 
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3.3.11.1 Absolute level-controlled (TM17 High Feature) 

Required configuration for level-controlled HW enable 
● Cam track TO or output cam TO configured 
● Digital output on TM17 High Feature parameterized for cam track output, and level-

triggered enable set at this output. The appropriate enable input for the enabling signal is 
parameterized automatically. 

● Digital output configured for cam track output (HW address) 
● Cam track TO or output cam TO must be active. 

Level-controlled enable procedure 
For cam tracks with a level-controlled enable, output cams are output for as long as the cam 
track is active in the TO (set with the _enableCamTrack command) and as long as a HW-
enable enabling signal, which has been parameterized on the TM17 High Feature, is 
present. This means that a cam track can also be output multiple times with a continuous 
enabling signal. An output cam, which is already active, is still output even if the enable is 
deactivated. 
An output cam cannot be activated until a HW enabling signal is present at the TM17. If the 
enable takes place within an output cam, it is not output. Subsequent output cams are, 
however, output. This can be parameterized in the track enable of the TO (see the Start 
mode and stop mode section). 
It is also possible to execute the output with inverted logic, i.e. the enable input on the TM17 
can be operated inversely and then works in LOW-active mode. 

 
Figure 3-29 Schematic representation of a level-controlled HW enable 

 

 Note 
With level-controlled HW enables, the state system variable does not indicate the status of 
the output (DO), but rather the status of the cam track signal (C-TS). 

 

Determining the status of the enable 
The I/O area of the digital input for the enabling signal is used to determine the status of the 
enable. For more information, see the Terminal Modules TM15/TM17 High Feature 
Commissioning Manual. 
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3.3.11.2 Absolute edge-controlled (TM17 High Feature) 

Required configuration for edge-controlled HW enable  
● Cam track TO or output cam TO configured 
● Digital output on TM17 High Feature parameterized for cam track output, and edge-

triggered enable set at this output. The appropriate enable input for the enabling signal is 
parameterized automatically. 

● Measuring input configured (measuring range, edge, operating mode of measurement 
once) 

● Digital output on the TO configured for cam track output (HW address) 
● Cam track TO or output cam TO must be active. 

Evaluating edges for the measurement 
For the measuring input, only the measurement once mode is permitted with the following 
edge detection: 
● Rising edge 
● Falling edge 
● Both edges 
A measuring of both edges, first rising and both edges, first falling and the cyclic measuring 
mode is not supported. 

Edge-controlled enable procedure 
In the case of edge-controlled HW enable inputs, the cam track is output when the track is 
active (_enableCamTrack command set) and the configured edge has been detected by the 
configured measuring input at the TM17 High Feature input. This edge enables the hardware 
gate for outputting the active cam track. The edge is detected in the configured measuring 
range (if configured) or with _enableMeasuringInput (without measuring range) on the 
measuring input. 
The measuring range operates with IPO/IPO2 or position control cycle clock resolution, and 
the enable input (measuring input) with 1 µs. The enable signal position can be evaluated in 
the usual way using the measuring input. 
An output cam cannot be controlled until a HW enabling signal is present at the TM17 High 
Feature (edge). If the enable takes place within an output cam, it is not output. Subsequent 
output cams are, however, output. 
As soon as a new measurement job is transmitted (measuring input activated) or a new 
measuring range begins, the enable for the active output is reset. 
To achieve quick response times, the cam track is continually output by the TO (cyclic cam 
track output), i.e. all output cams are transferred to the TM17 High Feature. 
In principle, non-cyclic cam track output is possible (e.g. if a HW enable is coupled to a SW 
enable). The cam track is then only output once after the HW enable. 
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Figure 3-30 Schematic representation of an edge-controlled HW enable 

 

 Note 
With an edge-controlled HW enable, the state system variable does not indicate the status of 
the output (DO), but rather the status of the cam track signal (C-TS). 

 

Determining the status of the enable 
The I/O area of the digital input for the enabling signal is used to determine the status of the 
enable. For more information, see the Terminal Modules TM15/TM17 High Feature 
Commissioning Manual. 

3.3.11.3 Setting (overriding) the enable via a program 
It is possible to set the HW input of the enable for the cam track via a SW enable signal. For 
this, you have to access the HW input directly via its address in the user program and set the 
bit.  
● Level-controlled: 

Enable, as long as the bit is set (functions as enable input). This can be achieved by 
logically ORing the SW enable and enable input (i.e. the enable can also be active 
"outside of" the SW enable, if the enable input is active). 

● Edge-controlled: 
Enable is set as long as the bit is set, irrespective of the measurement jobs on the 
Measuring Input TO. 
If the measured-value edge appears at the enable input during SW enable, the enable 
remains active even after the SW enable has been cancelled, until a new measurement 
job/new measuring range occurs. 
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3.3.11.4 Relative edge-controlled 
You can use the user program to implement a relative, edge-controlled enable input for a 
cam track.  
Follow the steps outlined below: 
1. Configure the cam track. 
2. Configure a measuring input that detects the measured result for exchanging the cam 

track (e.g. position of a workpiece edge). 
The measuring input can be connected, for example, to a drive via PROFIBUS DP, a 
SIMOTION CPU, or a TM15/TM17 High Feature. Unintended edges apparent during 
measuring can be hidden using the measuring range. 

3. Depending on the measured position, the configured cam track can be activated with 
_enableCamTrack in the user program and the detected position can be calculated via 
the axis reference position. Cam track output then occurs relative to the measured 
position. 

Note that output cams cannot be output immediately after the measurement has taken place, 
due to data transfer times (for example bus runtimes). 
This must be taken into account as follows in your application: 
● A certain time interval should be left between the measurement and output of the first 

output cam. 
● The edge-detecting sensor should be positioned in the machine accordingly. 
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3.4 Programming/References of TO Cam Track 

3.4.1 Programming 

 
Figure 3-31 Programming and execution model for the Cam Track TO 

*1 The following commands are available in the technology object states can be activated 
and active: 
● _disableCamTrackSimulation 
● _enableCamTrackSimulation 
The simulation commands are modal/act in parallel and do not replace any existing 
_enableCamTrack commands. 
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3.4.2 Commands 
The Cam Track technology object can be addressed in the user program using the following 
commands:  

Table 3- 14 Cam Track TO system functions 

Commands Description Application 
_enableCamTrack Activates cam track execution Cam track evaluation is activated. If the 

switching condition for the output of 
output cam is fulfilled, the output or 
state system variable is set. It is also 
effective for axes that have not been 
homed. 

_disableCamTrack Deactivates cam track execution Cam track evaluation is deactivated. If 
the switching condition for the output of 
output cam is fulfilled, the output or 
state system variable is not set.  

_enableCamTrackSimulation This function simulates a cam track by 
disconnecting the output. The cam track 
remains internally active, the status is 
retained, the cam track output is not switched.

Values are calculated, but not 
forwarded to the hardware. Hardware 
output cams act as software cams. The 
cam track remains internally active, the 
status is retained, the cam track output 
is not switched. If an active cam track is 
switched to simulation mode, the output 
cam status remains the same, and only 
the control of the output is reset or 
interrupted. 

_disableCamTrackSimulation The cam track is reset from simulation mode.  
The cam track output is switched according to 
the cam track status and the signal inversion. 

The output of output cam is switched 
according to cam track status and 
signal inversion. 

_setCamTrackState This function deactivates the cam track 
function and sets the cam track status to the 
specified value. 

This is used if the output should not be 
controlled by the cam track TO. 
Example: 
A glue nozzle is controlled by the cam 
track TO (applying glue dots). As a 
service function, it should also be 
possible to rinse the nozzle while 
constantly controlling it. This is 
achieved via _setCamTrackState. 

_resetCamTrack This function switches the cam track to an 
initial state. Pending errors are deleted. 
Modified configuration data is reset on 
request. 

Creating initial state of cam track TO 

_resetCamTrackError Resets cam track errors. It is terminated with 
a negative acknowledgment for any errors 
that cannot be acknowledged at this point. 

E.g. acknowledging configuration errors 
after entering correct values. 

_getCamTrackErrorNumberS 
tate  

Readout of error number status. Check for occurrence of an error with 
the specified error number 

_getStateOfCamTrackComm 
and 

This function returns the execution state of a 
command. 

Check whether or not cam track 
switching has already taken place (i.e. 
the command ID is still available or has 
already been deleted) 
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Commands Description Application 
_resetCamTrackConfigDataB 
uffer 

Changed configuration data is collected and 
stored in a buffer, and is activated with this 
command in the RUN configuration. 
This function deletes the configuration data 
collected in the buffer since the last activation 
without activating it. 

Changing configuration data in the 
RUN state discards the accumulated 
modifications. 

_bufferCamTrackCommandId This function enables commandId and the 
associated command status to be saved 
beyond the execution period of the command. 
The commandId parameter is used to define 
the command for which the respective status 
is to be saved. The maximum number of 
savable command states is specified in the 
decodingConfig.numberOfMaxBufferedComm
andId configuration data element. 

Subsequent check of how command 
was terminated, e.g. error-free or 
number of error that occurred. 

_removeBufferedCamTrackC 
ommandId 

This function ends the saving of commandId 
and the associated command status beyond 
the execution period of the command. 

Explicit deletion of previously saved 
command IDs. 

For further information on the system functions, please refer to the SIMOTION TP CAM 
Reference Lists. 
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3.4.3 Process Alarms 
You can predefine local alarm responses via SIMOTION SCOUT.  

 

 Note 
For more information, refer to the Motion Control Technology Objects Basic Functions 
functional description. 

 

How to configure the alarm response: 
1. Double-click Execution system in the project navigator below the SIMOTION device. The 

execution system opens. 
2. In the execution level tree, select SystemInterruptTasks > TechnologicalFaultTask. 
3. Then click the Alarm Response button in the displayed window. The Alarm Response 

window appears. You can configure the alarm response for every TO here. 
A system variable error indicates that a technology alarm has been generated. The response 
to the alarm is displayed in the errorReaction variable. 

Table 3- 15 Possible alarm responses 

Alarm Response Description Application 
NONE No response - 
DECODE_STOP Command processing is aborted, the cam track 

function remains active. Execution on the technology 
object can continue after _resetOutputCam or 
_resetOutputCamError. 

The Cam Track TO can only be 
reactivated after the error has been 
acknowledged. 

CAMTRACK_DISAB LE Command processing is aborted, current cam track 
function is aborted. Execution on the technology 
object can continue after _resetCamTrack or 
_resetCamTrackError. 

The Cam Track TO can only be 
reactivated after the error has been 
acknowledged. 
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3.4.4 TO Cam Track menus 

3.4.4.1 Cam track menu 
Grayed-out menu functions cannot be selected. The menu is only active if a Cam Track TO 
window is active in the working area.  

You can select the following functions: 

Table 3- 16 Cam track TO menu 

Function Significance/Note 
Close Select Close to close the configuration window for the cam track that is open in the working area. 
Properties Select Properties to display the properties of the cam track highlighted in the project navigator. 
Configuration Select Configuration to determine the configuration data (e.g. output cam type) of the cam track. 
Default Select Default to define the defaults of the system variables (e.g. track data and output cam data) 

of the cam track. 
Expert  

Expert list Select Expert list to open the expert list for the highlighted cam track. The configuration data and 
system variables can be displayed and changed in this list. 

 

Configure units Select Configure units to open the Configure units of the object window in the working area. You 
can configure the units used for the selected object here. 
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3.4.4.2 Cam track context menu 
Grayed-out functions in the context menu cannot be selected. 
You can select the following functions: 

Table 3- 17 Cam track TO context menu 

Function Significance/Note 
Open configuration Select Open configuration to display the window for configuring the cam track in the working 

area. Enter the configuration data for the cam track in this window. 
Cut Select Cut to remove the selected object and save it to the clipboard. 
Copy Select Copy to copy the selected object. It is stored in the clipboard. 
Paste Select Paste to insert the cam track stored in the clipboard. 
Delete Select Delete to delete the selected cam track. The entire data of the cam track is deleted 

permanently. 
Rename Use Rename to rename the object selected in the project navigator. Note that with name 

changes, name references to this object are not adapted. 
Expert  

Expert list Select Expert list to open the expert list for the highlighted cam track. The configuration data and 
system variables can be displayed and changed in this list. 

Configure units Select Configure units to open the Configure units of the object window in the working area. You 
can configure the units used for the selected object here. 

Insert script folder Insert script folder enables you to insert a folder below the TO. You can create scripts in this 
folder in order to, for example, automate the configuration. 

Import object Import object imports the data of a SIMOTION object from another project which was previously 
created with a selective XML export. You cannot import the entire project, only the data of the 
SIMOTION object. 

 

Save project and 
export object 

Save project and export object exports selected data of the selected object in XML format. This 
data export can then be reimported into other projects. Only the data of the selected object, not 
the entire project, is exported. 

Print Select Print to print the configuration of the cam track. All system variables and configuration 
data with the associated values are printed. 

Print preview Select Print preview to open the preview of the output cam data to be printed. 
Default Select Default to define the system variables (e.g. track data and output cam data) of the cam 

track. 
Properties Select Properties to display the properties of the cam track highlighted in the project navigator. 
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Measuring Input TO - Part III 4
4.1 Overview of Measuring Input TO 

4.1.1 General information about the Measuring Input TO 
The Measuring Input technology object is used for fast, accurate measurement of actual 
positions. This is achieved with hardware support (e.g. measuring input on the associated 
drive unit).  
Measurement jobs are activated and configured using the functions of the Measuring Input 
TO. 

Local and global measuring inputs 
Depending on the hardware platform, local and global measuring inputs are available for the 
measuring tasks. Local measuring inputs are axis-related and are mainly implemented in the 
drive. The actual position value is measured. 
Global measuring inputs can be freely assigned to the axes and add an internal time stamp 
to the measurement result for more precise determination of the axis positions. 

Assignment to axes and encoders  
The measuring input TO can be assigned to the following axes/encoders: 
● Position, synchronized, or path axes 
● External encoders 
● Virtual axes (only global measuring inputs) 

 

 
 

Note 
It is not possible to assign a measuring input to speed-controlled axes. 

 

Measurement once  
A measurement job is started by a program command. When a signal edge is detected at 
the measuring input, the current position (for virtual axes, either setpoint or actual value, as 
required) is stored temporarily. When the current system cycle clock finishes (either position 
control cycle clock or interpolator cycle clock), this value is available in a system variable for 
further processing in low-priority tasks. 
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Cyclic measurement (global measuring inputs only)  
A measurement job is started by a program command. Up to two edges can be detected for 
each processing cycle clock of the measuring input TO (with measuring inputs of SIMOTION 
D, CX32, CX32-2, CU310, CU320, CU320-2 onboard, max. of two edges for every three 
position control cycle clocks). These are stored in system variables and remain available 
until they are overwritten by more recent measurements. The measured values are detected 
continuously/cyclically until the program command is deactivated. Cyclic measuring is only 
possible with global measuring inputs. 

Measuring range  
By specifying a measuring range, the validity of the measurement can be restricted to this 
range; the measurement will only be activated when the position lies within the measuring 
range. 

One measuring input for more than one axis (as of V4.0) 
By creating a measuring input with the "monitoring measuring input" property, 
measurements can be made with one measuring input simultaneously on more than one 
axis/external encoder. 

4.2 Fundamentals of Measuring Input technology object 

4.2.1 Measuring input types - local and global measuring inputs 
Depending on the hardware platform (measuring input type), local and global measuring 
inputs are available for the measuring tasks. Compared to local measuring inputs, global 
measuring inputs have a greater range of functions and enable measurements to be made 
faster. During the configuration of a Measuring Input TO, you must consider which functions 
(measurement, interconnection options) are to the used. Depending on the requirements, 
you have to configure a local or a global measuring input. 

Local measuring inputs  
With a signal edge at the relevant input, the current actual values of an encoder connected 
to SIMOTION C230-2, C240, D4xx, D4x5-2 (X122/X132), CX32, CX32-2 or to the drive (e.g. 
SIMODRIVE 611U, MASTERDRIVES MC, SINAMICS) are measured with positioning 
accuracy to determine lengths or distances. The device on which the measuring system is 
available, is used for the measuring. 
The assignment of inputs is not fixed depending on the hardware and is performed in the 
SCOUT engineering system during configuration of the Measuring Input TO symbolically or 
via the HW address. 
Local measuring inputs refer to the respective drive. Configuration usually takes place via 
drive parameters. 
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Global measuring inputs  
With a signal edge at the relevant input, the current actual values of one or more encoders 
are measured using time stamp functionality with positioning accuracy in order to provide 
information for determining lengths or distances (possible with any encoders included in the 
project). 
Each measurement result is assigned a very precise "internal" time stamp which is then 
used to determine the corresponding actual position in SIMOTION. 
The assignment of inputs is not fixed depending on the hardware and is performed in the 
SCOUT engineering system during configuration of the Measuring Input TO symbolically or 
via the HW address. 
Global measuring inputs support extended functionalities 
● More than one measuring input on one axis/encoder, whereby these can be active 

simultaneously. 
● More than one measuring input is assigned to one measuring input (monitoring 

measuring input). 
With this functionality, one measuring input can have a functional effect on more than one 
measuring input and therefore on more than one axis/external encoder. 

● Cyclic measuring 
● Measuring on virtual axes 
● should be configured on the respective device. (I/O channel is configured as measuring 

input (MI)). 
● can be assigned on the SIMOTION-CPU to an axis TO or external encoder TO. 
● Configuration by way of symbolic assignment is possible. 
Time stamp functionality 
With global measuring inputs, a time value (time stamp) is stored with each measurement. In 
this way, the exact axis position can still be determined even with different propagation 
delays between the time of the measurement to the evaluation. 
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4.2.2 Hardware for measuring inputs 

Global measuring inputs are only supported by certain hardware (measuring inputs) (see table 
below). 

Hardware for local and global measuring inputs 
The following table provides an overview of which hardware supports local and which 
hardware supports global measuring inputs. 

Table 4- 1 Hardware for local and global measuring inputs 

Hardware (measuring inputs) Local measuring inputs Global measuring inputs 
TM15, TM17 high feature - X 
SIMOTION C240/C240 PN (B1-B4) - X 
SIMOTION C230/C240 (M1, M2) X - 
SIMOTION D4xx X X 

(V4.1 and higher) 
SIMOTION D4x5-2 X 

(X122/X132 only) 
X 

(X122/X132/X142) 
SIMOTION CX32/CX32-2 X X 

(V4.1 SP2 and higher) 
SINAMICS S120 drive 
CU310, CU320, CU320-2 

X X 
(V4.1 SP2 and higher) 

MASTERDRIVES MC X - 
SIMODRIVE 611U X - 
ADI4, IM174 X - 
PROFIdrive units X - 
IM174/ADI4 X - 
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Quantity structures for hardware measuring inputs 

Table 4- 2 Measuring inputs - Overview of quantity structures and functionality 

 Maximum available quantity structure 
 CU310,

D410, 
CX32 

D4x5, 
CU320 

D4x5-2 CU320-2 CX32-2 C230-2 C240 C240 
PN 

TM15 TM17 
High 
Feature 

Maximum 
number of 
inputs of 
measuring 
inputs 

3 6 16 8 4 2 6 4 24 16 

Can be 
configured as 
a local 
measuring 
input 

X X Max. 8 X X 2 (M1, 
M2) 

2 (M1, 
M2 

- - - 

Can be 
configured as 
a global 
measuring 
input 

X X Max.16 X X - 4 (B1-
B4) 

4 (B1-
B4) 

X X 

 
 

4.2.3 Interconnections 
The Measuring Input TO can be linked to all technology objects, such as Axis TO 
(positioning axis, following axis, path axis) and External Encoder TO.  
A TO, such as an Axis TO, can be interconnected simultaneously with several Measuring 
Input TOs. The assignment can be configured. 
With local measuring inputs, the measuring input TO is assigned symbolically or if <V4.2 as 
part of its configuration. The configuration specifies the number of the measuring input to be 
used and the number of the encoder on the assigned axis. 
(See also Local measuring (Page 147)) 
With global measuring inputs, the HW address is used for assignment to the measuring 
input. 
(See also Global measuring (Page 148)) 
With V4.2 and higher, global measuring inputs can also be configured with symbolic 
assignments. Address handling is thereby no longer required.  
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4.2.3.1 Measuring input connection options 

Measuring input on C2xx controller, analog drive connected  

X2X2

X3X3
X4X4
X5X5
X6X6

X1X1

X8X8

 
Figure 4-1 Connection of measuring input to the C2xx and an analog axis 

Measuring input directly on drive, connected to SIMOTION via PROFIBUS DP 

 
Figure 4-2 Connection of the measuring input on the drive, connected to SIMOTION via PROFIBUS 

Measuring inputs on the digital onboard measuring inputs of SIMOTION D or on TM15/TM17 
High Feature 
Measuring inputs on the digital onboard measuring inputs of SIMOTION D or on TM15/TM17 
High Feature, linked to SIMOTION D via DRIVE-CLiQ. 
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Figure 4-3 Connection of measuring input to SIMOTION D4x5 and TM15/TM17 High Feature 

The TO Measuring Input cannot be interconnected with DP I/O or integrated I/O (with the 
exception of inputs of measuring inputs). 

4.2.3.2 Several Measuring Input TOs on one axis/encoder (as of V3.2) 
Several Measuring Input TOs can be assigned to an Axis TO or an External Encoder TO. 
The number of measuring inputs is determined according to the functionality (local or global).  

Local measuring inputs 
For local measuring input (see Hardware for measuring inputs (Page 124)) the following 
applies: 
● Only two measuring inputs can be configured per axis TO or external encoder. 
● Only one measuring input can be active on an axis TO or external encoder. 

Global measuring inputs 
For global measuring inputs (see Hardware for measuring inputs (Page 124)) the following 
applies: 
● More than one measuring input can be configured per axis TO or external encoder. 
● More than one measuring input can be active simultaneously on an axis TO or external 

encoder. 
As far as interconnections of measuring inputs TO are concerned, therefore, one local 
measuring input can be configured on an onboard measuring input and one or more global 
measuring inputs can be configured and active simultaneously on measuring inputs of 
C240/C240 PN (B1-B4), D4xx, D4x5-2 (X122/X132/X142), CX32, CX32-2, CU310/320/320-
2, and TM15/TM17 high feature. 
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Figure 4-4 Example of interconnection of more than one measuring input with one axis or one 

external encoder 

See also 
Measuring input types - local and global measuring inputs (Page 122) 

4.2.3.3 More than one measuring input TO on a single measuring input (C230-2/C240 only) 
It is possible to assign more than one measuring input to a single measuring input (onboard 
inputs C230-2/C240 (M1-M2)). In this case, however, it must be ensured that only one 
measuring input is active at any one time.  

 
Figure 4-5 Interconnection of more than one measuring input with a single C230-2/C240 (M1-M2) 

onboard input 
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4.2.3.4 Measuring one measurement event on several axes - Listening measuring input (V4.0 
and later) 

With the "Monitoring measuring input" function, the measurement event of a measuring input 
can also be measured simultaneously by several Measuring Input TOs. To do so, an original 
measuring input (hereinafter referred to only as measuring input) is configured on a HW 
input. Additional Measuring Input TOs can be configured as monitoring measuring inputs and 
interconnected with the Measuring Input TO. The monitoring Measuring Input TOs "listen in" 
on the measurement event of the Measuring Input TO.  
The monitoring Measuring Input TOs can also be assigned to other axes / external encoders. 
With this functionality, one measuring input can have a functional effect on several axes / 
external encoders. 
The "listening in" property on the Measuring Input TO is set with the configuration data 
element inputAccess:=TO_INTERFACE.  

 

 Note 
One single event can only be measured on several axes/external encoders at the same time 
if the measuring input TO is configured as a global measuring input (see Hardware for 
measuring inputs (Page 124)). Only these inputs have the necessary time stamp 
functionality. 

 

Procedure 
One measuring input is interconnected with one measuring input, as usual. This measuring 
input is the original measuring input. The measuring process is activated and the 
measurement events are measured on this measuring input. The monitoring measuring 
inputs are connected internally to the measuring input via an interconnection interface, and 
the measurement events are communicated simultaneously. 
The activation and deactivation of the measurement, as well as the configuration of a 
measuring range can only take place on the measuring input. Activation and deactivation 
commands issued on the monitoring measuring input are not executed and are returned with 
errors. Technology alarm 40011 is issued. 

Functionality 
● Activation and deactivation of the measuring process on the measuring input only. These 

commands are not active on the monitoring measuring input. 
● Measuring range and edge selection are only available on the measuring input. 
● The monitoring measuring input must be configured correctly at the time of the 

measurement (measuring input cycle clock, system number). 
● A monitoring measuring input does not have its own measuring input and cannot perform 

any measurements of its own. 
● The processing cycle clocks of the measuring input and the monitoring measuring input 

do not have to have the same setting. However, accuracy is lost if the measuring input is 
assigned to the IPO cycle clock and the monitoring measuring input is assigned to the 
IPO2 cycle clock, and IPO and IPO2 are configured differently. 
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The following must be considered when interconnecting more than one measuring input: 
● The measuring input and the monitoring measuring input are interconnected with one 

axis TO or external encoder. 
● A measuring input can be interconnected with more than one monitoring measuring input 

on the output side. 
● A measuring input has no interconnection on the input side. 
● A monitoring measuring input can only be interconnected with one measuring input on 

the input side. 
● A monitoring measuring input has no interconnection on the output side. 
● An axis TO or an external encoder can be interconnected with more than one measuring 

input, including a mixture of measuring inputs and monitoring measuring inputs. 
Depending on the hardware (see the More than one measuring input on one axis/encoder 
(as of V3.2) section), more than one measuring input may be active simultaneously. 

● Local measuring inputs (onboard I/O from SINAMICS and C2xx) cannot be used for the 
measuring input. Only global measuring inputs can be used (see Hardware for measuring 
inputs (Page 124)). 

● Only single-stage interconnections are possible. 
 

 
 

Note 
For more information about interconnections, refer to the Motion Control Basic Functions 
Function Manual. 

 

 
Figure 4-6 Interconnecting monitoring measuring inputs 

See also 
Several Measuring Input TOs on one axis/encoder (as of V3.2) (Page 127) 
Measuring input types - local and global measuring inputs (Page 122) 
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4.2.4 Measurement 
The measuring process is divided into one-time and cyclic measurement modes. The 
operating mode is distinguished using two separate program commands.  

Table 4- 3 Overview of one-time and cyclic measurement functions 

Measurement once Cyclic measurement (global measuring inputs only) 
As of version V1.0 As of Version V3.2 
Call up with _enableMeasuringInput command. Call up with _enableMeasuringInputCyclic command. 
Measurement jobs must be issued individually for each 
measurement. 

Measuring is activated just once and runs cyclically until 
deactivated with _disableMeasuringInput. 

Several interpolation cycle clocks between two 
measurements 

Up to two edges can be measured in each execution cycle 
of the Measuring Input TO (IPO interpolation cycle clock, 
IPO2 interpolation cycle clock or position control cycle 
clock). With SIMOTION D4x5, D4x5-2 (X122/X132) 
onboard, CX32, CX32-2 and CU310/320/320-2, the 
minimum distance between two measurements is 3 position 
control cycle clocks. The measured values must be read 
from the user program before they can be overwritten by a 
new measurement. 

Supported by: 
For hardware for local and global measuring inputs, see 
Hardware for measuring inputs (Page 124) 

Supported by: 
For hardware for global measuring inputs, see Hardware for 
measuring inputs (Page 124) (excluding TM15) 

Optional measuring range is possible. One measuring range can be defined as of V4.0. 
Prior to V4.0, measuring range for TO cannot be configured 
(must be solved in the application). 

4.2.4.1 One-time measurement 
In one-time measurement mode, the measured result must be waited for. On its occurrence, 
the measuring process is terminated.  

 
Figure 4-7 Measuring input, measurement once 

Measurement process  
A measurement is activated by the _enableMeasuringInput program command. The 
enableCommand variable indicates the execution status of this command. 
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The control system variable indicates whether the measuring function is active. If, for 
example, a positive measured edge has been selected and the measuring input is deflected, 
i.e. a measuring event occurred, the system variable cannot assume the value ACTIVE until 
the measuring input is no longer deflected. 
The state variable is set to the value WAITING_FOR_TRIGGER. A rising edge (from 0 to 1) 
or a falling edge (from 1 to 0) triggers the measuring function. The measuredEdgeMode 
parameter can be used to select which type of edge should be acquired. Acquisition of both 
measured edges can also be activated by means of a measurement job, in which case you 
can specify in the command which edge is to be acquired first, for example, first the rising 
edge and then the falling edge.  
The drive must be capable of evaluating the signal edge (rising, falling, or both edges) 
selected by SIMOTION at the measuring input. 
When the measurement result is received, the measurement position is stored. Once the 
measurement has been made, the state variable is set to TRIGGER_OCCURRED, and the 
measured values can be evaluated using the measuredValue1 and measuredValue2 
variables for two measured edges. 

Activation/deactivation of measurement job  
The measurement job remains active until the measurement result has been obtained or 
until the job is terminated by a command (e.g. _disableMeasuringInput). 
The measuring process must be reactivated for each new measurement. 
The measuring accuracy depends on the accuracy of the hardware used. It lies in the range 
of microseconds. 

4.2.4.2 Cyclic measurement (as of V3.2) 
In cyclic measurement mode, up to two edges can be measured in each processing cycle 
clock of the measuring input TO for TM17 high feature, D4x5-2 (X142) and C240 (B1-B4) 
(IPO interpolation cycle clock, IPO2 interpolation cycle clock or position control cycle clock).  
With onboard measuring inputs of D4xx, D4x5-2 (X122/X132), CX32, CX32-2, 
CU310/320/320-2, the minimum duration between two measurements is 3 position control 
cycle clocks. Measuring signals in between are not detected. Measurements are taken 
cyclically, until they are terminated with a command.  
The measured values must be read from the user program before they can be overwritten by 
a new measurement. 

 

 Note 
Cyclic measuring is only possible with global measuring inputs (see Hardware for measuring 
inputs (Page 124)(excluding TM15)).  
During configuration, you are not prevented from also using local measuring inputs for cyclic 
measuring. However, this is a purely software-side solution, and only unique measuring 
processes are cyclically collected. The minimum time between two measurements is 
therefore much longer than with cyclic measuring with global measuring inputs.  
When cyclic measurement is activated with local measuring inputs (command 
_enableMeasuringInputCyclic), with V4.2 and higher, Note 40014 is output stating that during 
cyclic measuring with local measuring inputs, results may be lost if they are not spaced 
sufficiently. 
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Figure 4-8 TO measuring inputs, cyclic measuring (IPO processing cycle clock) 

Measurement process  
A measurement is activated by the _enableMeasuringInputCyclic program command. The 
cyclicMeasuringEnableCommand variable indicates the execution status of this command. 
The control system variable indicates whether the measuring function is active. Measuring 
begins on activation of the program command. 
The userdefault.measurededgecyclicMode system variable is used to select which type of 
edge should be acquired. Up to two edges can be measured in each processing cycle clock 
of the TO measuring input (IPO interpolation cycle, IPO2 interpolation cycle, or position 
control cycle). 
With cyclic measuring, the state variable remains in the WAITING_FOR_TRIGGER state 
even after the arrival of events, as waiting is continued for further events. Increases on the 
countermeasuredvalue1/2 event counter indicate that a measurement event has occurred. 
When the measurement event occurs, the measurement position is stored. After successful 
measurement, the measured values are stored in the measuredValue1 and measuredValue2 
system variables and can be evaluated. The measured values must be read from the user 
program before they can be overwritten by a new measurement. For example, if polling is 
being carried out in the IPO-synchronous task, up to two edges can be evaluated per IPO 
cycle clock. 

Table 4- 4 Archiving measurement results in the system variables within an IPO cycle clock 

Edges per IPO measuredValue1 measuredValue2 Description 
Rising and falling First rising edge First falling edge - 
Rising only or falling only First edge Second edge - 
One edge only First edge - - 
More than two edges First edge Second edge Error status is synchronously 

reported with the error 
system variable, and the 
40009 TO alarm is output. 
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counterMeasuredValue system variable  
The counterMeasuredValue1 and counterMeasuredValue2 counter variables are defined for 
the measuredValue1 and measuredValue2 system variables and are automatically 
incremented by a value of one for each measuring input. New results can be traced 
immediately and can also be read from non-IPO-synchronous tasks. 
The counter variables are incremented for each measurement input, even if the measured 
value is rejected (e.g. more than two measured values per IPO cycle clock). 
Counter variables are reset on power-up, reset, restart, and on first activation of cyclic 
measuring. Counter variables are not reset if cyclic measuring was already active and, for 
example, only a parameter was changed with the _enableMeasuringInputCyclic command. 

Activation/deactivation of measurement job  
The measurement job remains active until deactivated with the _disableMeasuringInput 
command. 

See also 
Measuring input types - local and global measuring inputs (Page 122) 

4.2.4.3 Measurement activation times 
Various response times (e.g. effects of propagation delays) must be taken into account in the 
application for the measuring function, depending on the axis/external encoder connection 
(onboard C2xx, PROFIBUS axis), the drive used (611U, MASTERDRIVES MC, SINAMICS), 
and the execution level (IPO, IPO2, or position control cycle clock).  
The measuring process is started with _enableMeasuringInput or 
_enableMeasuringInputCyclic in the user program. 
The runtime up to the evaluation of the measured edge at the HW input is dependent on the 
configuration. In order to detect the measured edge correctly, you must ensure in the user 
program that _enableMeasuringInput or _enableMeasuringInputCyclic have been executed 
prior to this runtime. 

Utilities & applications 
The SIMOTION Utilities & Applications contains examples of and help for SIMOTION. It 
serves to support SIMOTION users and clarify SIMOTION applications. 
SIMOTION Utilities & Applications includes, for example, a tool to estimate: 
● The time elapsed from activating the _enableMeasuringInput and 

_enableMeasuringInputCyclic command to the measuring input job becoming effective in 
the drive 

● The minimum time between two measurement jobs 
● Derivative action time when applying a measuring range (fine range) 
The SIMOTION Utilities & Applications is shipped with the SIMOTION SCOUT software 
package.  
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4.2.5 Measuring range 
A measuring range (system variable userdefault.measuringRangeMode) can be predefined 
for a measurement job. This can either be valid for the whole range, or restricted by entering 
a measuring range start and end.  

 

 Note 
The measuring range can be used for single measurement and, as of V4.0, for cyclic 
measurement. If a measuring range is required for cyclic measurement (prior to V4.0), this 
can be implemented in the application.  
A user program in the IPO-synchronous task can detect up to two edges in each IPO cycle 
clock. If an "unintended edge" is detected, it simply has to be rejected. 

 

Measuring process with measuring range  
When measuring with a measuring range, initially, _enableMeasuringInput or 
_enableMeasuringInputCyclic simply records the measurement job in the system. The 
measurement will then be triggered only when the axis position lies within the measuring 
range. Measuring is only valid within this range. 

 

Figure 4-9 Measuring in the measuring range 

The time that elapses after reaching the start of the measuring range on the axis 
(mechanics) until the measured edge is evaluated at the HW input is dependent on the 
configuration. In order to activate the measuring function on reaching the desired start of the 
measuring range on the axis (mechanics), you must preset the start of the measuring range 
with the _enableMeasuringInput or _enableMeasuringInputCylic command, depending on the 
axis velocity and response time. 
This procedure is the same for the end of the measuring range. Here, it is important that the 
measuring function is deactivated as soon as the end of the measuring range on the axis 
(mechanics) is crossed. 
If no measured edge is detected in the measuring range during a single measurement, the 
measuring job is aborted and a TO alarm is triggered. During cyclic measuring, each 
measurement result in the measuring range is reported. However, a TO alarm is not output if 
no measured edge is detected in the measuring range. 
During cyclic measuring, the measurement remains active for modulo and non-modulo axes 
even after the measuring range is exited, and even over several modulo cycles. The 
measurement is only terminated with _disableMeasuringInput. 
For non-modulo axes, the sequence in which the start and end of the measuring range are 
specified is irrelevant. If the start of the measuring range is greater than the end of the 
measuring range value, the two values are exchanged. 
If the start of the measuring range is greater than the end of the measuring range in a 
modulo axis, the measuring range is extended from the start of the measuring range over the 
modulo transition of the axis to the end of the measuring range. 



Measuring Input TO - Part III  
4.2 Fundamentals of Measuring Input technology object 

 Output Cams and Measuring Inputs 
136 Function Manual, 11/2010 

 
Figure 4-10 Measuring range for modulo axes for the measuring input 

Dynamic measuring range  
The measuring range can also be switched on or off dynamically. An activation time is 
allowed for this purpose when switching on or off. 
The activation time can be specified by means of the measuringRange.activationTime 
configuration data element.  
This time can be used, for example, to compensate for the runtimes during activation via 
PROFIBUS and the drive. 
The following applies here: 
● Activation of the measuring range and consideration of the activation time are performed 

on a position control granular basis. 
● This means that the accuracy depends on the position control cycle clock. 
● The runtime should be taken into consideration: Position control DP cycle clock activation 

in the drive (i.e. the position of the position control cycle clock in relation to the DP cycle 
clock as well). 

● The actual position of the encoder is not evaluated directly, instead the filtered actual 
position is evaluated (see Actual value system). 

4.2.6 Configure Units 
You can define the basic units for each technology object. The same physical variables can 
have different units in different technology objects. These are converted:  

How to configure the units: 
1. Open the context menu for the technology object in the project navigator. 
2. In the context menu, select Expert > Configure units. The Configure Units window 

appears in the working area. 
3. Select the unit for the physical variables. These units are used for the technology object, 

e.g. s for time units. 
or 
1. In the project navigator, open the Configuration under the TO. 
2. Select the tab Units. 
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You can set the following parameters: 

 
Field/Button Explanation/Instructions 
Unit system Drop down list for preselecting the units to be displayed 

The "SI units system" is set by default in the drop down list 
when creating anew. 

Table with units  
 Physical parameter column Displays the physical parameter. The physical parameters 

which are also used by the TO are made available. 
 Unit column Display and configuration for unit. A drop down list for 

selecting the unit appears when you click on the cell. 
Toolbar  
  Displays whether offline data or online data is shown 

• Blue field = offline display 
• Yellow field = online display 

 Close Button for closing the dialog. 
 Help Button for opening the dialog's online help. 

 
 

4.2.7 Simulation 
This function activates the measuring input simulation (simulation=active). Measured result 
arrived is set and allocated to the programmed measured value as a measured result. 
If the simulation mode is active on the measuring input, the simulated measured value is 
entered in Measuredvalue1 using the function _enableMeasuringInput (trigger), and 
state=trigger_occurred is set. 
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4.3 Configuring the Measuring Input technology object 

4.3.1 Inserting Measuring Inputs 
 

 Note 
Before you insert a measuring input, the hardware must be configured and the axis or 
external encoder to which the measuring input cam is assigned has to be created. 

 

To insert a new measuring input  
1. In the project navigator, highlight the MEASURING INPUTS folder under the relevant axis 

or external encoder. 
2. Select Insert > Technology Objects > Measuring Input , or double-click  Insert Measuring 

Input in the project navigator at the axis or external encoder entry in the MEASURING 
INPUTS folder. The Insert Measuring Input window appears. 

3. Enter a name for the measuring input. You can also enter a comment. 
Names must be unique throughout the project. For this reason, all the inserted measuring 
inputs are displayed under Available measuring inputs. 

4. Confirm with OK. In the working area, the window for the configuration is displayed and 
the measuring input created is shown in the project navigator. 

4.3.2 Parameterization of the Measuring Input technology object 

General information about configuration data and system variables  
Two data classes are distinguished when parameterizing a TO. 
Configuration data defines the principal functionality of a TO. They are set within the object 
configuration framework with the SCOUT engineering system and are not normally changed 
during runtime. 
System variables provide status data of the TO for the user program and a parameterization 
interface on the TO. System variables can be changed during runtime. 

 

 Note 
For more information about technology objects, refer to the SIMOTION Motion Control Basic 
Functions functional description. 
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To parameterize a measuring input:  
1. In the project navigator under the MEASURING INPUTS folder, find the measuring input 

technology object (TO) that you want to parameterize. Double-click the measuring input 
to display the associated objects. 

2. Double-click Configuration or Default in the project navigator. The window appears in the 
working area. 
– Configuration (see the Configuring a measuring input section): 

Define the configuration data of the measuring input here. This includes, for example, 
the processing cycle clock.  

– Default (see the Measuring input defaults section): 
Define the measuring input defaults of the system variables here. These include the 
edge, start of measuring range, and end of measuring range.  

3. Change configuration data and measuring input defaults. 
4. Click Close to accept the changes. 
5. Repeat steps 2 to 4 for all objects in which you want to change the configuration data and 

defaults. 

See also 
Measuring Input Configuration (Page 140) 
Measuring input defaults (Page 145) 

4.3.3 Use Expert List for Measuring Inputs 
Parameters required for standard SIMOTION applications (configuration data and system 
variables) are parameterized into the output cam technology object directly by means of 
screen forms or are defined automatically. 
It may be necessary to change automatically-defined parameters for special SIMOTION 
applications. These configuration data and system variables can only be displayed and 
changed in the expert list. 

 

 Note 
For more information about working with the expert list, refer to the SIMOTION Motion 
Control Basic Functions functional description. 
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4.3.4 Measuring Input Configuration 

4.3.4.1 Measuring Input Configuration 
In the Configuration window, define the configuration data values for the measuring input.  
Double-clicking in the project navigator below the measuring input on the Configuration 
element displays the window in the working area. 

 
Figure 4-11 Global measuring input  
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Figure 4-12 Local measuring input 
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Figure 4-13 Monitoring measuring input 

You can set the following parameters: 

Table 4- 5 Measuring input configuration data 

Field/Button Significance/Note 
Name The name of the created measuring input is displayed here. 
Processing cycle clock Use this to select the system cycle during which the measurement result is interpolated and 

stored in the system variables. 
IPO 
(Default value) 
Measurement result is refreshed in the interpolator cycle clock.  
IPO2 
Measurement result is updated in the interpolator cycle clock 2. The IPO2 cycle clock length is 
at least twice that of the IPO.  
Position control cycle clock 
Measurement result is refreshed in the position control cycle clock.  
For the possible setting IPO_fast, see the chapter entitled Second position control cycle clock 
(Servo_fast) in the Motion Control Basic Functions manual. 
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Field/Button Significance/Note 
Axis measuring system 
no. 

Under Axis measuring system no., enter the number of the encoder system used on the 
measuring input (if the axis has more than one encoder). Encoder system 1 is the default 
setting. An encoder system can be assigned to several measuring inputs. 
Note: 
With global measuring inputs, please note that measurement is not based on the encoder 
which is active for the control/Ipo, but on the axis measuring system set on the measuring 
input. 
Note: 
With virtual axes the axis measuring system no. is irrelevant because only setpoints are 
measured. 

Monitor current status 
(measurement once) 

If the checkbox is activated, short pulses (short servo cycle clock) will be suppressed at the 
measuring input. If the measuring input is activated, provided that rising edge is selected under 
Edge, the measuring input will only be activated when the measuring input was at signal status 
0 for at least one servo cycle. 

Activation time of the 
measuring range on 
measuring input 

Enter an activation time, in seconds, for the activation and deactivation of the measuring range 
here. With this time, you can compensate, for example, the runtimes during activation via 
PROFIBUS and drive. The accuracy of the activation depends on the servo cycle clock. 

Compensation value for 
time stamp (Page 144) 

Here, you enter the time-based compensation value for the time stamp evaluation. The 
compensation value is stored in the configuration data TimeStampConfig.correctionTime. 
Every measurement result has a time stamp. When measuring actual values on a real axis, the 
time that elapses after the measurement event is measured until it is communicated to the 
SIMOTION system, is corrected by interpolation (runtimes based on bus and cycle clock 
system). For measurement on virtual axes, setpoints are measured, rather than actual values. 
With setpoints, there are no runtimes. For example, if you set a measurement in the actual 
value system in relation to a virtual axis in the setpoint system (e.g. master axis), a 
compensation value for the offset time must be taken into account in order for the position to 
be calculated correctly. 

Measuring input number Enter the measuring input at the drive of the axis here. One input can be assigned to several 
measuring inputs. Input 1 is the default setting. 

Measuring input selection  
Standard (global 
measuring input), 
e.g. on the 
TM15/TM17 module/ 
C240 (B1-B4) or 
SIMOTION D 
onboard 
(Refer to chapter 
Global measuring 
(Page 148)) 

Select the radio button if you want to configure a measuring input for global measuring. This 
functionality is available for hardware (see Hardware for measuring inputs (Page 124)). With 
global measuring, the current actual values of one or more encoders are measured with 
positioning accuracy with a signal edge on the relevant input in order to determine lengths or 
distances from these (possible with any encoders present in the project). 
The output can be symbolically assigned via the assignment dialog using the  button in the 
Output field (symbolic assignment is activated by default in the project with V4.2 or higher). 
For more details, see cam output types. (Page 18) 
If symbolic assignment is not active or if the CPU version < V4.2, a physical output is assigned 
by entering the HW address and bit number in the Output field. 

Drive-related (local 
measuring input) 

Activate the radio button if the measuring input is connected directly to the C230-2/C240, 
D4xx, D4x5-2 (X122/X132), or the drive. Measurements can be taken only on the device that 
has a measuring system. You still have to enter the name of the measuring input number. 

 

Monitoring 
measuring input 

Select the radio button if you want to configure a monitoring measuring input. If the check box 
is selected, the measurement result of a measuring input TO that is interconnected on another 
HW input (see Hardware for measuring inputs (Page 124)) is also measured by the measuring 
input configured as a monitoring measuring input (listening in on the measurement event). 
With this functionality, one measuring input can have a functional effect on several axes / 
external encoders. If you have configured a monitoring measuring input, you can now only 
select the processing cycle clock and axis measuring system number. 
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Field/Button Significance/Note 

 Button for opening the assignment dialog. Select a parameter or an address in the assignment 
dialog. 

 Displays whether offline data or online data is shown 
• Blue field = offline display 
• Yellow field = online display 

4.3.4.2 Time stamp correction value 
When measuring with measuring inputs, the following should be taken into account when 
calculating the measurement positions from the measurement result and actual position of 
axis / external encoder: 
● the filter time constant setting on the measuring input (e.g. TM17 smoothing filter), 
● the delay times in the transmission section and sensors and 
● with global measuring inputs also the Ti setting on axis / external encoder 
 
The hardware delay times on the measuring inputs can be found in the Manuals and can 
usually be ignored for values of much less than 125 µs (e.g. with SIMOTION D, SINAMICS 
Control Units, SIMOTION C240)) 
If the filter time can be parameterized for the hardware used (e.g. TM17 high feature: 1 µs or 
125 µs), set the smallest possible value for the measuring inputs. 
The delay times up to the measuring input, due to the transmission line and sensor 
technology, depend on the components used and are usually unknown. If these values are 
small, they can also be ignored. 
You must also take the Ti setting into account for "global" measuring inputs. The value can 
be found in the properties of the SINAMICS drive unit in the HW Config. 
Example of how to proceed: 
● For SIMOTION D: in HW Config, double-click on SINAMICS Integrated  
● Under DP slave properties, in the tab Cycle synchronization read off the value Ti 
During the measuring input configuration of "global" measuring inputs, also enter the 
negated value of Ti as offset value of the time stamp (TimeStampConfig.correctionTime). 
If measurements have to be performed with "very high" accuracy or the dead times caused 
by the filter time constant and delay times from the transmission line, BERO, converter, 
contacts, etc. cannot be ignored, we recommend the machine-specific determination of the 
dead times that really occur, through measurements or series of measurements.  
Measurements with velocity-dependent displaced measuring results are an indication that 
the dead times have not been compensated or incorrectly compensated. 
The procedure for empirical/measuring technique determination of dead times is similar to 
the process for determining dead times during cam output. 

See also 
Determining derivative-action times for output cams (dead time compensation) (Page 39) 
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4.3.5 Measuring input defaults 
You can define the defaults for every measuring input. These values are stored in system 
variables and can be changed by programs.  
Double-clicking in the project navigator below the measuring input on the Defaults element 
displays the window in the working area. 

 
Figure 4-14 Measuring input defaults 
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You can set the following parameters: 

Table 4- 6 Measuring input defaults 

Field/Button Significance/Note 
Edge 
(measurement once) 

Under Edge you select the signal edge that starts the measurement when present at the 
measuring input and measures the actual position of the axis.  
The drive must be capable of evaluating the signal edge (rising, falling, or both edges) selected 
by SIMOTION at the measuring input. 
Rising edge (low to high) 
The actual position is recorded with the rising edge of the measuring input.  
Falling edge (high to low) 
The actual position is recorded with the falling edge of the measuring input.  
Measure at both edges 
The actual position is recorded using both the rising and falling edge of the measuring input.  
Measure at both edges, starting with a rising edge (low to high) 
The actual position is recorded using both the rising and falling edge of the measuring input, and 
measurement is begun at the first rising edge.  
Measure at both edges, starting with a falling edge (high to low) 
The actual position is recorded using both the rising and falling edge of the measuring input, and 
measurement is begun at the first falling edge. 

Start of measuring 
range/ 
End of measuring range 
(measurement once) 
(See the Measuring 
range section also) 

Enter the start and end of the measuring range here. 
If the start of the measuring range is greater than the end of the measuring range for modulo 
axes, the measuring range extends from the initial value through the modulo transition to the end 
value. For non-modulo axes the initial and end values are swapped in this case. 

Measuring range 
(measurement once) 
(See the Measuring 
range section also) 

Under Measuring range you can choose whether or not to apply the defined measuring range.  
Measuring without specified range 
The measuring input records the measured values in the entire traversing range.  
Measuring in specified range 
The measuring input only records the measured values within the measuring range defined by 
the start and end points.  

Cyclic measuring edge 
(Page 132) 

The edges to be detected in cyclic measuring are selected here. Up to two edges can be 
measured in each processing cycle clock of the measuring input (IPO interpolation cycle clock, 
IPO2 interpolation cycle clock, or position control cycle clock). Cyclic measuring is only possible 
with certain hardware (see Hardware for measuring inputs (Page 124)). 
All edges 
Both rising and falling edges are measured. 
Rising edges only 
Only rising edges are measured. 
Falling edges only 
Only falling edges are measured. 

See also 
Measuring range (Page 135) 
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4.3.6 Local measuring 

Introduction 
With local measuring inputs, the measuring input is assigned as part of its configuration. The 
configuration specifies the number of the measuring input to be used and the number of the 
encoder on the assigned axis (PROFIdrive). 

4.3.6.1 Local measuring on C230-2, C240 (not C240 PN) 
With a signal edge at the relevant M1 or M2 input, the current actual values of one or more 
encoders connected to the onboard encoder interfaces (X3 to X6) are measured with 
positioning accuracy to determine lengths or distances. 
The assignment of inputs is not fixed; the special use is activated in the SCOUT engineering 
system during configuration of the measuring input via the measuring input number. 

 

 Note 
As the C240 PN has no onboard encoder interfaces, it has no local inputs of measuring 
inputs. 

 

4.3.6.2 Local measuring on D4xx, D4x5-2 (X122/X132), CX32, CX32-2, CU310, CU320 and 
CU320-2 

If you connect a local measuring input TO to the measuring inputs of D4xx, D4x5-2 
(X122/X132), CX32, CX32-2 and CU320 and CU320-2, you will have to set the following 
parameters (PROFIdrive): 
● Parameter p488 on the associated drive for one local measuring input 
● Parameters p488 and p489 on the associated drive for two local measuring inputs 
● Parameters p728.8 - p728.15 on the control unit as inputs for all DI/DO used as 

measuring inputs (these settings can also be made using a parameterization mask) 
 

4.3.6.3 Local measuring on other drives (MASTERDRIVES MC, SIMODRIVE 611U, etc.) 
With SIMOTION, the measuring input is assigned as part of its configuration. The 
configuration specifies the number of the measuring input to be used and the number of the 
encoder on the assigned axis. 
Please refer to the documentation for the respective drive system for details of any additional 
settings which may be required. 
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4.3.7 Global measuring 
With global measuring, the current actual values of one or more encoders are measured with 
positioning accuracy with a signal edge on the relevant input in order to determine lengths or 
distances from these (possible with any encoders present in the project). Up to two edges 
can be measured for each position control cycle clock of the Measuring Input TO.  
The assignment of the inputs is not fixed, and the special use is activated via the HW 
address when the Measuring Input TO is configured. 
 

 

 Note 
Global measuring is only possible for measuring inputs with time stamp. Hardware for 
measuring inputs (Page 124) 

 

See also 
Global measuring on D4xx, D4x5-2 (X122/X132), CX32, CX32-2, CU310, CU320 and 
CU320-2 (Page 151) 
Configuring and interconnecting a listening Measuring Input TO (Page 157) 

4.3.7.1 Global measuring on TM15/TM17 High Feature 
Digital inputs are available for connection of measuring inputs on the TM15 and TM17 High 
Feature terminal modules. These can be used for one-off or cyclic measuring. Cyclic 
measuring is only supported by the TM17 High Feature.  

 

 Note 
For more information about the Measuring Input TO on terminal modules, see the Terminal 
Modules TM15 / TM17 High Feature Commissioning Manual. 

 

To configure a measuring input on a TM15/TM17 High Feature 
1. In the project navigator, below the input/output component (TM15/TM17) that you want to 

use, double-click the entry Inputs/outputs. The Bidirectional Digital Inputs/Outputs window 
is displayed. 

2. For the selected I/O channel, select measuring input as the function. 
 

 
 

Note 
If you do not use symbolic assignment (see the Chapter entitled Symbolic Assignment 
(from V4.2 onward) in the Motion Control Basic Functions manual), then you must note 
the offset (e.g. 3.1). 

 

3. Insert a new measuring input or use an existing one. 
4. Assign parameters to the measuring input TO. 
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5. Double-click Configuration below the measuring input in the project navigator. The 
Configuration window appears in the working area. 

6. Activate the option Standard (global measuring input). Assignment of an output to a 
measuring input is supported as of V4.2 using symbolic assignment (see the Chapter 
entitled Symbolic Assignment (from V4.2 onward) in the Motion Control Basic Functions 
manual) or by means of entering the HW address. In order to assign a physical output, 
the HW address and bit number must be entered in the Output field. 

7. Click OK to close the window and select Project > Save. 

To determine the logical hardware address for a TM15/TM17 high feature (only if symbolic 
assignment is not activated) 

1. For TM15/TM17 modules, the hardware addresses result from the configured address 
range, and the bit numbers from the offset. 

2. In the project navigator, below the input/output component (TM15/TM17) that you want to 
use, double-click the entry Inputs/outputs. The Bidirectional Digital Inputs/Outputs window 
is displayed. 

3. Find the input that you want to use (Measuring input must be selected under Function) 
and note the offset (e.g. 3.0). 

4. In the project navigator, below the SIMOTION device or the SINAMICS drive unit, select 
– For SIMOTION D:  

SINAMICS_Integrated > Communication > Message frame configuration 
– For the SINAMICS S120 drive unit: 

Communication > Message frame configuration 
5. Double-click Message frame configuration and, in the window which appears, select the 

tab PROFIdrive PZD message frames. The components are displayed there with the 
address ranges (e.g. TM17 input data 328 to 343).  

 
Figure 4-15 Determining the hardware address of the components 
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6. Before you determine the hardware address, an alignment between HW Config and 
SIMOTION SCOUT, with respect to the address, must be performed. If this has not been 
performed or you have changed the addresses, click on Set up addresses. If there are 
question marks in the fields instead of I/O addresses, you must also perform an 
alignment. 

7. Now calculate the HW address by adding the base input address (first value of the 
address range) of the TM to the offset (e.g. 328 + 3 = 331). 

8. The bit number is defined by means of the offset. For example, an offset of 3.0 results in 
a bit number of 0. 

 

See also 
Inserting Measuring Inputs (Page 138) 
Parameterization of the Measuring Input technology object (Page 138) 

4.3.7.2 Global measuring on C240/C240 PN (B1-B4) 
The inputs B1-B4 are available for global measuring on the C240. These can be used for 
one-off or cyclic measuring.  

 

 Note 
For more information about the measuring input on C240/C240 PN, refer to the C2xx 
Operating Instructions. 

 

To configure a measuring input on a C240/C240 PN (B1-B4) (global measuring) 
1. Insert a new measuring input (see Inserting measuring inputs section) or use an existing 

one. 
2. Parameterize the measuring input (see the Parameterization of the measuring input 

technology object section) 
3. Double-click Configuration below the measuring input in the project navigator. The 

Configuration window appears in the working area. 
4. Activate the option Standard (global measuring input). If symbolic assignment is not 

active or if the CPU version < V4.2, a physical output is assigned by entering the HW 
address and bit number in the Output field. 

5. Enter the HW address and the bit number. The hardware address and the bit number can 
be ascertained in HW Config (e.g. 64.2 for the measuring input Pin 3 of connector X1). 

6. Click OK to close the window and select Project > Save. 

See also 
Inserting Measuring Inputs (Page 138) 
Parameterization of the Measuring Input technology object (Page 138) 
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4.3.7.3 Global measuring on D4xx, D4x5-2 (X122/X132), CX32, CX32-2, CU310, CU320 and 
CU320-2 

D4xx, D4x5-2, CX32, CX32-2, CU310, and CU320 have digital inputs for connecting to a 
global measuring input. These can be used for one-off or cyclic measuring.  

If symbolic assignment is not active or if the CPU version < V4.2, the following applies: 
Measurement results are transferred via standard message frames 391 and 392 rather than 
via the axis message frame.  
If a message frame 39x is set, the SINAMICS I/Os are interconnected automatically to this 
message frame 39x using BICO interconnections and are so available for SIMOTION. 

 

 Note 
In the case of versions earlier than V4.2, when using 39x message frames, the onboard 
D4x5 outputs are to be assigned exclusively to SIMOTION. 

 

Inverting global measuring inputs 
When selecting telegram 39x, inverting of the global measuring inputs is activated on 
Sinamics_Integrated, CX32, CX32-2 and S120 via parameters p490 and p2088[2]. 
The default assignment of p2088[2] is as follows: 
● p2088[2].0 -> Inverting of DI/DO8 
● p2088[2].1 -> Inverting of DI/DO9 
● p2088[2].2 -> Inverting of DI/DO10 
● p2088[2].3 -> Inverting of DI/DO11 
● p2088[2].4 -> Inverting of DI/DO12 
● p2088[2].5 -> Inverting of DI/DO13 
● p2088[2].6 -> Inverting of DI/DO14 
● p2088[2].7 -> Inverting of DI/DO15 
If the default assignment of the digital inputs to PZD2 is changed in message frame 39x, this 
must be taken account of in p2088[2] correspondingly. 

To configure a measuring input on a D4xx, D4x5-2 (X122/X132), CX32, CX32-2, CU310, CU320, 
CU320-2 measuring input 

1. In the project navigator, switch to the Control_Unit entry under the control unit for the 
respective device. 

2. Double-click Inputs/outputs below the control unit. The window appears in the working 
area. 

3. Select Bidirectional digital inputs/outputs. 
4. Select the measuring input function (SIMOTION). 
5. Insert a new measuring input (see Inserting measuring inputs section) or use an existing 

one. 
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6. Assign parameters to the measuring input TO. 
7. Double-click Configuration below the measuring input in the project navigator. The 

Configuration window appears in the working area. 
8. Activate the option Standard (global measuring input). Assignment of an output to a 

measuring input is supported as of V4.2 using symbolic assignment (see the Chapter 
entitled Symbolic Assignment (from V4.2 onward) in the Motion Control Basic Functions 
manual) or by means of entering the HW address. In order to assign a physical output, 
the HW address and bit number must be entered in the Output field. 

9. Click OK to close the window and select Project > Save. 

To determine the logical hardware address for the onboard inputs of D4xx, D4x5-2 (X122/X132), 
CX32, CX32-2, CU310, CU320, CU320-2 (only if symbolic assignment is not activated) 

1. In the project navigator, select Communication > Message frame configuration under the 
SIMOTION or SINAMICS device. 

2. Double-click Message frame configuration and, in the window which appears, select the 
tab PROFIdrive PZD message frames. The components are displayed there with address 
range (input/output data). 

 
Figure 4-16 Control unit I/O addresses 

3. Select the message frame type SIEMENS message frame 391 (two measuring inputs 
max.) or 392 (six measuring inputs max.). The telegram depends on the number of 
measuring inputs configured. 

4. Before you determine the hardware address, an alignment between HW Config and 
SIMOTION SCOUT, with respect to the address, must be performed. If this has not been 
performed or you have changed the addresses, click on Set up addresses. If there are 
question marks in the fields instead of I/O addresses, you must also perform an 
alignment. 

5. Now calculate the HW address by adding the base input address (first value of the input 
data) of the control unit to the offset (e.g. 298 + 3 = 301). The offset always has the value 
3. 

6. You will find the bit number in the following table. The inputs are set in parameters 680.0 
to 680.7 of the control unit, e.g. bit 1 in parameter 680.0. 
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Table 4- 7 Bit numbers for D410, D4x5, D4x5-2 (X122/X132), CX32, CX32-2 CU310, CU320, CU320-2 

Input D4x5, D4x5-2, 
CU320 

Input D4x5-2, CU320-2 Input D410, CU310, CX32 Input CX32-2 Bit number 

- X122.9 (DI/DO8) - X122.9 (DI/DO8) Bit 0 
X122.8 (DI/DO9) X122.10 (DI/DO9) X121.8 (DI/DO9) X122.10 (DI/DO9) Bit 1 
X122.10 (DI/DO10) X122.12 (DI/DO10) X121.10 (DI/DO10) X122.12 (DI/DO10) Bit 2 
X122.11 (DI/DO11) X122.13 (DI/DO11) X121.11 DI/DO11) X122.13 (DI/DO11) Bit 3 
- X132.9 (DI/DO12) -  Bit 4 
X132.8 (DI/DO13) X132.10 (DI/DO13) -  Bit 5 
X132.10 (DI/DO14) X132.12 (DI/DO14) -  Bit 6 
X132.11 (DI/DO15) X132.13 (DI/DO15) -  Bit 7 

4.3.7.4 Global measuring on D4x5-2 (X142) 

Unlike (X122/X132), measuring inputs on measuring input D4x5-2 (X142) are configured in HW 
configuration  

Configuration of terminals and function as well as the fixed telegram's start address are 
configured in HW Config. 

To configure a measuring input on an input of D4x5-2 (X142) 
The dialog to configure the X142 can be opened via the input/output X142 in the project 
navigator. Alternatively, you can access the dialog to be configured via the HW configuration 
by going to Open HW Configuration ... in the device's context menu. 
Slot X142 is shown in the detail view and in the station window of the respective D4x5-2 
device. You can access the Properties dialog via the Object properties... context menu or by 
double-clicking on the X142 line. 
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Figure 4-17 Display of D4x5-2 in HW configuration 

In the Properties dialog, you can manage Addresses and interconnect Bidirectional digital 
inputs/outputs 0-7.  
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Addresses 

 
Figure 4-18 Manage addresses 

Table 4- 8 Addresses 

Function Description 
Inputs  
 Start Under Start, enter the start address of the digital inputs. 
 Length The length of the digital input address cannot be modified. 
 System specification With System specification, you can activate or deactivate 

the automatic setting of digital input addresses. 
Outputs  
 Start Under Start, you can enter the start address of the digital 

outputs. 
 Length The length of the digital output address cannot be modified. 
 System specification With System specification, you can activate or deactivate 

the automatic setting of digital output addresses. 
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Channels 0-7 

 
Figure 4-19 Channels 0-7 

Table 4- 9 Channels 0-7 

Function Description 
IN/OUT X142 Inputs/outputs (IN/OUT 0-7) of X142. 
Inverter Button for inverting. 
Function  
 DI Digital input. 
 DO Digital output. 
 Output cam Output for cam. 
 Measuring inputs Probe input. 
IN filter time/OUT replacement value strategy  
 Filter time  The drop down list contains 1µs and 125µs values. Only 

available for DI and measuring input function. 
 Set substitute value/keep last value The selection options are available for the DO and output 

cam function. 
Logical adr. PI, PQ for output cam and measuring input. 

Note: 
Logical address is only required if you work without symbolic 
assignment. 
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4.3.8 Configuring and interconnecting a listening Measuring Input TO 
With the "Monitoring measuring input" function, the measurement event of a measuring input 
can also be measured simultaneously by several Measuring Input TOs. 

To configure and interconnect a monitoring measuring input: 
1. Before you configure a monitoring measuring input, a measuring input must be 

configured on a measuring input with a HW address. This can be a measuring input (see 
Hardware for measuring input (Page 124)). (see chapter Global measuring (Page 148)). 

2. Insert a new measuring input (see Inserting Measuring Inputs (Page 138) section). 
3. Double-clicking in the project navigator below the measuring input on the Configuration 

element displays the window in the working area. 
4. Select Monitoring measuring input, and enter the processing cycle clock and the system 

number (see the Measuring input configuration section). 
5. Double-clicking in the project navigator below the monitoring measuring input on the 

Interconnections element displays the window in the working area. 
6. In the EventIn table row under the Interconnected to output connectors column, select the 

EventOut of the measuring input with which you want to interconnect the monitoring 
measuring input. The axis to which the monitoring measuring input is assigned is 
automatically displayed under Reference. 

 
Figure 4-20 Interconnecting a monitoring measuring input 

7. Click Close. The monitoring measuring input is configured and interconnected. 

See also 
Measuring Input Configuration (Page 140) 
Measuring one measurement event on several axes - Listening measuring input (V4.0 and 
later) (Page 129) 
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4.3.9 Measuring input with HW enable input (TM17 High Feature) 
On the TM17 High Feature, hardware-based enable inputs can be configured for up to six 
measuring-input inputs. Measuring signals can only be detected at the assigned measuring 
input if an enable is present (this is a gate function).  

 

 Note 
In order to be able to use an enable input it must be configured on the TM17 High Feature 
(see Section Global measuring on the TM15/TM17 and C240 (B1-B4)). 
For more information about HW enable input, see the Terminal Modules TM15 / TM17 High 
Feature Commissioning Manual. 

 

Required configuration for level-controlled HW enable 
● Measuring input is configured 
● Digital input on TM17 High Feature parameterized for measuring input, and level-

triggered enable set at this input. The appropriate enable input for the enabling signal is 
parameterized automatically. 

● Digital input configured for detecting measured values (HW address) 
● Measuring input must be active 

Level-controlled enable procedure 
The measuring input is activated with _enableMeasuringInput or 
_enableMeasuringInputCyclic. No measured values are forwarded to the TO in this state, as 
no enabling signal is present yet (gate closed). Edges are forwarded to the TO by setting the 
enable (gate open). 
Depending on the configured measuring range, measured edges are filtered by the TO in the 
measuring input processing cycle clock and by the TM17 High Feature at a resolution of 
several µs. 
Edges are not detected if: 
● The measuring process is terminated with _disableMeasuringInput. 
● The edges fall outside the measuring range. 
● No enabling signal is present (gate closed). 

DI

 
Figure 4-21 Schematic representation of HW enable on the measuring input 
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It is also possible to execute the enable with inverted logic, i.e. the enable input on the TM17 
High Feature can be operated inversely and then works in LOW-active mode. 

Determining the status of the enable 
The I/O area of the digital input for the enabling signal is used to determine the status of the 
enable. 

Overriding the enable 
It is possible to override the measuring enable input with a SW enable signal. For this, you 
have to access the input directly via its address and set the bit. The enable is achieved, as 
long as the bit is set (functions as enable input) 

See also 
Global measuring (Page 148) 
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4.4 Measuring Input technology object programming/references 

4.4.1 Programming 

 
Figure 4-22 Programming and execution model for the Measuring Input TO 

*1 The following commands are effective in the TO states can be activated and active: 
● _disableMeasuringInputSimulation 
● _enableMeasuringInputSimulation 
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4.4.2 Commands 
The Measuring Input technology object can be addressed in the user program using the 
following commands:  

Table 4- 10 Measuring Input TO system functions 

Commands Description Application 
_enableMeasuringInput Activate measurement job. Measurement is activated. Measuring 

is terminated after the measuring 
process has been executed. 

_enableMeasuringInputCyclic 
(V3.2 and higher) 

This function activates a cyclical 
measurement job. The results of the 
last measurement are displayed in the 
system variables. 

Cyclic measuring of axis/encoder 
positions by activating a measurement 
job once only 

_disableMeasuringInput Deactivate measurement job. Measurement is terminated. 
_enableMeasuringInputSimulation Activates measuring input simulation. 

Measured result arrived is set and 
allocated to the programmed measured 
value as a measured result. 

Simulation of a program run using 
default settings of programmed 
measured values 

_disableMeasuringInputSimulation Deactivate simulation mode. - 
_resetMeasuringInput Reset measuring input. Create initial state of measuring input. 
_resetMeasuringInputError Reset error on measuring input. E.g. acknowledge configuration errors 

after entering correct values. 
_resetMeasuringInputConfigDataBuffer This function clears the configuration 

data collected in the buffer since the 
last activation without activating them. 

Changing configuration data in the 
RUN state discards the accumulated 
modifications. 

_getMeasuringInputErrorNumberState 
(V3.1 and higher) 

Readout of error number status. Check for occurrence of an error with 
the specified error number 

_getStateOfMeasuringInputCommand 
(V3.2 and higher) 

This function returns the execution 
state of a command. 

Check whether or not measurement 
has already taken place (i.e. the 
command ID is still available or has 
already been deleted) 

_bufferMeasuringInputCommandId 
(V3.2 and higher) 

This function enables commandId and 
the associated command status to be 
saved beyond the execution period of 
the command. 
The commandId parameter is used to 
define the command for which the 
respective status is to be saved. The 
maximum number of saveable 
command statuses is specified in the 
decodingConfig.numberOfMaxBuffered
CommandId configuration data 
element. 

Subsequent check of how command 
was terminated (e.g. error-free or 
number of error that occurred) 

_removeBufferedMeasuringInputComm
andId 
(V3.2 and higher) 

This function ends the saving of 
commandId and the associated 
command status beyond the execution 
period of the command. 

Explicit deletion of previously saved 
command IDs 

For further information on the system functions, please refer to the SIMOTION TP CAM 
Reference Lists. 
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4.4.3 Process Alarms 
You can predefine local alarm responses via SIMOTION SCOUT.  

 

 Note 
For more information, refer to the Motion Control Technology Objects Basic Functions 
functional description. 

 

How to configure the alarm response: 
1. Double-click Execution system in the project navigator below the SIMOTION device. The 

execution system opens. 
2. In the execution level tree, select SystemInterruptTasks > TechnologicalFaultTask. 
3. Then click the Alarm Response button in the displayed window. The Alarm Response 

window appears. You can configure the alarm response for every TO here. 
A system variable error indicates that a technology alarm has been generated. The response 
to the alarm is displayed in the errorReaction variable. 

Table 4- 11 Possible alarm responses 

Alarm Response Description Application 
NONE No response - 
DECODE_STOP Command processing is aborted, the 

current measuring function remains 
active. Further processing on the 
technology object can continue after 
_resetMeasuringInput or 
_resetMeasuringInputError. 

The TO measuring input can only be 
reactivated after the error has been 
acknowledged. 

MEASURING_INPUT_DISABLE Stop and abort of all commands. 
Further processing on the technology 
object can continue after 
_resetMeasuringInput or 
_resetMeasuringInputError. 

The TO measuring input can only be 
reactivated after the error has been 
acknowledged. 



 Measuring Input TO - Part III 
 4.4 Measuring Input technology object programming/references 

Output Cams and Measuring Inputs 
Function Manual, 11/2010 163 

4.4.4 Measuring input menus 

4.4.4.1 Measuring Input technology object menu 
Grayed-out menu functions cannot be selected. The menu is only active if a Measuring Input 
TO window is active in the working area.  
You can select the following functions: 

Table 4- 12 Measuring input menu 

Function Significance/Note 
Close Select Close to close the configuration window for the measuring input that is open in the 

working area. 
Properties Select Properties to display the properties of the measuring input selected in the project 

navigator. 
Configuration Select Configuration to define the configuration data for the measuring input. 
Default Select Default to define the values for the system variables of the measuring input. 
Expert  

Expert list Select Expert list to open the expert list for the selected measuring input. The configuration 
data and system variables can be displayed and changed in this list. 

 

Configure units Select Configure units to open the Configure units of the object window in the working area. 
You can configure the units used for the selected object here. 
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4.4.4.2 Measuring input TO context menu 
Grayed-out functions in the context menu cannot be selected.  

You can select the following functions: 

Table 4- 13 Measuring input context menu 

Function Significance/Note 
Open configuration Select Open configuration to display the window for configuring the measuring input in the 

working area. Enter the configuration data of the measuring input in this window. 
Cut Select Cut to remove the selected object and save it to the clipboard. 
Copy Select Copy to copy the selected object. It is stored in the clipboard. 
Paste Select Paste to insert the measuring input stored in the clipboard. 
Delete Select Delete to delete the selected measuring input. The entire data of the measuring input is 

deleted permanently. 
Rename Use Rename to rename the object selected in the project navigator. Note that with name 

changes, name references to this object are not adapted. 
Expert  

Expert list Select Expert list to open the expert list for the selected measuring input. The configuration data 
and system variables can be displayed and changed in this list. 

Configure units Select Configure units to open the Configure units of the object window in the working area. You 
can configure the units used for the selected object here. 

Insert script folder Insert script folder enables you to insert a folder below the TO. You can create scripts in this 
folder in order to, for example, automate the configuration. 

Import object Import object imports the data of a SIMOTION object from another project which was previously 
created with a selective XML export. You cannot import the entire project, only the data of the 
SIMOTION object. 

 

Save project and 
export object 

Save project and export object exports selected data of the selected object in XML format. This 
data export can then be reimported into other projects. Only the data of the selected object, not 
the entire project, is exported. 

Print Select Print to print the configuration of the measuring input. All system variables and 
configuration data with the associated values are printed. 

Print preview Select Print preview to open the preview of the measuring input data to be printed. 
Default Select Default to define the values for the system variables of the measuring input. 
Properties Select Properties to display the properties of the measuring input selected in the project 

navigator. 
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Output cam, 39, 107 

Assigning parameters 
Cam track, 93 
Measuring inputs, 139 
Output cam, 32 

Automatic deactivation, 74 

B 
Bit number, 37 

C 
Cam track 

Activation time, 99 
Active outside of track length, 75 
Assigning parameters, 93 
Axis reference position, 79 
Changing during runtime, 86 
Changing output cam during runtime, 87 
Context menu, 119 
Deactivation time, 100 
Features, 59 
Functionality, 56 
General information, 55 
Inserting, 93 
Menu, 118 
Output cam types, 60 
Start mode, 76 
Stop mode, 76 
Time-based cam, maximum ON length, 64 
Validity of single output cams, 87 

Cam track (camTrackType) 
Configuring, 42, 101 

Cam track activation, 74 
Cam track activation mode 

Cyclic, 78 
Non-cyclic, 78 

Cam track actuation time 
Activation time, 72 
Deactivation time, 72 

Cam track deactivation, 74 
Cam track HW enable 

Edge-controlled, 111 
Level-controlled, 110 

Cam track mapping 
Axis, 81 
General information, 81 
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Negative axis positions, 83 
Output cam, 82 

Cam tracks 
Status of single output cam, 89 

CAMTRACK_DISABLE, 117 
Changing axis configuration 

Cam track, 88 
Changing track length, 88 
Commands 

Cam track, 115 
Measuring inputs, 161 
Output cam, 50 

Comparison of output cam and cam track, 12, 58 
Configuration 

Cam track, 94 
Measuring inputs, 140 
Output cam, 34 

Configuration data 
Cam track, 93 
Measuring inputs, 139 
Output cam, 33 

Configure units 
Cam track, 31, 79, 136 
Measuring input, 31, 79, 136 
Output cam, 31, 79, 136 

Configuring 
Cam track, 92 

Connection possibility 
Measuring inputs, 126 

Context menu 
Cam track, 119 
Measuring inputs, 164 
Output cam, 53 

Counter cam, 16 
counterMeasuredValue, 134 
Cyclic measuring, 122, 132 
Cyclic output 

Cam track, 78 

D 
Deactivation time, 72 

Time-based cam, 74 
Deactivation via command, 74 
Dead time compensation 

Output cam, 39, 107 
DECODE_STOP, 52, 117, 162 
Default 

Cam tracks, 97 
Measuring inputs, 145 
Output cam, 38 

disableOutOfTrackRange, 74 

E 
Edge-controlled enable 

Cam track (TM17 High Feature), 111 
Relative cam track, 113 

Effective direction 
Output cam, 24, 39 

Effective direction and behavior, 69 
enableValidCam, 87 
Exact-time output cam, 22 
Expert list 

Cam track, 94 
Measuring inputs, 139 
Output cam, 33 

F 
Functionality 

Cam track, 56 
Output cam, 10 

G 
General information 

Cam track, 55 
Measuring input, 121 
Output cam, 9 

Global measuring 
C240/C240 PN (B1-B4), 150 
Measuring inputs, 148 
SIMOTION D, 151 
TM15/TM17, 148 

Global measuring inputs, 123 

H 
Hardware cam, 13, 42, 60, 101 
HW enable 

Cam track, 109 
HW enable for Output Cam TO, 48 
Hysteresis, 39, 100 

Cam track, 70 
Output cam, 25 

Hysteresis range, 70 

I 
inputAccess, 129 
Inserting 

Cam track, 93 
Measuring inputs, 138 
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Output cam, 32 
Inversion 

Cam track, 89 
Output cam (camType), 30 

IPO, 36, 95 
Measuring inputs, 142 

IPO2, 36 
Measuring inputs, 142 

K 
keepEnabledOutOfTrackRange, 75 

L 
Level-controlled enable 

Cam track (TM17 High Feature), 110 
Local alarm response 

Cam track (camTrackType), 117 
Measuring inputs, 162 
Output cam, 51 

Local measuring inputs, 122 
Logical HW address, 37 
Logical operation, 30 

M 
measuredEdgeMode, 132 
Measurement, 131 
Measurement job 

Activation/deactivation, 132, 134 
Measurement once, 121, 131 
Measuring 

At both edges, 146 
Edge, 146 
Falling edge, 146 
Rising edge, 146 
Specified range, 146 
Without area indication, 146 

Measuring input 
Assignment to axes/encoders, 121 
General information, 121 

Measuring input interconnections, 125 
Measuring inputs 

Activation time, 134 
Assigning parameters, 138 
Configuration, 140 
Connection possibility, 126 
Context menu, 164 
Global, 123 
Global measuring, 148 

Hardware enable, 158 
HW enable (TM17 High Feature), 158 
Inserting, 138 
Level-controlled enable, 159 
Local, 122 
Measurement once, 131 
Menu, 163 
TM15/TM17, 148 

Measuring process 
Cyclic measuring, 133 
Measurement once, 131 
Measuring range, 135 

Measuring range, 135 
Dynamic, 136 

MEASURING_INPUT_DISABLE, 162 
measuringRange.activationTime, 136 
Menu 

Cam track, 118 
Measuring inputs, 163 
Output cam, 52 

Modulo length 
Cam track activation mode, 84 
Cam track examples, 85 
Changing, 88 

Monitoring measuring input, 129 
More than one measuring input 

Axis/encoder, 127 
Input, 128 

N 
Non-cyclic output 

Cam track, 78 
NONE, 52, 117, 162 

O 
Output cam 

Assigning parameters, 32 
Configuring, 42, 101 
Context menu, 53 
Effective direction, 24 
Functionality, 10 
General information, 9 
Hysteresis range, 25 
Inserting, 32 
Menu, 52 
On/Off behavior, 24 
Setting exact time, 22 

Output cam (camType) 
Inversion, 30 
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Output cam actuation time 
Activation time, 27 
Deactivation time, 27 

Output cam data, 59, 100 
Output cam length, 63 
Output cam type, 60 
OUTPUTCAM_DISABLE, 52 
Overriding the enable, 112 

P 
Passive measuring input, 129 
Position control cycle clock, 36, 95 

Measuring inputs, 142 
Position-based cam, 14, 61 
Position-based cam (default value), 35 
Process Alarms, 51, 117, 162 
Processing cycle clock, 36 
PROFIBUS message frame 

Measuring inputs, TM15/TM17, 149 
Programming, 49, 114, 160 

R 
References, 7 

S 
Setpoints, 36, 95 
Setting the enable, 112 
Simulation 

Cam track, 79 
Measuring inputs, 137 
Output cam, 30 

Software cam, 13, 60 
Start mode, 76 

Effective immediately (default), 76 
Immediately when cam track output inactive, 76 
With next track cycle, 76 

Stop mode, 76 
At end of cam track, 78 
Effective immediately (default), 78 
Immediately when cam track output inactive, 78 

System functions 
Cam track, 115 
Measuring inputs, 161 
Output cam, 50 

System variables 
Cam track, 93 
Measuring inputs, 139 
Output cam, 33 

T 
Time-based cam, 64 
Time-based cam with maximum ON length 

Cam track, 64 
Time-based output cam, 15, 63 
TO_INTERFACE, 129 
Track data, 59, 98 
Track length, 69 

Cam track activation mode, 84 

U 
Unidirectional output cam, 16, 35 
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